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New in this release

The following sections detail what is new in the Nortel Contact Center Manager
Contact Center, Communication Server 1000/Meridian 1 and Voice Processing
Guide (297-2183-931) for release 6.0.

m  “Features” on page 10
= “Other changes” on page 10

Features

See the following sections for information about feature changes:

m  “Give Controlled Broadcast” on page 10
= “Universal Networking” on page 10

Give Controlled Broadcast
Nortel does not support the Give Controlled Broadcast feature on the CS 1000E
platform. The following sections were updated to include this information:

= “Give Controlled Broadcast Announcement and Open Voice Session
checklists” on page 55

= “Script commands” on page 134

Universal Networking

Universal Network Skill-Based Routing (UNSBR) is a non-switch specific
networking capability introduced in Contact Center 6.0. Universal Networking
affects the following sections:

= “To configure NSBR networking” on page 40
= “To configure CDNs on the switch” on page 86

Other changes

See the following section for information about changes that are not feature-
related.

= “Phantom TNs” on page 11

10 Contact Center Manager
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= “Updating CallPilot configuration” on page 11
= “Resource acquisition” on page 11
. “CSQO/CSQI settings” on page 11

Phantom TNs
The section “To configure phantom TNs on the switch” on page 109 is new
content.

Updating CallPilot configuration
The procedure “Updating CallPilot configuration” on page 146 was updated.

Resource acquisition

Nortel recommends that you do not configure extra voice ports that Contact
Center Manager Server does not access or acquire. See “Resource acquisition
on page 140.

CSQO/CSAQl settings
The maximum values for CSQO and CSQI were updated. See “Defining the
ELAN subnet with LD 17” on page 73.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide
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Overview

The Contact Center, Communication Server 1000/Meridian 1 and Voice
Processing Guide provides descriptive information and instructions for how to
set up and configure the following components for use with Contact Center
Manager Server:

Communication Server 1000 or Meridian 1 PBX switches

Note: Unless otherwise specified, references in this guide to the
Communication Server 1000 switch are also applicable to the Meridian 1
PBX switch.

Meridian Link Services (MLS)
CallPilot, Meridian Mail, or a third-party voice-processing system

Note: The Meridian Mail voice-processing system is not available on the
Communication Server 1000 switch.

Meridian Integrated Recorded Announcement (MIRAN)

Assumptions

This guide is based on the following assumptions:

You installed and made operational the Contact Center Manager Server.

If Contact Center Manager Server is not installed, install it. For more
information, see the Contact Center Manager Server Installation and
Maintenance Guide.

You installed and made operational the switch. You applied all current
Service Updates (SU). For information about which SU to install on the
switch, check the following Web site:

= www.nortel.com

The switch is running X11 Release 25.40B or Communication Server 1000
Release 3.0, 4.0, or 4.5.

12
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About Contact Center 6.0

The following components comprise the Contact Center 6.0 product.

Contact Center Manager Server

Contact Center Manager Server is the core contact center component that
provides the intelligent routing capability for telephony calls and multimedia
contacts. Use Contact Center Manager Server to route calls and contacts to the
most qualified agent. The most qualified agent is the agent with the appropriate
capability for handling the type of call or contact and who has the appropriate
skillset or unique abilities. Rules for contact treatment (what happens while the
customer is waiting for a response) and routing (the contact response) can be
simple or complex.

Contact Center Manager Server manages multimedia contacts using the Open
Queue feature introduced in Contact Center 6.0. The Open Queue is a licensed
feature that provides seamless integration between the Contact Center Manager
Server, Administrator, Multimedia, and Communication Control Toolkit
products. It provides true workflow, queuing, routing, reporting, and
management of contacts of multiple types, such as e-mail. It provides a truly
integrated multimedia contact center.

Network Control Center server

The server in a Contact Center Manager network that manages the Network
Skill-Based Routing (NSBR) configuration and communication between servers
is the Network Control Center server. The Network Control Center server is
required when servers in multiple Contact Center Manager Server sites are
networked and operating as a single distributed contact center. The Network
Control Center server runs the Network Control Center (NCC) software
application, a feature of the Contact Center Manager Server application
software.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 13
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Standby and Replication server

The Replication server is a third-party software server that replicates data and
outputs it to the Standby server. If the active Contact Center Manager Server
fails, the standby server can be quickly deployed.

Contact Center Manager Administration

Contact Center Manager Administration is a browser-based tool for contact
center administrators and supervisors. You can use Contact Center Manager
Administration to manage and configure a contact center and its users, define
access to data, and view real-time and historical reports. You can install the
Contact Center Manager Administration component on the same machine as
Contact Center Manager Server, or on a separate networked machine.

With the Contact Center Manager Administration award-winning Web-based
platform, you can perform the following functions:

m  Contact Center Management—Assign agents to supervisors and skillsets
to agents.

= Access and Partition Management—Create a Contact Center Manager
Administrator, and partitions and access classes for agents and supervisors.
Partitions define what a user can view, and access classes define what the
user is allowed to create, change or modify.

»  Configuration—Configure the contact center data such as users and
skillsets for the contact center. You can use templates in Microsoft Excel
spreadsheets to upload Contact Center Manager information.

»  Scripting—Create, modify, and validate contact routing instructions for the
contact center.

»  Real-Time Reporting—\View the dynamics of contact activity, agent
activity, skillset performance, nodal performance, and application
performance for both networked and single-node contact centers.

= Historical Reporting—Gather and present information about the past
performance of the contact center.

= Report Creation Wizard—Create, maintain, and modify customized
reports with a user-friendly interface.

14
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= Emergency Help—View notifications of agent emergencies. Agents can
click an Emergency button on the Contact Center Agent Desktop to alert
supervisors of contact emergencies.

m  Audit Trail—View a record of all actions performed in the Administration
configuration.

»  Outbound—Configure outbound campaigns if the Multimedia/Outbound
server software is installed. For more information about the Multimedia/
Outbound server, see “Contact Center Multimedia” on page 16.

Agent Desktop Display

The Agent Desktop Display application is a separate application that can be run
along with the Agent Desktop application to view real-time skillset monitoring
on agent desktops.

Communication Control Toolkit

The Communication Control Toolkit server is a server/client application that
helps you implement Computer Telephony Integration (CTI) for installed and
browser-based client integrations. It facilitates the integration of contact center,
knowledge worker, and self-service solutions with your client applications.

The Communication Control Toolkit contains the following elements:

s Communication Control Toolkit server—The component responsible for
managing client sessions consists of the following subcomponents:

s Contact Management Framework—An infrastructure component that
manages the states of contacts, agents, terminals, and addresses.

n  Telephony Application Program Interface (TAPI) Connector—An
application that converts Communication Control Toolkit requests to TAPI
Application Program Interface (API) calls, and TAPI events to
Communication Control Toolkit events. The TAPI Connector sits between
the Nortel TAPI Service Provider and the Contact Management
Framework.

m  TAPI Service Provider—A Microsoft TAPI client responsible for CTI
operations of all lines controlled by the Communication Control Toolkit
platform that are initialized by TAPI.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 15
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s Communication Control Toolkit API—An API that controls voice
resources. The API is published as Microsoft .NET types and distributed as
a Windows assembly, which is referenced by application developers.

m  Client applications—Third-party components including software phones,
agent telephony toolbars, or call management applications. The Contact
Center Agent Desktop is a Nortel software application that provides the
agent telephony toolbar functionality.

Contact Center Multimedia

The Contact Center Multimedia server contains contact center applications that
expand the contact center to allow agents to view, respond to, and track requests
over the Internet. E-mail and outbound contacts are directed to the first available
agent in the skillset who can handle the contact type. If more than one agent is
available, the contact is routed to the agent with the highest priority for the
skillset. Supervisors and administrators view real-time displays and run
historical reports to determine volume and completion statistics.

The Contact Center Multimedia server contains the following components:

»  Multimedia/Outbound database— The server component includes the
Caché database, or multimedia database, that stores all incoming e-mail
contacts, outbound campaigns, and associated responses in a structured
format within the database. The Multimedia Administrator, the Outbound
Campaign Management Tool, the Contact Center Agent Desktop, and
additional utilities are stored on the Contact Center Multimedia server.

m  Contact Center Redundancy server—You can optionally install a warm
standby server, or Redundancy server, to shadow the Caché database and
provide a quick recovery if the primary Contact Center Multimedia server
fails. All multimedia services are disabled on the Redundancy server, until
the Redundancy server is required to run as the primary server.

s Contact Center Multimedia Administrator—Use the Multimedia
Administrator application to configure the properties required for routing
contacts. For outbound contacts, you must configure skillsets. For e-mail
messages, you must configure E-mail Manager settings such as recipient
mailboxes, rules for routing e-mail messages, and skillsets. You can use the
Multimedia Administrator application for administration and data
management such as backing up data in the database.

16 Contact Center Manager



February 2007

Getting started

Outbound Campaign Management Tool—You access the Outbound
Campaign Management Tool from Contact Center Manager Administration
application. Administrators use the Outbound Campaign Management Tool
to create, modify, and monitor outbound campaigns. An outbound
campaign is a series of outbound calls to customers for one specific
purpose, such as a customer survey or a sales promaotion.

Contact Center Agent Desktop—Agents use Internet Explorer to connect
to the Contact Center Multimedia server to access the Agent Desktop
interface. The Communication Control Toolkit pushes e-mail, Web
requests, outbound contacts, and voice calls to the Agent Desktop interface.
Agents use the Agent Desktop interface to retrieve e-mail and outbound
campaign information, and customer details and history from the
Multimedia database. Agents also use the Agent Desktop application to
send e-mail replies and save outbound call details in the multimedia
database.

Migration Utility—A utility that you use to migrate the data from the
Symposium Web Center Portal database to the new Contact Center
Multimedia database.

Server Utility

Server Utility lets you to monitor and maintain Contact Center Manager Server
Release 6.0. The Server Utility provides functionality that is not available
through Contact Center Manager Administration.

The Server Utility is primarily used to do the following:

= Monitor and maintain desktop user accounts and access classes, serial
ports, switch resources, the Voice Prompt Editor, server settings, and
connected sessions, backup scheduler, and alarm monitor.

= Use the Provider application to receive Contact Center script
information over the Host Data Exchange (HDX) interface.
Additionally, it can be configured to return information to the Contact
Center script.

= Use the Service Monitor application to monitor the status of Contact
Center Manager Server 6.0 services from a standalone computer. The
information returned is similar to the information provided by SMONW.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 17
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m Use PC Event Browser to view events that occur on the client machine
where Contact Center Manager Administration is running. Events that
occur on the server cannot be viewed in the PC Event Browser window.

License Manager

Nortel uses a License Manager for the centralized licensing and control of all
Contact Center Suite 6.0 components and features across the Contact Center
suite (Contact Center Manager (nodal and Network Control Center), Contact
Center Manager Administration, Communication Control Toolkit, and Contact
Center Multimedia).

You must install the License Manager on the Contact Center Manager Server or
on the primary Contact Center Manager Server in a Network Control Center. If
you work in a direct connect environment, where there is no Contact Center
Manager Server, you must install the License Manager on the Communications
Control Toolkit server.

A Corporate License feature is available with Contact Center Suite 6.0, where
licensing for the entire contact center network is administered on a centralized
License Manager server thereby reducing administration overhead. With
Corporate Licensing, you can enable the concurrent agent licenses across a
contact center network. For example, if an agent logs off in California, the seat
(agent license) becomes available for use by an agent based in Texas thereby
maximizing the corporate license investment.

You can install a backup License Manager server on another Contact Center
Manager Server to ensure business continuity if the primary License Manager
server fails.

Network architecture

The Contact Center Manager Server network architecture includes three
components:

s Routed ELAN subnet
= Nortel server subnet

= Single network interface card (NIC) Contact Center Manager Server
configuration

18
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The ELAN subnet must be routed to the Nortel server subnet with one router.

Contact Center Manager Server now requires only a single network interface
card (NIC) configuration to connect to the Nortel server subnet. A second NIC
connected directly to the ELAN subnet is optional to accommodate delayed
legacy data network design changes. The single-NIC configuration is
encouraged as future Contact Center Manager Server releases and features (such
as SIP Contact Center) do not support the dual-NIC configuration.

Other software that works with Contact Center

You can install other software available through Nortel to work with the
components of Contact Center:

= Use the Host Data Exchange (HDX) application server as an optional host
computer to run a third-party provider application that receives data from
Contact Center Manager Server and returns data (such as an account
balance) to Contact Center Manager Server. Contact Center Manager
Server supports up to 10 HDX applications.

m  Use CallPilot/Meridian Mail Client voice mail system as a front-end
interactive voice response (IVR) or voice service for Contact Center
Manager Server.

m  Use Interactive Voice Response (IVR) to allow telephone callers to interact
with a host computer using prerecorded messages and prompts. You can
use Nortel IVR or third-party 1VR systems to provide front-end IVR to
calls before they are handed over to Contact Center Manager Server.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 19
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Communication Server 1000/Meridian 1 PBX changes

You now configure the following items through the Contact Center Manager
Administration Launchpad (in addition to configuring them on the switch and
voice-processing system):

= controlled directory numbers (CDN)

= Interactive voice response (IVR) Automatic call distribution directory
number (ACD-DN)

= agent phones (TN)

= Voice ports (virtual agents)
m  global settings

= script variables

Landing Pads

A Landing Pad in the first instance is a unique dialable number.

= Landing Pads are employed in the absence of the ability to tag a call
reference directly to the call, for example, no means of conveying a
Network Call ID along with the call to target (in the voice call signaling).

= Landing Pads are employed so that agents can dial a unique number on a
per call basis, to create a unique call reference.

= Aunique call reference is used to match a source routed call to a previously
reserved target agent, or more generally to track a call from source to
destination, where regular telephony information provided at source and
target for that call is not enough to uniquely differentiate between all calls
arriving.

= Landing Pads are normally grouped together as a pool of resources,
constantly reused.
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How to use this guide

This guide covers the configuration procedures for:

m  the ELAN subnet

m the ACCESS link

= switch subsystems

m  Meridian Link Services (MLYS)
m  Voice-processing systems

If the task you want to perform is not listed here, use the table of contents or
index to find the information you need.

Where to start in this guide

The following table provides some pointers on where to start for common

procedures.
If you want to do this Start here
Configure the ELAN subnet Chapter 3, “To configure the ELAN
subnet.”
Configure the ACCESS link Chapter 3, “To configure the ACCESS
link.”
Configure the following switch Chapter 4, “Switch subsystem
subsystems: configuration.”
= CDNs
= NACD-DNs
= IVR ACD-DNs
m Voice ports
= agent and supervisor TNs
= routes
m Multiple Queue Assignments

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 21
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If you want to do this Start here

Configure MLS Chapter 5, “Meridian Link Services
configuration.”

Configure voice processing Chapter 6, “Voice-processing
subsystem configuration.”

Test voice services Chapter 9, “Testing integration.”

Migrate from Meridian Mail to Chapter , “To migrate from Meridian

CallPilot Mail to CallPilot.”

Migrate from Meridian MAX to Chapter , “To migrate from Meridian

Contact Center Manager Server MAX to Contact Center Manager
Server.”

22 Contact Center Manager
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Skills you need

This guide is intended for individuals responsible for configuring,
administering, and maintaining the switch, CallPilot, Meridian Mail, or a third-
party voice-processing system.

This section describes the skills and knowledge that you need to use this guide
effectively. This guide is directed at the moderately experienced user and does
not detail the basics of the switch, CallPilot, Meridian Mail, or Contact Center
Manager Server operation, features, or administration.

The examples in this document are based on the following releases (with most or
all packages equipped):

s X11 Release 25.40B or Communication Server 1000 Release 3.0 or later

m  CallPilot 4.0 or Meridian Mail Release 13.2 or later

Note: CallPilot Release 3.1 continues to be supported in Contact Center
Manager Server 6.0. Any references to CallPilot in this guide also apply to
CallPilot 3.1.

= Contact Center Manager Server Release 6.0

Prompts, menus, and windows can look different for different releases of the
subsystems, or for subsystem equipped with different versions of the packages.

Nortel product knowledge

Knowledge of, or experience with, the following Nortel products can be of
assistance when administering Contact Center Manager Server:
= the appropriate switch type:

»  Meridian 1 PBX 11, 11C-Chassis, 51C, 61C, 81, or 81C (X11 Release
25.40B or later)

m  Communication Server 1000 Release 3.0 or later
s  CallPilot Release 4.0 or CallPilot Release 3.1
= Meridian Mail Release 13.2 or later

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 23
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PC experience or knowledge

Knowledge of, or experience with, the following PC products can be of
assistance when administering Contact Center Manager Server:

Microsoft Windows 2003 Server (Standard or Enterprise edition)
Microsoft Windows 2003 (Standard or Enterprise edition)
client/server architecture

Internet Protocol (IP)

Other experience or knowledge

Other types of experience or knowledge that may be of use include:

database management
flowcharting
programming

24
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Related documents

The following guides are available on the Contact Center portfolio DVD or on
the Nortel Web site (www.nortel.com).

For information about

Refer to

NTP number

Planning and
engineering guidelines,
and server requirements

Contact Center Planning and
Engineering Guide

297-2183-934

Contact Center Manager CapTool
User’s Guide

297-2183-935

Server requirements

Contact Center Server and Operating
System Requirements Guide

297-2183-263

The Contact Center
portfolio

Contact Center What’s New in
Release 6.0

297-2183-903

Switch configuration

Contact Center Communication
Server 1000/Meridian 1 and Voice
Processing Guide

297-2183-931

SIP Contact Center Switch Guide

297-2183-962

Contact Center 6.0 Security Guide

Contact Center Portfolio Service
Packs Compatibility and Security
Hotfixes Applicability List

Installation, upgrades,
migration, and
maintenance

Contact Center Manager Server
Installation and Maintenance Guide

297-2183-925

Contact Center Manager
Administration Installation and
Maintenance Guide

297-2183-926

Nortel Media Application Server
Installation and Configuration Guide
for Contact Center 6.0

297-2183-227
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For information about | Refer to NTP number

Scripting Contact Center Manager Scripting | 297-2183-930
Guide for Communication Server
1000/Meridian 1 PBX

Contact Center Manager Database | 297-2183-940
Integration User Guide

Administering contact | Contact Center Manager 297-2183-927

centers Administrator’s Guide

Handling contacts Contact Center Agent Desktop User |297-2183-945
Guide

CallPilot Application Builder Guide |555-7101-325

Host Data Exchange Programmer’s | 297-2183-939
Guide

Contact Center Manager Meridian 297-2183-941
Link Services Interface Specification
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How to get help

This section explains how to get help for Nortel products and services. However,
before contacting Nortel for support, consult “Troubleshooting” on page 261 of
this guide.

Finding the latest updates on the Nortel Web site

The content of this documentation was current at the time the product was
released. To check for updates to the latest documentation and software for
Contact Center 6.0, click one of the following links:

Link to Takes you directly to

Latest software The Nortel page for Contact Center located at
www.nortel.com/espl.

Latest documentation The Nortel page for Contact Center documentation
located at www.nortel.com/helmsman.

Getting help from the Nortel Web site

The best way to get technical support for Nortel products is the Nortel Technical
Support Web site:

www.hortel.com/support

This site provides quick access to software, documentation, bulletins, and tools
to address issues with Nortel products. From this site, you can:

s download software and related tools
= download technical documents, release notes, and product bulletins
= sign up for automatic notification of new software and documentation

= search the Technical Support Web site and Nortel Knowledge Base for
answers to technical issues

= open and manage technical support cases
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Getting help over the phone from a Nortel Solutions Center

If you do not find the information you require on the Nortel Technical Support
Web site, and you have a Nortel support contract, you can also get help over the
phone from a Nortel Solutions Center.

In North America, call 1-800-4ANORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the phone
number for your region:

www.nortel.com/callus

Getting help from a specialist by using an Express Routing Code

You can use an Express Routing Code (ERC) to more quickly route your call to
the appropriate support specialist. To locate the ERC for your product or service,

go to:

www.nhortel.com/erc

Getting help through a Nortel distributor or reseller

If you purchased a service contract for your Nortel product from a distributor or
authorized reseller, you can contact the technical support staff for that distributor
or reseller.
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Overview

Switch

The following subsystems work together to provide processing for a call:

Communication Server 1000 or Meridian 1 PBX switch
Contact Center Manager Server

voice-processing system (CallPilot, Meridian Mail, or a third-party
voice-processing system)

Note: Meridian Mail and CallPilot can coexist in the same environment.
For example, you can choose to use a legacy Meridian Mail for voice
mailboxes or to provide IVR (Interactive Voice Response) services, and use
CallPilot for advanced voice processing. However, Contact Center
Manager Server cannot use advanced voice-processing services from both
Meridian Mail and CallPilot.

Meridian Link Services

The following sections describe each of the subsystems.

The switch provides a speech path for a call between its source (usually a trunk)
and its destination (a RAN trunk, voice port, or agent). Two connections to the
switch interact with voice-processing systems: voice paths and signaling links.

Voice paths

\oice paths are connections that carry speech (phone calls). They are configured
as Terminal Numbers (TN) on the switch. The following table shows the voice
paths types used for different voice-processing systems.

Voice path type Voice-processing system

virtual ACD (Automatic Call | CallPilot or Meridian Mail
Distribution) agent phones

2500 phone TNs usually third-party voice-processing systems

2500 phone ACD agent TNs | usually third-party voice-processing systems
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Voice path type Voice-processing system

T1TNs usually third-party voice-processing systems
E1 TNs usually third-party voice-processing systems
Signaling links

Signaling links are connections that carry auxiliary information (such as
treatment directory numbers [DN]) between the switch and a voice-processing
system. Signaling links are optional, but they allow greater cooperation and
control between the switch and the voice-processing system.

Contact Center Manager Server

The server communicates with the switch and the voice-processing system.

Communicating with the switch

The server executes scripts and instructs the switch to set up the speech paths
necessary to connect calls to voice ports, agents, or RAN trunks, and to provide
tone treatments (such as ringback and busy) to calls. The server communicates
with the switch over the ELAN (Embedded Local Area Network) subnet and the
Nortel server subnet using the AML (Application Module Link) protocol.

Communicating with CallPilot

Contact Center Manager Server also communicates with CallPilot to instruct it
to play prompts, collect digits input by callers, or both.

For basic voice processing (Give IVR), the server communicates with CallPilot
over the Nortel server subnet, using the Meridian Link interface.

For advanced voice processing (Give Controlled Broadcast Announcement and
\Voice Session commands), the server tells CallPilot which prompts to play using
the ACCESS protocol over the ELAN subnet. Messages from the switch to
CallPilot (call arrival messages) travel on the ELAN subnet to Contact Center
Manager Server, which sends them over the Nortel server subnet (using the
MLS protocol) to CallPilot.
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Communicating with Meridian Mail
Contact Center Manager Server also communicates with Meridian Mail to
instruct it to play prompts, collect digits input by callers, or both.

For basic voice processing (Give IVR), the server communicates with Meridian
Mail over the ELAN subnet.

For advanced voice processing (Give Controlled Broadcast Announcement and
\oice Session commands), the server tells Meridian Mail which prompts to play
using the ACCESS link. Meridian Mail and the switch communicate using the
CSL (Command and Status Link).

CallPilot

The CallPilot voice channels connect to the switch by a DS30 cable. On the
switch side, you configure this card as an SL1 phone TN (virtual agent).

Contact Center Manager Server can access the voice services provided by
CallPilot through the following commands:

= Give IVR
s  Give Controlled Broadcast Announcement
= Open Voice Session

When the Give IVR script command is used, Contact Center Manager Server
sends the command, the ACD-DN (Automatic Call Distribution Directory
Number), and a treatment DN (if specified) to the switch. It sends this
information over the ELAN subnet and the Nortel server subnet, using the AML
protocol. When the call arrives at a CallPilot voice port, the switch alerts
CallPilot using Contact Center Manager. The alert is sent over the Nortel server
subnet, using the Meridian Link interface.

When the Give Controlled Broadcast Announcement or Open Voice Session
script commands are used, Contact Center Manager Server sends the command
and the ACD-DN to the switch. It sends this information over the ELAN subnet
and the Nortel server subnet, using the AML protocol. When the call arrives at a
CallPilot voice port, the switch alerts CallPilot using Contact Center Manager
through the Nortel server subnet, using the Meridian Link interface.
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Meridian Mail

The Meridian Mail voice channels connect to the switch by means of a special
network loop card. On the switch side, you configure this card as either an SL1
phone TN (virtual agent) or, for the Option 11, a 2008 phone TN.

Contact Center Manager Server can access the voice services provided by
Meridian Mail through the following commands:

= Give IVR
= Give Controlled Broadcast Announcement
= Open Voice Session

When the Give IVR script command is used, Contact Center Manager Server
sends the command and a treatment DN (if specified) to the switch over the
ELAN subnet. The switch passes the treatment DN to Meridian Mail.

When the Give Controlled Broadcast Announcement or Open Voice Session
script commands are used, the server uses the ACCESS link to communicate the
Play Prompt segment list (specified in the Play Prompt script command) to
Meridian Mail. For the Open Voice Session script command, the server can also
instruct Meridian Mail to collect digits (using the Collect Digits command).

Meridian Link

Meridian Link (MLink) is an interface used for communication between a host
application and the switch. The interface facilitates the integration of the
computer and the switch. In this integrated environment, the host processor
interacts with the switch by exchanging application layer messages.

You can develop Meridian Link applications, which allow you to use
information taken from the switch (such as Caller ID), connect to another
application to retrieve a matching record from a database, and then provide
screen populated information to help agents prepare for the call.
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Meridian Link Services

Meridian Link Services (MLS) is a process running on Contact Center Manager
Server that gives the customer Computer Telephony Integration (CTI) server
access to the Meridian Link interface. Through MLS, the server can connect to
Meridian Link applications over the Nortel server subnet.

External applications register with MLS to obtain access to application layer
messages. MLS commands that result in call processing requests are sent over
the ELAN subnet to the switch. Examples of external applications that can
register with MLS include Telephony Application Program Interface (TAPI)
Service Provider and CTI.

Connections between the subsystems

The subsystems communicate across local area networks (LAN) and serial links.

CallPilot

The following illustration shows connections using Contact Center Manager
Server and CallPilot.

HDX Application
Server

ELAN Subnet ‘
Media ‘

Customer LAN

CallPilot

Gateway Web Server CCMS CCMA

Routing  Firewall
h (Optional

Nortel Server Subnet

(Managed Ethernet Switch — for
example, BPS 2000, Baystack 450,
and so on)

Router
1100
Modem
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Meridian Mail

The following illustration shows connections using Contact Center Manager
Server and Meridian Mail.

HDX/Meridian
Link Applications

Call Server

ELAN Subnet \

z
<
3
o]
£
2
@
=1
(@]

Rodting  Firewall

Media
Gateway

Signaling 3p000000 Access Link [R232]----ctms  ccMA
Server =

Meridian Mail server

Nortel Server Subnet

(Managed Ethernet Switch — for
example, BPS 2000, Baystack 450,
and so on)

Router
1100
Modem

Subnets
The subsystems require the following types of subnets for communication:

s ELAN (Embedded Local Area Network) subnet—A dedicated Ethernet
TCP/IP LAN that connects the server in Contact Center Manager Server
and the switch.

= Nortel server subnet—The LAN to which your corporate services and
resources connect. The server in Contact Center Manager Server and client
both connect to the Nortel server subnet. Third-party applications that
interact with the server also connect to this LAN.

Serial links
The subsystems communicate using the following serial links:

= ACCESS Link—This is an RS-232 asynchronous connection between
Meridian Mail and ACCESS applications, such as Contact Center Manager
Server.
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s CSL (Command and Status Link)—This is an RS-232 asynchronous
connection between the switch and Meridian Mail.

Subsystems

Upon arrival of a call, control of the call passes from one subsystem to another.
Each subsystem provides a specific set of features or services.

To use these features, you must configure the following subsystems correctly:

s the Communication Server 1000 or Meridian 1 PBX switch

=  the voice-processing system (CallPilot, Meridian Mail, or a third-party
voice-processing system)

= Contact Center Manager Administration

= the links between Contact Center Manager Administration, the switch, and
the voice-processing system (if applicable)

You must also configure the switch for MLS if any of the following conditions
apply:

= you use Symposium Voice Services on CallPilot

= you use another MLS

As with any interlinked configuration, you must configure many parameters
consistently across these subsystems.

This chapter lists the entities that you must configure in each of the subsystems.
It provides a recommended configuration sequence to ensure that you configure
each entity correctly. It also provides checklists to use during configuration.
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Subsystem configuration reference
information

The following table shows the entities that you must configure on the different
subsystems. When you configure an entity on more than one subsystem, you
must ensure that the parameters are consistent across the subsystems.

CallPilot Meridian Contact
voice- Mail voice- |Center
Configuration processing |processing |Manager
element Switch |system system Server
ACD-DNs X X X
Contact Center X X
Manager CDNs
CallPilot Voice X X
Messaging Primary
CDN (Controlled
Directory Number)
IVR ACD-DNs X X X X
(ACCESS and IVR)
Landing pads X X
Mailboxes and X X
passwords (Meridian
Mail)
Phones X X
Routes X
Scripts X
Treatment DNs X X X X
(optional) | (SDN)

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 37



Configuration overview

Standard 6.0

CallPilot Meridian Contact
voice- Mail voice- |Center
Configuration processing | processing | Manager
element Switch |system system Server
\oice files and X X X
segments
Voice ports (Virtual X X X X
Agent TNs)/voice
channels
\oice service DNs X X

(VSDNs)

Meridian Mail refers to voice ports as voice channels.

To configure these entities on the switch, see Chapter 4, “Switch subsystem
configuration.” To configure these entities in CallPilot or Meridian Mail, see
Chapter 6, “Voice-processing subsystem configuration.” To configure these
entities on Contact Center Manager Server, see Chapter 7, “Contact Center

Manager configuration.”
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Recommended configuration sequence

Before you configure the subsystems, create a system design based on your
contact center requirements. Use the Capacity Assessment Tool (CapTool) to
determine the capacity requirements for your contact center.

Your design must take the following information into consideration:

network design (ELAN subnet, Nortel server subnet, and remote access
service [RAS] IP requirements)

projected peak call traffic
number of agents, shifts, days of operation
projected call flow and scripting requirements

voice messaging port requirements (number of ports required for Give IVR
and ACCESS services, such as Voice Sessions, Give Controlled Broadcast
Announcement, and collect digits sessions)

For more information, see the Contact Center Planning and Engineering Guide.

Configuration sequence

Nortel recommends that you complete the configuration in the following

sequence:
1. Install all subsystems using the associated documentation.
2. Ensure that the links between subsystems are configured, connected, and
functioning (see Chapter 3, “Subsystem connections configuration”).
3. Configure the switch (see Chapter 4, “Switch subsystem configuration”).
4. Configure the switch for MLS if any of the following conditions apply (see
Chapter 5, “Meridian Link Services configuration”):
= you use CallPilot as your voice-processing system
= you use another MLS
5. Configure CallPilot, Meridian Mail, or the third-party voice-processing

system (see Chapter 6, “\Voice-processing subsystem configuration”).
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6.

7.

Configure Contact Center Manager Server (see Chapter 7, “Contact Center
Manager configuration”).

Install and configure third-party applications.

To configure NSBR networking

If you use Network Skill-Based Routing (NSBR), you must also configure
networking.

You can network multiple servers using Universal Networking.

Configure networking after you configure and make operational each of the
individual servers in your network.

Release 1.1 of the Communication Server 1000 switch only supports IP line and
trunk networking. IP peer networking is supported on Release 2.0.

To configure networking, you must configure the following components:

the switch—Install and configure the NACD (Network Automatic Call

Distribution) package, and create the CDNSs to which networked calls for

each server are routed.

m For Universal Networking, you must provision Landing Pad CDNs or
Dialed Number Identification Services (DNIS) on the switch. For more
information, see “Landing Pads” on page 86.

the Network Control Center (NCC)—Install and configure the NCC
software.

the servers—Define the network CDNSs, configure the communication
parameters, assign agents to network skillsets, and modify the scripts to use
the Network Skill-Based Routing feature.
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ATTENTION | Contact Center Manager Server, if you use switches

that are networked together (calls transferred or routed
from one switch to another switch) regardless of
whether or not Network Skilled-Based Routing
(NSBR) is used, you must define a Home Location
Code (HLOC) in LD 15 that is distinct for each of the
switches on the network.

Nortel suggests that you set the HLOC equal to the Local
Steering Code (LSC) or, if you do not use a seven-digit
Coordinated Dialing Plan (CDP) and there is no LSC, set
it equal to the Network Numbering Exchange (NXX) or
Number Plan Area (NPA) of the local calling area.

For more information, see the Contact Center Manager Network Control Center
Administrator's Guide.

Release 1.1 of the Communication Server 1000 switch only supports networking
over Integrated Services Digital Network (ISDN) trunks. IP networking is
supported on Release 2.0. For more information, see the Communication Server
1000 documentation.
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Configuration checklists

The checklists in this section assume an understanding of the configuration
elements and how to check their status on the switch, CallPilot or Meridian
Mail, and Contact Center Manager Administration. If you do not know how to
check the status of a particular element, consult the appropriate section in this
guide or the appropriate guide for the subsystem.

In the following checklists, the subsystem Switch refers to both the
Communication Server 1000 and Meridian 1 PBX switches unless otherwise
indicated.

General checklist

Before proceeding to the command-specific setups, complete the following

checklist.
Subsystem |Description v
Switch Verify that Communication Server 1000/Meridian 1
PBX switch is up and running correctly.
Switch Install required Communication Server 1000/Meridian
1 PBX software packages (use LD 22 to verify the
packages). (See “Before you begin” on page 83 for
more information.)
Switch The following additional switch requirements are

available:

m Meridian 1 PBX dependency PEPs for Contact
Center Manager Server

m Meridian 1 PBX dependency PEPs for the specific
voice-processing subsystem you use

= provisioning of sufficient Call Registers
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Subsystem

Description

Switch

Verify that the ELAN subnet connection between
Contact Center Manager Server and Communication
Server 1000/Meridian 1 PBX switch is functioning.

Note the current ELAN subnet/VVSID number using LD
48. (This is useful for troubleshooting.)

Ensure that the default gateway is configured in the
switch using LD 117. (See “Default Gateway,” on page
76.)

Switch

Configure Contact Center Manager Server CDNs on
the switch. (See “To configure CDNs on the switch” on
page 86.)

Switch

Configure the Active Directory Services (ADS) or
SCB block on the switch with LD 23. (See “Creating a
CallPilot ACD-DN in LD 23,” on page 97.) Nortel
recommends that you use an ADS block.

CAUTION

Risk of ACD block corruption

Before performing this task, ensure that all agents log
off. Failure to do so can result in corruption of the ACD
block.

If you configure the ADS block, you must configure
DCUS in the PARM data block with LD 17. See
“Defining the ELAN subnet with LD 17,” on page 73.

Switch

Configure Agent ACD queues in LD 23. (See
“Creating a CallPilot ACD-DN in LD 23,” on page 97.)

When you configure the ADS or SCB block, the values
for HOML and RPRT are set to YES for existing ACD
queues. If HOML=YES, agents are logged off when
they replace the handset after a call. If this is not
appropriate for your environment, modify the HOML
parameter for existing ACD queues.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide
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Subsystem |Description 4

Switch Configure the agent and supervisor TNs on the switch.
(See “To configure agent and supervisor TNs on the
switch” on page 103.)

Switch Configure the trunk, music, and RAN routes on the
switch. (See “To configure routes on the switch” on
page 111.)

Give IVR checklists

If you use:
= CallPilot, use the “CallPilot checklist” on page 44
= Meridian Mail, use the “Meridian Mail checklist” on page 49

= athird-party voice processing engine, use the “Third-party voice-
processing engine checklist” on page 53

CallPilot checklist
Complete the following checklist if you use the Give IVR command with
CallPilot.

Subsystem |Description 4

Complete the general checklist.

CallPilot Verify that CallPilot is up and running for voice
messaging.

Switch and | Verify that CallPilot is in communication with the
CallPilot switch.

Switch Enable the link between the switch and the CallPilot
server for CTI operations (LD 48).

44 Contact Center Manager



February 2007 Configuration overview

Subsystem |Description 4

Switch Configure the IVR ACD-DN (for IVR voice ports) on
the switch (LD 23). For more information, see “To
configure IVR ACD-DNs on the switch” on page 96.

When you configure the IVR ACD-DN on the switch,
set the IVR and ALOG prompts to YES.

Switch Configure the IVR voice ports on the switch as virtual
agents (LD 11). For more information, see “To
configure voice ports on the switch” on page 100.

You must dedicate voice ports to Contact Center
Manager Server Give IVR voice service.

Contact Configure the CallPilot connection parameters for TCP
Center voice connection as follows:
Manager

m CallPilot connection IP (ELAN network interface
IP address) is set.

m CallPilot connection port is set (Set TCP port to
10008).

See “To configure voice connections” on page 181 for
more information.

Server

CallPilot Configure the CallPilot server configuration and enable
integration.

In the CallPilot Configuration Wizard, review all
CallPilot configuration information up to and including
the Switch Information page. On the Switch
Information page:

= Select Enable Contact Center Manager Server
Integration.

= Enter the customer number in the Switch Customer
Number box.

m Enter the Nortel server subnet address of Contact
Center Manager Server in the Contact Center
Manager Server CLAN (Customer Local Area
Network) IP Address field.
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Subsystem |Description 4

CallPilot Configure voice ports (IVR voice channels) in the
CallPilot server configuration.

In the CallPilot Configuration Wizard, identify and
configure the channels that provide IVR services to
Contact Center Manager Server. (See “Non-ACCESS
ports” on page 145 for more information.)

Notes:

= TN of the voice channel in CallPilot Mail = TN of
the virtual agent on the switch = Telephony/Port
Address of the phone on Contact Center Manager
Server.

m ACD-DN defined for the voice channel in CallPilot
= ACD-DN on the switch = IVR ACD-DN on
Contact Center Manager Server.

CallPilot Verify that the SDN table contains the CallPilot
Primary CDN.

= Application name is Voice Messaging.
m Media type is Voice.

CallPilot Verify the SDN table contains Contact Center Manager
Server IVR ACD-DNs. Configure the IVR ACD-DNs
as follows:

m Application name is Symposium Voice Services.
m Media type is Voice.
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Subsystem |Description
CallPilot Define Contact Center Manager Server Treatment DNs
as Service DN entries in the SDN table. Each
application is named and the media type is Voice. (Use
meaningful application names because CallPilot can
store a large number of applications.)
Notes:
= Applications with the media type of Voice contain
voice items that are actually announcements and
menus played to callers (Give IVR script
commands).
m Use CallPilot Application Builder to create, record,
and manage voice menus and announcements.
m Complete applications before they are selected in
the CallPilot SDN table.
Contact Configure and acquire IVR ACD-DN on the Contact
Center Center Manager Server (see “To configure IVR ACD-
Manager DNs on the server” on page 188).
Server
Contact Verify in Contact Center Manager Server that VSM
Center and Meridian Link Services Manager (MLSM)
Manager services are running. (Use the VSM Status window if it
Server is configured.)
Contact Configure and acquire the voice ports on the Contact
Center Center Manager Server (see “To configure voice ports
Manager on the server” on page 196).
Server Notes:
= VR voice ports are defined with a TN with no
channel number.
m All TNs in the switch belonging to the IVR ACD-
DNs in the switch are acquired by Contact Center
Manager Server as voice ports.
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Subsystem |Description 4

CallPilot Verify the acquired voice ports are idle in CallPilot.

Use the Channel Monitor in CallPilot Manager to
check voice port status. If the voice ports are not
initialized, restart CallPilot.

Contact Implement and activate the Give IVR test script before

Center activating the rest of the voice-processing scripts.

Manager The voice-processing script command uses both the

Server IVR ACD-DN and a Treatment DN, as in the following
examples:

GIVE IVR ivr_qgueue WITH TREATMENT
welcome_msg

GIVE IVR 6000 WITH TREATMENT
1001

(See “To define scripts” on page 207 for more
information.)

If you do not specify the Treatment DN that is in the
script, the server uses the default Treatment DN
(TRDN) defined for the IVR ACD-DN on the switch.
Ensure that the default treatment is also configured in
the SDN table in CallPilot for proper operation.

Contact Activate the Master Script.
Center Activate scripts containing voice processing
Manager instructions after all relevant subsystem configurations.
Server
Contact Verify the Give IVR test script is working:
Center = Other scripts are verified and any additional
g/lanager voice-processing scripts are implemented.
erver )
m The SDN table is updated as new treatments are
required.

If the test script is not working:
m Start troubleshooting procedures.
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Meridian Mai

Meridian Mail is not available on the Communication Server 1000 switch.

Complete the following checklist if you use the Give IVR command with

| checklist

Meridian Mail:

Subsystem |Description
Complete the general checklist.

Meridian Verify that Meridian Mail is up and running for voice

Mail messaging.

Switch and | Verify that Meridian Mail is in communication with the

Meridian switch.

Mail

Switch Configure the IVR ACD-DN (for IVR voice ports) on
the switch (see “To configure IVR ACD-DNs on the
switch” on page 96).
When you configure the IVR ACD-DN on the switch,
set the IVR and ALOG prompts to YES.

Switch Configure the IVR voice ports on the switch as virtual
agents (see “To configure voice ports on the switch” on
page 100).
Dedicate voice ports to Contact Center Manager Server
Give IVR voice service.

Meridian Configure Contact Center Manager Server IVR ACD-

Mail DNs in the VSDN table. Associate them with a Voice
Messaging service type.
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Subsystem |Description 4
Meridian Configure Contact Center Manager Server Treatment
Mail DNs in the VSDN table.

Notes:

m Associate treatment DNs with the desired voice
application (for example, a voice menu or an
announcement).

m Create Menus and Announcement Services before
associating with a Treatment DN entry in the VSDN
table.

= See “To configure Meridian Mail for Give IVR” on
page 169 for more information.

Meridian Define IVR ACD-DN and IVR ports in the Channel
Mail Allocation Table (see “To configure VR voice ports”
on page 172).

Notes:

= TN of the voice channel in Meridian Mail = TN of
the virtual agent on the switch = Telephony/Port
Address of the phone on Contact Center Manager
Server.

m ACD-DN defined for the voice channel in Meridian
Mail = ACD-DN of the TN on the switch = number
of IVR ACD-DN on Contact Center Manager

Server.
Contact Configure and acquire IVR ACD-DN on Contact
Center Center Manager Server (see “To configure IVR ACD-
Manager DNs on the server” on page 188).
Server
Contact Verify in Contact Center Manager Server that the VSM
Center service is running. (Use the VSM Status window if it is
Manager configured.)
Server
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Subsystem |Description 4
Contact Configure and acquire voice ports on the Contact

Center Center Manager Server (see “To configure voice ports
Manager on the server” on page 196).

Server Notes:

m Define IVR voice ports with a TN with no channel
number.

m Contact Center Manager Server acquires all TNs in
the switch belonging to the IVR ACD-DNs in the
switch as voice ports.

Meridian Verify the acquired voice ports are idle in Meridian
Mail Mail.

Use the Digital Signal Processing (DSP) Port Status (in
the Meridian Mail Administration Terminal) to check
voice port status.

Contact Implement and activate the Give IVR test script before

Center activating the rest of the voice-processing scripts.

Manager The voice-processing script command uses both the

Server IVR ACD-DN and a Treatment DN, as in the following
examples:

GIVE IVR ivr_qgueue WITH TREATMENT
welcome_msg

GIVE IVR 6000 WITH TREATMENT

1001

(See “To define scripts” on page 207 for more
information.)

If the Treatment DN is not specified in the script, the
server uses the default Treatment DN (TRDN) defined
for the IVR ACD-DN on the switch. Ensure that the
default treatment is also configured in the VSDN table
in Meridian Mail for proper operation.
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Subsystem |Description 4
Contact Activate the Master Script.
Center Activate scripts containing voice processing
Manager instructions after all relevant subsystem configurations.
Server
Contact Verify that the Give IVR test script is working:
Center = Other scripts are verified and any additional
g/lanager voice-processing scripts are implemented.
erver .
= The VSDN table is updated as new treatments are
required.
If the test script is not working:
m Start troubleshooting procedures.
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Third-party voice-processing engine checklist

If you use the Give IVR command with a third-party voice-processing engine,
complete the tasks in the following checklist in the order listed.

The Give IVR script statement can use only voice ports defined on the switch as
ACD agents. If the voice-processing engine connects to the switch as any other
type of device, only the Route Call command is used in a script to hand off the

call to the voice-processing engine.

Subsystem |Description
Complete the general checklist.

Switch Configure the IVR ACD-DN on the switch (see the
documentation provided with your IVR system).
When you configure the IVR ACD-DN on the switch,
set the IVR prompt to YES.

Switch Configure voice ports on the switch as analog agents
(see the documentation provided with your IVR
system).

You must use dedicated voice ports.

Switch Verify that the third-party voice-processing system is
up and communicating properly with the switch.

\oice Configure voice ports in the third-party

processing | voice-processing system.

Contact Configure and acquire the IVR ACD-DN on the server

Center (see “To configure IVR ACD-DNSs on the server” on

Manager page 188).

Server
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Subsystem |Description
Contact Configure and acquire the voice ports on the server
Center (see “To configure voice ports on the server” on page
Manager 196).
Server Notes:
m Define voice ports with a TN only (the channel
number field is blank).
= TN of virtual agent on switch = Telephony/Port
Address of phone on server.
m The server acquires all TNs in the switch ACD-DN
as voice ports.
Contact Verify that the script command refers to the IVR ACD-
Center DN that is acquired.
Manager
Server
Contact If an APL link exists, specify a treatment DN one of the
Center following ways:
g/lanager = A treatment DN is explicitly specified in the script.
erver
s The Default Treatment DN for the IVR ACD-DN is
set correctly on the switch.
n If IPML (Inter-Peripheral Message Link) exists, the
treatment DN is specified in the script.
If the treatment DN is not specified in the script, the
server uses the default treatment DN defined for the
IVR ACD-DN on the switch.
Contact Verify that voice ports behind the IVR ACD-DN
Center acquired by the server are indicated by the switch and
Manager show their state as either Logged In or Logged Out.
Server

Ports must be Logged In for the switch to connect calls
to the port for voice processing.
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Give Controlled Broadcast Announcement and Open Voice Session

checklists

If you use:

m  CallPilot, use the “CallPilot checklist” on page 55.
= Meridian Mail, use the “Meridian Mail checklist” on page 62.

ATTENTION

The Give Controlled Broadcast feature is not supported on the

Communication Server 1000E. Nortel recommends using
Open Voice Session with Play Prompt or Collect Digits with
this switch type. For more detailed information, see Bulletin

Number P-2006-0312-Global.

CallPilot checklist
If you use the Give Controlled Broadcast Announcement or Open Voice Session
commands with Sympaosium Voice Services on CallPilot, complete the tasks in

the following checklist in the order listed:

Subsystem |Description
Complete the general checklist.

CallPilot Verify that CallPilot is up and running for voice
messaging.

Switch and | Verify that CallPilot is in communication with the

CallPilot switch.

Switch Verify that the link between the switch and the
CallPilot server is enabled for CTI operations.

Switch Configure the ACCESS ACD-DN (for ACCESS voice
ports) on the switch (see “To configure IVR ACD-DNs
on the switch” on page 96).
When you configure the ACD-DN on the switch, set
the IVR and ALOG prompts to YES.
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Subsystem |Description 4

Switch Verify that ACCESS voice ports are configured on the
switch as virtual agents (see “To configure voice ports
on the switch” on page 100).

Voice ports must be dedicated to Contact Center
Manager Server ACCESS voice service.

Contact Configure the CallPilot connection parameters for TCP

Center voice connection as follows:

g/lanager = CallPilot connection IP (CLAN network interface
erver

IP address) is set.

m CallPilot connection port is set (Set the TCP port to
10008).

See “To configure voice connections” on page 181 for
more information.

Meridian If you change voice services from Meridian Mail to
Mail CallPilot, ensure that the following conditions are met:

m Meridian Mail resources are deacquired on Contact
Center Manager Server (IVR and ACCESS ACD-
DNs, TNs, voice ports).

m The ACCESS cable is physically disconnected from
the Contact Center Manager Server COM port.

= The other end of the cable is disconnected from the
Meridian Mail utility card.
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Subsystem |Description 4

CallPilot Verify that the CallPilot server configuration is updated
and integration is enabled.

In the CallPilot Configuration Wizard, review all
CallPilot configuration information up to and including
the Switch Information page. On the Switch
Information page:

m Select Enable Contact Center Manager Server
Integration.

= Enter the customer number in the Switch Customer
Number box.

m Enter the Nortel server subnet address of Contact
Center Manager Server in the Contact Center
Manager Server CLAN IP Address field.

CallPilot Verify that Voice ports (ACCESS channels) are
configured in the CallPilot server configuration.

In the CallPilot Configuration Wizard, identify and
configure the channels that provide ACCESS services
to Contact Center Manager Server. (See “ACCESS
voice ports” on page 144 for more information.)

Notes:

= \oice port channel number on Contact Center
Manager Server = Class ID of the TN on CallPilot.

= TN of voice channel in CallPilot = TN of virtual
agent on switch = Telephony/Port Address of phone
on Contact Center Manager Server (with the voice
port option selected).

= ACD-DN defined for the voice channel in CallPilot
= ACD-DN on switch = ACCESS ACD-DN on
Contact Center Manager Server.
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Subsystem |Description 4

CallPilot Verify that the SDN table contains the CallPilot
Primary CDN.

m Application name is Voice Messaging.
= Media type is Voice.

CallPilot Update the SDN table in CallPilot with Contact Center
Manager Server ACCESS ACD-DNs. ACD-DNs are
configured as follows:

= Application name is Symposium \Voice Services.
= Media type is Voice.

Contact Configure and acquire ACCESS ACD-DN on the
Center Contact Center Manager Server (see “To configure the
Manager ACCESS IVR ACD-DN” on page 157).

Server

Contact Configure the global settings on Contact Center
Center Manager Server (see “To configure Global settings” on
Manager page 199) to specify the following:

Server » default ACCESS Treatment DN and ACCESS

ACD-DN (these have the same value)
= number of ACCESS ports reserved for broadcasts
= Broadcast Voice Port Wait Timer

» the mailbox number and password are not used—
leave at default values
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Subsystem |Description

Contact Configure and acquire the voice ports on Contact

Center Center Manager Server (see “To configure voice ports

Manager on the server” on page 196).

Server Notes:

m ACCESS voice ports are defined with both a TN
and a channel.

m All TNs in the switch belonging to the ACCESS
ACD-DNs in the switch are acquired by Contact
Center Manager Server as voice ports.

Contact Verify that the ACCESS link between Contact Center

Center Manager Server and CallPilot is functioning correctly.

Manager In Contact Center Manager Server, verify that VSM

Server and MLSM services are running. (Use the VSM Status
window if it is configured.)

CallPilot Verify that the acquired voice ports are idle. Use the
Channel Monitor in CallPilot Manager to check voice
port status. If the voice ports are not initialized, restart
CallPilot.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide

59



Configuration overview

Standard 6.0

Subsystem |Description 4
Contact Define voice segments as follows:

Center = System predefined voice segments (file 1, which
Manager contains all the number prompts) are updated.

Serve, (Make a list of the segment IDs referenced in the
CallPilot

Contact Center Manager Server variable table.)
= New user voice segments are defined.
Notes:

m Use Application Builder to define voice items
(referred to in Contact Center Manager Server as
voice segments or prompts).

In Contact Center Manager Server, the variables are
defined as

<application name> : <segment ID>

(For more information, see “Test scripts” on page
242.) Application names are case-sensitive.

m Create voice items or voice prompts first in
Application Builder before you define the voice
segment variables used in Contact Center Manager
Server scripts.

For more information, see the CallPilot Application
Builder Guide and “To define voice segment variables”
on page 205.
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Subsystem |Description
Contact Implement and activate the ACCESS test script before
Center activating the rest of the voice-processing scripts.
Manager The voice-processing script command uses both the
Server ACCESS ACD-DN (optional) and voice segment
variables that refer to the voice prompts that the caller
hears.
For example:
GIVE CONTROLLED BROADCAST ANNOUNCEMENT
PLAY PROMPT VOICE SEGMENT
closed_message_vs
OPEN VOICE SESSION
PLAY PROMPT VOICE SEGMENT
hold_option_vs
COLLECT 1 DIGITS INTO hold_choice_cv
END VOICE SESSION
(See “To define scripts” on page 207 for more
information.)
Contact Activate the Master Script.
Center Activate scripts containing voice processing
Manager instructions after all relevant subsystem configurations.
Server
Contact Verify that the Give Controlled Broadcast
Center Announcement and Open Voice Session test script is
Manager working.
Server = Other scripts are verified and any additional
voice-processing scripts are implemented.
= \oice segment variables are updated as required.
If the test script is not working:
m Start troubleshooting procedures.
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Meridian Mail checklist

If you use the Give Controlled Broadcast Announcement or Open Voice Session
commands with Symposium Voice Services on CallPilot or Symposium Voice
Services on Meridian Mail, complete the tasks in the following checklist in the

order listed:

Subsystem |Description v

Complete the general checklist.

Meridian Verify that Meridian Mail is up and running for voice

Mail messaging.

Switch and | Verify that Meridian Mail is in communication with the
Meridian switch.

Mail

Switch Configure the ACCESS ACD-DN (for ACCESS voice

ports) on the switch (see “To configure IVR ACD-DNs
on the switch” on page 96).

When you configure the ACD-DN on the switch, set
the IVR and ALOG prompts to YES.

Switch Configure the ACCESS voice ports on the switch as
virtual agents (see “To configure voice ports on the
switch” on page 100).

Dedicate voice ports to Contact Center Manager Server
ACCESS voice service.

Contact Set the voice connection type (on Contact Center
Center Manager Server client) to serial. See “To configure
Manager voice connections” on page 181 for more information.
Server

Meridian Configure the Contact Center Manager Server

Mail ACCESS ACD-DNs in the VSDN table. Associate

ACCESS ACD-DNs with an ACC service type.
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Meridian Define the ACCESS ACD-DN and ACCESS ports in
Mail the Channel Allocation Table (see “To configure
ACCESS voice ports” on page 158).
Notes:
= TN of the voice channel in Meridian Mail = TN of
the virtual agent on the switch = Telephony/Port
Address of the phone on Contact Center Manager
Server.
= ACD-DN defined for the voice channel in Meridian
Mail = ACD-DN on the switch = IVR ACD-DN on
Contact Center Manager Server.
Contact Configure and acquire the ACCESS ACD-DN on the
Center Contact Center Manager Server (see “To configure the
Manager ACCESS IVR ACD-DN” on page 157).
Server
Contact Configure the Meridian Mail mailbox and password.
Center = An appropriate Meridian Mail mailbox password
Manager policy is defined for Contact Center Manager
Server and Server.
Meridian - . .
Mail m Meridian Mail mailbox and password are created,
updated, or checked.
= Contact Center Manager Server global settings are
updated with the mailbox and password.
If the password expires, you cannot access the Voice
Prompt Editor and callers cannot hear the prompts
because Contact Center Manager Server cannot open
the mailbox.
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Subsystem |Description 4
Contact Configure the global settings on Contact Center

Center Manager Server (see “To configure Global settings” on
Manager page 199) to specify the following:

Server » default ACCESS Treatment DN and ACCESS

ACD-DN (these have the same value)
= number of ACCESS ports reserved for broadcasts
= Broadcast Voice Port Wait Timer

m the ACCESS mailbox number and password
configured in Meridian Mail for voice prompts

Contact Configure and acquire voice ports on the Contact
Center Center Manager Server (see “To configure voice ports
Manager on the server” on page 196).

Server Notes:

m ACCESS voice ports are defined with both a TN
and a channel.
= All TNs in the switch belonging to the ACCESS

ACD-DNs in the switch are acquired by Contact
Center Manager Server as voice ports.

Contact Verify that the ACCESS link between Contact Center

Center Manager Server and Meridian Mail is functioning

Manager correctly.

Server In Contact Center Manager Server, the MLSM service
iS running.

Meridian Verify that the acquired voice ports are Active in

Mail Meridian Mail.

Use the DSP Port Status (in the Meridian Mail
Administration Terminal) to check voice port status.
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Subsystem |Description 4
Contact Define the voice segments as follows:
Center

» System predefined voice segments (file 1, which

Manager contains all the number prompts) are updated.

Serv_er_, (Make a list of the segment IDs referenced in the

me_rl'd'a” Contact Center Manager Server variable table.)
ai

= New user voice segments are defined.
Notes:

= Use the Voice Prompt Editor (VPE) to create or
delete voice files and record voice segments.

\Voice segments created with VVPE are stored in
Meridian Mail. The variables are defined as

<voice file name> : <segment number>

Voice file names are case-sensitive.

m Create voice items or voice prompts first in VPE
before you define the voice segment variables used
in Contact Center Manager Server scripts.

For more information, see:

= “To configure Meridian Mail for ACCESS” on page
157

= “To define voice segment variables” on page 205
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Subsystem |Description 4
Contact Implement and activate the ACCESS test script before
Center activating the rest of the voice-processing scripts.
Manager The voice-processing script command uses both the
Server ACCESS ACD-DN (optional) and voice segment

variables that refer to the voice prompts that the caller

hears.

For example:

GIVE CONTROLLED BROADCAST ANNOUNCEMENT
PLAY PROMPT VOICE SEGMENT
closed_message_vs

OPEN VOICE SESSION

PLAY PROMPT VOICE SEGMENT
hold_option_vs

COLLECT 1 DIGITS INTO hold_choice_cv
END VOICE SESSION

(See “To define scripts” on page 207 for more
information.)

Contact Activate the Master Script.

Center Activate scripts containing voice processing

Manager instructions after all relevant subsystem configurations.
Server

Contact Verify the Give Controlled Broadcast Announcement
Center and Open Voice Session test script is working.
Manager = Other scripts are verified and any additional

Server voice-processing scripts are implemented.

= \oice segment variables are updated as required.
If the test script is not working:
m Start troubleshooting procedures.
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NSBR/Queue to NACD command checklist

If you use Network Skill-Based Routing or the Queue to NACD command,

ensure that NACD is configured correctly on the switch. This entails the tasks in
the following checklist.

Subsystem |Description

Switch Install the NACD package on the switch.

Switch Define the Release ID for the D-channels in
LD 17. (See “Defining the ELAN subnet with LD 17,”
on page 73.)

Switch For a Uniform Dialing Plan (UDP), configure the

following:

m ISDN (Integrated Services Digital Network) Route
Data Block with INAC = YES and PNI (Personal

Number Identification) of the Target Node to which

these routes are connected (LD 16)
m AC1lor AC2 in the ESN Data Block (LD 86)

m Route List Index (RLI) with no Digit Manipulation
Index (DMI) for the customer (LD 86)

= DMI table that deletes 3 digits for the customer (LD

86)
s LOC with RLI for each node (LD 90)

m HLOC for each customer (LD 15). If AC2 is used
within the NACD Routing tables, put LOC after
AC2. If ACL1 is used within the NACD Routing
tables, do not put LOC after AC2.

= PNI that is a unique identifier (LD 15)
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Subsystem |Description 4
Switch For a Coordinated Dialing Plan (CDP), configure the
following:

m ISDN Route Data Block with the PNI (Personal
Number Identification) of the Target Node to which
these routes are connected (LD 16)

= Route List Index (RLI) with no Digit Manipulation
Index (DMI) for the customer (LD 86)

m Local Steering Code (LSC) that deletes three digits
(if using seven-digit CDP, and DNs are four digits)
(LD 87)

= Distant Steering Code (DSC) with RLI for each
node (LD 87)

m LSC for each customer (LD 15)
m HLOC for each customer (LD 15)
m PNI that is a unique identifier (LD 15)

ATTENTION

In Contact Center Manager Server, if you use switches
that are networked together (calls transferred or routed
from one switch to another switch) regardless of
whether Network Skilled-Based Routing (NSBR) is
used, you must define a Home Location Code (HLOC)
in LD 15 that is distinct for each of the switches on the
network.

Nortel suggests that you set the HLOC equal to the
LSC or, if you do not user a seven-digit CDP and there
is no LSC, set it equal to the NXX or NPA of the local
calling area.
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Switch

Configure an ACD-DN for NACD with the following
(LD 23):

m Day and Night Routing Tables

= Call Answering Algorithms—OlIdest Call in
Network (OCN) and High Priority Queue (HPQ)

m NACD timers, such as RAGT (Reserve Agent
Timer), CRQ (Call Request Queue), and FCTH
(Flow Control Threshold)

For more information, see the NACD documentation.

Switch

For the Queue to NACD command only. Configure an
ACD-DN on the switch, with an associated Night
Routing Table containing remote targets and time
values. This ACD-DN has no positions assigned and,
therefore, is always in Night Mode. It lets the Queue To
NACD command. (See “To configure NACD-DNs to
enable the Queue to NACD command” on page 92.)

The switch supports call routing through tandem nodes. To route calls through

tandem nodes, ensure that you provision your Nortel server subnet/WAN to
allow the transmission of messages from one Contact Center Manager to
another. Also, the tandem nodes must have the NACD package and all its

prerequisites installed.
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Overview

To enable the features of Contact Center Manager Server to operate correctly,
you must configure the following links between the subsystems:

the IP address and the default gateway on the switch

the ELAN subnet between the switch, Contact Center Manager Server, and
CallPilot

the ACCESS link between Contact Center Manager Server and the voice-
processing system (if you use Symposium Voice Services on CallPilot or
Meridian Mail to provide voice-processing services). For more information
about configuring the ACCESS link, see “To configure the ACCESS link”
on page 77.
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To configure the ELAN subnet

To configure and verify the ELAN subnet, you must perform the following

tasks:

m  Define the Embedded LAN (ELAN) and a Value Added Server (VAS).
= Enable the ELAN subnet link.
m  Check the ELAN subnet link.
m  Check the AML link.

m  Define a default gateway address.

s Check the ELAN subnet to Nortel server subnet communication.

These tasks associate the ELAN subnet link with a VSID to allow message
transmission.

In these procedures, it is assumed that CallPilot or Meridian Mail and the switch
are installed and communicating correctly.

Defining the ELAN subnet with LD 17

Use these prompts and responses in LD 17. For prompts that are not specified
in the following table, press Enter.

Prompt Response Description

REQ CHG Change

TYPE CFN Configuration Record

ADAN NEW ELAN 16, CHG Add/change/remove

ELAN 16, OUT ELAN 16 |1/O device type ELAN 16 (AML over

Ethernet).

CTYP ELAN Card type

DES NAME Enter a name for the ELAN subnet port
number. Use a generic name because
the ELAN subnet port is not dedicated
to a specific application.
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Prompt Response Description
VAS NEW Add a Value Added Server (VAS).
VSID 16 Value Added Server identifier.
ELAN 16-31 Associate VSID with the ELAN subnet.
SECU Yes Turn on security for MLS applications.
CSQO CS 1000 Release 3.0, Number of call registers linked to output
4.0,4.5 queue.
25% of NCR maximum NCR = total number of call registers
X11 Release 25.40B Switch patch MPLR12423 is required.
2040 maximum This patch multiplies the values by 8.
For example, a setting of 255 becomes
255 x 8 = 2040.
csal CS 1000 Release 3.0, Number of call registers linked to input
4.0,4.5 queue.
25% of NCR maximum NCR = total number of call registers
X11 Release 25.40B Switch patch MPLR12423 is required.
2040 maximum This patch multiplies the values by 8.
For example, a setting of 255 becomes
255 x 8 = 2040.
REQ END Exit from overlay.

Enabling the ELAN subnet link

1 At the switch administration terminal, load LD 48.

2  Type the command enl elan 16.

To check the ELAN subnet with LD 48

When you configure the VSID and power up Contact Center Manager Server,
the ELAN subnet link comes into service.
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Checking the ELAN subnet link

1 At the switch administration terminal, load LD 48.
Type the command stat elan.

3  Ensure that, under your Contact Center Manager Server ELAN IP address,
LYR7 and APPL are active. Note the ELAN ID.

Example

ELAN #: 16 DES: the application (for example, elan16)

APPL_IP_ID: 47.152.163.68 LYR7: ACTIVE EMPTY APPL
ACTIVE

4  If the ELAN subnet is not active, check the ELAN subnet connection by
pinging the switch IP address from the application:

a. Open a DOS prompt.

b. Type ping nnn.nnn.nnn.nnn, where nnn.nnn.nnn.nnn is the switch IP
address.

c. Press Enter.

To check the AML link

If you use Meridian Mail for your voice services, you can check the AML link.

Checking the AML link

1 At the switch administration terminal, load LD 48.
Type the command stat aml.
3 Ensure that LYR2 is connected and LYR7 is active.

Example

>1d 48

.stat aml

AML: 09 ESDI: 09 DES: mail\

LYR2: CONNECTED LYR7: ACTIVE EMPTY
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Default Gateway

In Contact Center Manager, you must connect the ELAN subnet to the Nortel
server subnet through one (and only one) router. Aside from the physical
connection, you must configure machines on all sides of the router to
acknowledge the presence of this router (also known as the default gateway).

Define a default gateway address
Type the following commands:
>LD 117

>new route 0.0.0.0 a.b.c.d

where a.b.c.d denotes the IP address of the gateway local to the telephony
switch.
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To configure the ACCESS link

If you use Symposium Voice Services on CallPilot or Meridian Mail, you can
include Open Voice Session or Give Controlled Broadcast Announcement
commands in your scripts. Contact Center Manager Server communicates with
the voice-processing system that provides these services using the ACCESS
link. You must configure the link between the server and the voice-processing
system by performing these tasks:

s Enable ACCESS on the voice-processing system.
Note: CallPilot installs with ACCESS enabled.

= Set up the physical connection from Contact Center Manager Server to the
voice-processing system.

m  Configure the ACCESS link between Contact Center Manager Server and
the voice-processing system. For more information about configuring the
ACCESS link, see “To configure the ACCESS link to Contact Center
Manager Server” on page 78.

For a detailed explanation of how voice-processing functions in Contact Center
Manager Server, see Chapter 6, “Voice-processing subsystem configuration.”
To determine whether ACCESS is enabled on Meridian Mail

At the Meridian Mail administration terminal, ensure that Meridian Mail is
equipped with the Meridian ACCESS feature. You can check this by going to
TOOLS level > Display system record.

If Meridian Mail does not have the ACCESS feature, you must upgrade the
product to include this feature.
To establish a physical connection to Contact Center Manager Server

You can use one of two ways to establish a physical connection to Contact
Center Manager Server, from CallPilot, or from Meridian Mail.
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From CallPilot

CallPilot communicates with Contact Center Manager Server over the
Embedded LAN (ELAN). Ensure that the CallPilot server is physically
connected to the ELAN subnet.

From Meridian Mail

You must establish a physical connection between the ACCESS voice port on
Meridian Mail and the COMZ2 port on Contact Center Manager Server. The
physical cable varies depending on which Meridian Mail platform you use:

= OnaModular Option platform, an NT4R20AA fan-out cable is connected
to the 1/O panel connector labeled RSM. From the defined fan-out port,
connect a Null modem cable DB-25 male connector to a DB-9 female
connector.

= Onthe Modular Option EC platform, an NT6P0109 fan-out (five DB-25
connectors) cable is connected to the 1/0 panel connector labeled 5RS232.
From the defined fan-out port, connect a Null modem cable DB-25 male
connector to a DB-9 female connector.

= Onthe Option 11C Meridian Mail platform, you must configure an RSM
interface card and a fan-out cable.

To configure the ACCESS link to Contact Center Manager Server

You can use one of two ways to configure the ACCESS link to Contact Center
Manager Server, from CallPilot, or from Meridian Mail.

From CallPilot

When you configure CallPilot, you must specify the Nortel server subnet IP
address of Contact Center Manager Server in the CallPilot Configuration
Wizard. For detailed instructions, see “Updating CallPilot configuration” on
page 146.

When you configure Contact Center Manager Server, you must specify the
ELAN network interface IP address of the CallPilot server on Contact Center
Manager Server. For detailed instructions, see “Configuring the CallPilot
connection” on page 182.
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From Meridian Mail

On Contact Center Manager Server, the COM2 port is automatically configured
for the ACCESS Link, at 9600 bits per second (bps). You must configure the
physical port used for the ACCESS link on Meridian Mail for ACCESS, and its
baud rate must match that configured in Contact Center Manager Server.

Configuring the ACCESS link on Meridian Mail

1

7

In the Meridian Mail Integrated Communication Link window, click Add
Link.

Result: The Add/Modify Link window appears.

In the Link Name box, enter a name for the link.

The name of the link can:

m be 1-19 alphanumeric characters long.

m include single spaces, except at the beginning and end of the name.
m not be SysOps or any lowercase or uppercase version of the word.
From the Users Port menu, select an appropriate port.

Click OK.

Result: If you create the first link for a COM port, the Modify Connection
window appears.

From the Protocol menu, select MMLink.
From the Baud Rate menu, select 9600.

The baud rate must match the baud rate configured on Meridian Mail. If the
number of ACCESS ports is greater than 48, and then set the baud rate to
19.2 in Contact Center Manager and Meridian Mail.

Click OK.

If you enter all of the parameters correctly, the ACCESS link appears. You can
ensure that the ACCESS link is synchronized through the Meridian Mail Tools
ACCESS diagnostics.
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Where to go from here

To complete configuration of voice processing, you must also:

configure IVR ACD-DNs on the switch. For more information, see “To
configure IVR ACD-DNs on the switch” on page 96.

configure voice ports on the switch. For more information, see “To
configure voice ports on the switch” on page 100.

configure ACCESS voice ports on the voice-processing system. For more
information about configuring ACCESS voice ports on CallPilot, see “To
update CallPilot configuration” on page 146. For more information about
configuring ACCESS voice ports on Meridian Mail, see “To configure
Meridian Mail for ACCESS” on page 157.
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Overview

You must configure the following elements on the Communication Server 1000
or Meridian 1 PBX switch.

Element For more information, see

CDNs “To configure CDNSs on the switch”
on page 86

networked ACD-DNs “To configure NACD-DNs to enable
the Queue to NACD command” on
page 92

IVR ACD-DNs “To configure IVR ACD-DNs on the

switch” on page 96

voice ports “To configure voice ports on the
switch” on page 100

ADS or SCB block “Creating a CallPilot ACD-DN in

Nortel recommends that you use an | LD 23,” on page 97

ADS block.

When you configure the ADS or
SCB block, the values for HOML
and RPRT are set to YES. If
HOML=YES, agents are logged
off when they replace the handset
after a call. If this is not
appropriate for your environment,
modify the HOML parameter for
existing ACD queues.

If you configure the ADS block,
you must configure DCUS in the
PARM data block with LD 17.

agent ACD queues “To configure agent and supervisor
TNs on the switch” on page 103
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Element For more information, see

agent phones “To configure agent and supervisor
TNs on the switch” on page 103

routes “To configure routes on the switch”
on page 111

CAUTION
& Risk of ACD block corruption

Before programming the ADS or SCB block, make sure that all
agents log off.

This chapter explains how to configure most of these elements. It also explains
how to initialize the switch and change resources on the switch without causing
problems on Contact Center Manager Server.

For a complete list of the X11 overlays, see the Software Input/Output Guide
X11 Administration provided with the switch.

Before you begin

Before you configure elements on the switch, ensure that:

= you have the packages required for:
= Vvoice processing in Contact Center Manager Server
= voice processing in CallPilot or Meridian Mail
= any other desired switch features

The Contact Center Manager Server packages include 311 (NGCC) and
324 (NGEN). The Meridian 1 PBX software package list for CallPilot 4.0 is
found in the CallPilot Release 4.x.

For more information, contact your Nortel customer support representative.
= your switch is running one of the following software releases:

m  X11 Release 25.40B or later

= Communication Server 1000 Release 3.0, 4.0, or 4.5

s Communication Server 1000M Release 3.0
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= you apply all current Service Updates (SU). For information about which
SUS to install on the switch, contact your Nortel customer support
representative.

= you install the NACD package on the switch (if you purchased the Network
Skill-Based Routing option).

ATTENTION Contact Center Manager Server cannot share switch resources

(such as CDNs, ACD-DNs, or TNs) with other applications
such as Meridian Max, Meridian Link, and CCR (Customer
Controlled Routing).

To change switch resources

You can use the CHG command in LD 11 to change any non-ACD properties of
switch resources without releasing the resources, with the appropriate software
version, as follows:

s Communication Server 1000 Release 3.0
s X11 Release 25.40B or Communication Server 1000 Release 4.0

CAUTION
& Risk of system corruption

If you change acquired resources on a system without an
appropriate software version, linked list corruption and status
mismatches may occur.
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ATTENTION Do not change ACD properties (position ID, queue 1D,
supervisor 1D, and so on) on acquired resources.

Nortel recommends that you take whatever steps are
appropriate to ensure that the resource you change is not in use
during the change. This not only reduces the risks of any
unexpected operations, but also avoids having a user become
disconnected when the service change is completed. The best
way to avoid such problems is to disable a unit prior to service
change.

In Communication Server 1000M Release 3.0 and supported X11 releases, you
can also use the DES command in LD 85 to change acquired switch resources
with patch MPLR18387.

In X11 Release 25.40B and Communication Server 1000M Release 3.0 and
earlier, you can change the DES of an M3900 set in LD 85 with patch
MPLR16833 installed.

To move and delete switch resources

Before you move (MOV) or delete (OUT) a switch resource, you must ensure
that it is deacquired. You cannot MOV or OUT an acquired resource.
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To configure CDNs on the switch

Controlled Directory Numbers (CDN) are specialized ACD-DNSs or queues on
the switch. A CDN is the entry point of a call into Contact Center Manager
Server call processing. You must configure CDNSs on the switch and on Contact
Center Manager Server (see “To configure CDNs on the server” on page 185).

Landing Pads

For each site that is configured to use Landing Pads, you must define the
Landing Pads. If the site is configured to use CDN Landing Pads, you must
configure CDN Landing Pads; if it is configured to use DNIS (Dialed Number
Identification Service) Landing Pads, you must configure DNIS Landing Pads.

Landing Pads are applicable only to Universal Networking.

For more information, see the Contact Center Manager Network Control Center
Administrator’s Guide or the Contact Center Manager Administration Online
Help.

A Landing Pad in the first instance is a unique dialable number.

= Landing Pads are employed in the absence of the ability to tag a call
reference directly to the call, for example, no means of conveying a
Network Call 1D along with the call to target (in the voice-call signaling).

m  Landing Pads are employed so that agents can dial a unique number on a
per call basis, to create a unique call reference.

= Aunique call reference is used to match a source routed call to a previously
reserved target agent, or more generally to track a call from source to
destination, where regular telephony information provided at source and
target for that call is not enough to uniquely differentiate between all calls
arriving.

= Landing Pads are normally grouped together as a pool of resources,
constantly reused.
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Note that direct targeting of a position ID (agent/ACD key) is not used in
Contact Center Manager Server or earlier releases, nor is it generally desired, or
in fact possible across all switch types and trunk protocols in contact centers,
because any caller can target an agent directly.

The uniqueness aspect can take different forms.

= DNIS provides the original number that was dialed at source to the target.
These calls are usually funneled into one or more route points (CDNs or
ACD DNs) in a contact center, either through auto-terminated trunks or
through Incoming Digit Conversion (IDC). You can use the DNIS number
to distinguish one call from another as long as the DNIS used is unique on a
per call basis.

m  For Direct Inward Dial (DID) enabled target switches, you can use CDNs
as Landing Pads.

The DNIS method and the CDN method are generally available across different
switch types.

Modes of operation

CDNs have two modes of operation—default and controlled—as shown by the

CNTL prompt. Contact Center Manager Server requires that you configure the

CDN in default mode. When Contact Center Manager Server acquires the CDN,
the following events occur:

s The CDN is automatically switched to controlled mode.

m  The parameter ASID appears next to the CDN block.

s CNTL and AACQ automatically change to YES.

If CNTL = NO (that is, if the CDN is not acquired), or if no treatment is given in
four seconds, calls are directed to the default DN. (Do not set CNTL to YES
manually.)

Ensure that RPRT = NO.
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Assumptions

CDN data block

The following assumptions are made:

= You know the user ID and password to log on to the switch administration
terminal.

= You are familiar with switch Change and Diagnostics overlays.
= You have a listing or printout of available CDNs (overlay program 23).

Use these prompts to configure a CDN. This includes Music and RAN prompts.
For prompts not listed in the table, press Enter to accept the default.

N

CAUTION

Risk of corruption

Corruption results if a CDN is not configured in this overlay
before that CDN is acquired in Contact Center Manager

Administration.

Prompt Response Description

REQ aaa Request.

TYPE CDN Type of data block is CDN.

CUST XX Customer number associated with this
data block.

CDN XXXX Control Directory Number.

FRRT 0-511 First RAN route number for ACD.

FRT 0-2044 First RAN time.

SRRT 0-511 Second RAN rout number for ACD.

SRT 0-2044 Second RAN time.
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Prompt Response Description
FROA NO (YES) First RAN on arrival.
MURT 0-511 Music route number.
DFDN X...X Local default ACD-DN.
CEIL 0—(2047) CDN ceiling value.
OVFL (NO) YES Force Overflow Tone to the call when the
ceiling threshold is exceeded.
TDNS (NO) YES Is DNIS number an original called party.
RPRT (YES) NO Management reporting and status display.
CNTL (NO) YES CDN is in control.
VSID 0-15 Value Added Server ID.
HSID 0-15 Host ID.
CWTH 0-(1)-2047 Call Waiting Threshold.
BYTH (0)-2047 Busy Threshold.
OVTH 0-(2047) Overflow Threshold.
STIO 0,1,2,...15 Status Input/Output devices.
TSFT 0—(20)-510 Telephone Service Factor Threshold in
seconds.
ACNT XXXX Account.
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To verify that the CDN is acquired

After you acquire the CDN on Contact Center Manager Server, the CDN

printout appears as follows:

>1d 23
ACD000

MEM AVATL:
DISK RECS AVAIL:
ACD DNS AVAIL:

REQ

TYPE
CUST
CDN

TYPE
CUST
CDN

FRRT
SRRT
FROA
MURT
DFDN
CEIL
OVFL
TDNS
RPRT
AACQ
ASID
SFNB
USFB
CALB
CNTL
VSID
HSID
CWTH
BYTH
OVTH
STIO
TSFT

prt
cdn
0
2003
CDN
0
2003

NO

7700
2047

2047

20

9

3591770

USED: 405925

USED:

10
9
7

11
10
8

24

12

9

11

2

13

11

12

TOT: 3997695

TOT: 24000

15 16 17 18 19
13 14 15
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To change CDNs on the switch

If you need to change CDNs on the switch, you must follow specific steps to
avoid causing service breaks in Contact Center Manager Server. For example, if
you remove a CDN that is currently acquired by Contact Center Manager
Server, you can cause some services to stop processing. This prevents Contact
Center Manager Server from handling calls.

Changing CDNs on the switch

1 Deacquire the CDN from Contact Center Manager Administration. See
“Configuring and acquiring a CDN” on page 185.

2 Delete, add, or make changes to the CDN as necessary on the switch.

3  Acquire the CDN on Contact Center Manager Administration.
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To configure NACD-DNs to enable the Queue
to NACD command

The networked ACD-DN (NACD-DN) is a local dummy ACD-DN (that is,
there are no agent positions assigned to it) with a Night Routing table. NACD-
DNs enable you to route calls to other Contact Center Manager Server sites. You
can use NACD routing as a backup in the event that a Contact Center Manager
Server network routing command fails.

To enable NACD routing, you must connect the switch using a Meridian
Customer Defined Network (MCDN). For more information about configuring
the switch on an MCDN, see the documentation that comes with the switch.

To ensure that Contact Center Manager Server calls are handled in a timely
fashion, the switch alternates presentation of NACD and Contact Center
Manager Server calls. After an agent finishes an NACD call, the switch provides
a small time window to allow a Contact Center Manager Server call to be
presented. If no Contact Center Manager Server call is available, the switch
presents the next NACD call.

When to configure NACD-DNs

Configure NACD-DNSs when you want the application to communicate with the
switch NACD software. This lets you to route overflow calls to other Contact
Center Manager Server sites. Use the Queue To NACD script command to
access the NACD-DNs.

If you configure an NACD-DN, ensure that there are no TNs or positions
associated with the ACD-DN that is configured as the NACD routing DN. If
there are TNs or positions assigned, reassign them to another ACD-DN.
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Assumptions

The following assumptions are made:

= You know the user ID and password to log on to the switch administration

terminal.

= You are familiar with switch change and diagnostics overlays.

Configuring a new NACD-DN with LD 23

Use these prompts and responses in LD 23. For prompts that are not specified
in the following table, press Enter.

Prompt Response Description

REQ NEW Add an NACD-DN.

TYPE ACD ACD data block.

CUST XX Customer number.

ACDN XXXX ACD-DN to be added.

MAXP 1 The number of agent positions that can be
assigned to the queue.

NCFW X Enter an x to delete night call forward
(NCFW).
Note: NCFW must be blank to allow the
configuration of an NACD Night Routing table.

To configure an existing ACD-DN as an NACD-DN with LD 23

If you use an existing ACD-DN, ensure that there are no TNs or positions
associated with the ACD-DN to be configured as the NACD routing DN. If
there are TNs or positions assigned, reassign them to another ACD-DN. Then
use LD 23 to configure the NACD-DN as described in “Configuring a new
NACD-DN with LD 23” on page 93.
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Configuring the Night Routing table with LD 23

Use these prompts and responses in LD 23. For prompts that are not specified
in the following table, press Enter.

Prompt Response Description

REQ NEW Add.

TYPE NACD Network ACD.

ACDN XXX...X ACD directory number used.

TABL N Night Table.

TRGT XXXX tttt Remote target ACD-DN (xxxx) and the timer

(0—1800) in seconds.

Press Enter to add another target. You can
add a maximum of 20 targets to the table.

Press Enter twice to stop adding targets.

REQ END Exit from overlay.

Local targets are ignored when using Contact Center Manager Server.

Night Service (NSVC)
With NACD, you can define one of three Night Service treatments:

Night RAN Route with Night Tables—Callers receive Night RAN, while
the call is monitored for the timers defined for Targets nodes.

Night Tables only—No Night RAN is given, while the call is monitored
for the timers defined for Targets.

Night Tables with Delay Night RAN Treatment (DNRT)—With Active
entries in Night Tables (DNRT) on, callers receive Day treatment. The FRT
must be 4 seconds greater than the timer value of the last entry in the Night
Table for this to work. When all entries in the Night Table are inactive, a
Night RAN is returned to inform the caller that the network is closed.
Note: When a caller accesses the queue in Night Service and uses the
NACD Night Table (the Night Table has open Targets), the caller hears first
and second RAN.
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Night Mode

The Source ACD-DN goes into the Night mode using the NSVC key (dialing
N [6]), when all agents log off. Then all calls access the Night table, unless the
calls have outstanding call requests from the Day table.

Two Night Service modes are available:

=  Transition mode
= Night mode

When the source node is in Transition mode, new calls access the Night table
and existing calls access the Day table.

When the source node is in Night mode, new calls access the Night table.
Existing calls that have pending call requests from the Day table are honored,
but no more searching of the Day table takes place.

When the target node is in either Transition mode or Night mode, new call
requests are denied and existing call requests are canceled.

When the Source ACD-DN comes out of Night Service, only current call
requests accessing the Night table apply. All new calls (calls without outstanding
call requests) access the Day table.
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To configure IVR ACD-DNs on the switch

An IVR ACD-DN is a DN that is assigned to voice ports that provide
voice-processing services. You program voice ports as ACD agents belonging to
IVR ACD-DNs. Contact Center Manager Server must acquire the IVR ACD-
DNs. You configure IVR ACD-DNs on the switch, in your voice-processing
system (see Chapter 6, “\Voice-processing subsystem configuration™), and on
Contact Center Manager Server (see “To configure IVR ACD-DNs on the
server” on page 188).

This section describes how to configure IVR ACD-DNs if you use Symposium
\Voice Services on CallPilot or Meridian Mail. If you use a third-party IVR
system, see the documentation provided with the system.

When to configure IVR ACD-DNs

Configure IVR ACD-DNs if you use CallPilot, Meridian Mail, or a third-party
IVR system to play messages to callers. These messages are stored on the
voice-processing system and can be announcements or voice menus.

If your system uses only a MIRAN card to provide messages, you do not need to
configure IVR ACD-DNs.

Configure an IVR ACD-DN for each group of voice ports; for example,
configure one for ACCESS voice ports, one for non-ACCESS voice ports, and
one for Voice Messaging (Contact Center Manager does not acquired Voice
Messaging ACD-DNs).

For more information about voice port partitioning, see “To configure voice
ports on the switch” on page 100.

Assumptions

In the following procedures, it is assumed that:

= You know the user ID and password to log on to the switch administration
terminal.

= You are familiar with switch change and diagnostics overlays.
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= You have a listing or printout of available IVR ACD-DNs.

Creating a CallPilot ACD-DN in LD 23

Use the following prompts and responses in LD 23. For prompts not listed in the
table, press Enter to accept the default.

Prompt

Response

Description

REQ

NEW

Create a new queue.

TYPE

ACD

ACD data blocks.

CUST

0-99

Customer number.

ACDN

XXXX

The DN of the ACD queue. This is the IVR ACD-
DN acquired from Contact Center Manager.

MWC

NO

Indicates that this is not a message center.

MAXP

XX

Indicates the number of agent positions that can
be assigned to the queue.

IVR

YES

Indicates that the queue can be used with the
Give IVR command defined in scripts.

TRDN

XXXX

Default treatment DN is used if treatment is not
specified in the script.

Use treatment DNs to select the treatment that
the call receives from the voice-processing
system. You can also use them with CallPilot,
Meridian Mail, or any voice-processing system
that connects to the switch by means of the AML
link.

ALOG

YES

ACD agents are automatically logged on.

Only CallPilot and Meridian Mail TNs are
automatically logged on; analog TNs, such as
those used for third-party IVR systems, are not.
To log on analog TNs, you must write an
application on the IVR system to log on the
ports.

REQ

END

Exit from overlay.
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Creating a Meridian Mail IVR ACD-DN in LD 23

Use the following prompts and responses in LD 23. For prompts that are not
specified in the following table, press Enter.

Prompt Response Description

REQ NEW Create a new queue.

TYPE ACD ACD data blocks.

CUST 0-99 Customer number.

ACDN XXXX The DN of the ACD queue. This is the IVR
ACD-DN acquired from Contact Center
Manager.

MWC YES Indicates that this is a message center and
that the queue has agents.

CMS YES Command and Status Link Application
Protocol is used.

IMA YES Enables IMS attendant.

IVMS YES Integrated voice messaging. This creates a
message center from which messages can be
retrieved.

VSID XX Value Added Server identifier.

MAXP XX Indicates the number of agent positions that
can be assigned to the queue.

ALOG YES ACD agents are automatically logged on when
Meridian Mail is powered on.

Only Meridian Mail and CallPilot TNs are
automatically logged on; analog TNs, such as
those used for third-party IVR systems, are
not. To log on analog TNs, you must write an
application on the IVR system to log on the
ports.

IVR YES Indicates that the queue can be used with the

Give IVR command defined in scripts.
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Prompt

Response

Description

TRDN

XXXX

Default treatment DN used if treatment is not
specified for a Give IVR command in a script.

Use treatment DNSs to select the treatment that
the call receives from the voice-processing
system. You can also use them with CallPilot,
Meridian Mail, or any voice-processing system
that connects to the switch by means of the
AML link.

REQ

END

Exit from overlay.

After you finish

You must configure the voice ports as virtual agents. See “To configure voice
ports on the switch” on page 100.
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To configure voice ports on the switch

\oice ports carry speech to CallPilot, Meridian Mail, or an IVR system. You
must configure voice ports when the ports are CallPilot, Meridian Mail, or third-
party IVR system ports used to play announcements or voice menus. You must
configure voice ports on the switch, in CallPilot and Meridian Mail (see Chapter
6, “Voice-processing subsystem configuration”), and on Contact Center
Manager Server (see “To configure voice ports on the server” on page 196).

Configure voice ports as virtual agent TNs for Meridian Mail or CallPilot. (For
third-party IVR systems, the agent TNs are analog TNs.) For Nortel CallPilot,
the class of service must be MMA (Multimedia Agent) and FLXA. For Meridian
Mail, the class of service must be IMA and VMA.

For the voice ports, ensure that the key layout matches the configuration of keys
in CallPilot or Meridian Mail. This matching lets CallPilot and Meridian Mail
answer, disconnect, originate, transfer, and conference calls.

You must have AST licenses on the switch to support messaging between
CallPilot and Contact Center Manager Server.

ATTENTION Some services and applications that handle calls outside of

Contact Center Manager Server control can share voice
ports, while calls under Contact Center Manager Server
control require dedicated voice ports to operate correctly.
For more information, see “Voice port partitioning rules”
on page 141.

Creating a CallPilot voice port with LD 11

Use the following prompts and responses in LD 11. For prompts not listed in the
table, press Enter to accept the default.

Prompt Response Description
REQ NEW Add a voice port.
TYPE 2008
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Prompt Response Description

TN Iscu Terminal Number of the voice port, where | is
the loop, s is the shelf, ¢ is the card, and u is
the unit. (For the Option 11C, TN is cu only.)

AST 00 01 Associated set assignment on key 0 and key 1
(required for MLSM messages)

CLS FLXA (units Flexible voice/data allowed.

16-31) Voice Terminal

VCE Warning Tone Allowed

WTA Conditionally Toll Denied

l(\:/I-II\-/Il?A Multimedia Agent
Notes:
When you change from CLS DAT to CLS VCE,
add CLS WTA to avoid conflict with CLS
CPTA. CLS CPTA is the default for VCE TNs.
CTD is optional, but prevents outbound long-
distance calls from a voice port.

KEY 0 ACD xxxx Define 0 as an ACD key. xxxx is the ACD-DN

Zzz nnnn of agents to voice mail. zzz is the CLID
(Calling Line Identification) entry number.
nnnn is the position ID. In CallPilot, the
position ID must match the CallPilot key 0
value.

KEY 1 SCN xxxx Define key 1 as a single-call non-ringing DN.
xxxX is the SCN DN of the SCN. The DN must
match the key 1 value on the CallPilot
Meridian 1 PBX Switch Information screen.

KEY 2 MSB Define key 2 as a Make Set Busy key.

KEY 3 NRD Define key 3 as a Not Ready key.

KEY 4 TRN Define key 4 as a Transfer key.

KEY 5 A03 Define key 5 as a Conference key.

(letter O)

REQ END Exit from overlay.
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Creating a Meridian Mail voice port with LD 11

Use the following prompts and responses in LD 11. For prompts not listed in the
table, press Enter to accept the default.

Prompt Response Description

REQ NEW Add a voice port.

TYPE 2008 or SL1 Use 2008 for Meridian 1 PBX Option 11, and
SL1 for all other switch types.

TN 10 (0-15) Enter the TN of the agent.

CLS IMA Integrated messaging service attendant
allowed.

VMA Server voice messaging allowed.
KEY 0 ACD xxxx Define 0 as an ACD agent key. xxxx is the
Zzz nnnn ACD-DN of voice agents in voice mail. zzz is
the CLID entry number. nnnn is the position
ID.

KEY 1 SCN xxx Define key 1 as a single-call non-ringing DN.
xxx is the SCN DN of the SCN. The DN must
match the DN on the Channel Allocation
Table.

KEY 2 MSB Define key 2 as a Make Set Busy key.

KEY 3 NRD Define key 3 as a Not Ready key.

KEY 6 TRN Define key 6 as a Transfer key.

KEY 7 AO3 Define key 7 as a Conference key.

(letter ‘O’)

KEY 9 RLS (For SL1 phones.) Define key 9 as a Release
key.

REQ END Exit from overlay.
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To configure agent and supervisor TNs on the
switch

If you want a user to log on to a phone to receive or monitor incoming calls, you
need to configure phones (TN). You must configure agent and supervisor phones
on the switch and on Contact Center Manager Server (see “To configure agent
phones on the server” on page 194).

While agent and supervisor phones require no special configuration for Contact
Center Manager Server, they must belong to an ACD-DN. Usually, call routing
is controlled by Contact Center Manager and is not affected by the ACD-DN.

The ACD-DN controls call routing if the Contact Center Manager CDN is in
default mode or if incoming network ACD calls target the ACD-DN.

To configure ACD queues

You use LD 23 to configure the ACD-DN with which a phone is to be
associated. If you want the agent to use the phone to enter Not Ready reason
codes, you must ensure that NRAC for the ACD-DN is set to YES.

To deactivate Not Ready reason codes, set the NRAC to NO.

Default Queue Management (DQM)

Use the Default Queue Management feature to associate an ACD queue with an
agent. When the agent logs on to a Contact Center Manager acquired phone,
Contact Center Manager checks to see which ACD queue is associated with the
agent and the phone. If the ACD queue associated with the agent is different
than the ACD queue configured on the phone, Contact Center Manager attempts
to move the phone to the agent’s associated ACD queue.

This new ACD queue information is maintained on the phone even after the
agent logs off. Therefore, the ACD queue of the phone can differ after an agent
logs on as compared to phone’s default configuration. The phone position 1D,
however, remains unaffected.
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Value Added Server Identification (VSID) definitions

Do not enter a VSID definition on agent or supervisor phones.

AMG key

There is no means for configuring the secondary supervisor’s position 1D along
with the AMG key in Contact Center Manager 6.0.

For earlier versions of Contact Center Manager, the AMG ACD Answer
Emergency key must have CLS set to SPV.

You can define the Answer Emergency key as a secondary supervisor’s position
ID. The secondary supervisor’s position ID can be NULL by default. You cannot
change the position ID of the ACD set after the ACD set is acquired as a Human
Agent. On the M3905, key numbers 8-11 are reserved for AMG.

Assumptions

In the following procedure, it is assumed that:

= You know the user ID and password to log on to the switch administration
terminal.

= You are familiar with switch Change and Diagnostics overlays.

Example of defining a digital ACD phone

To define digital ACD phones, use LD 11 with the following prompts. For prompts
that are not included in the following table, use the default value.

Prompt Response Description

REQ NEW Add a new phone.

TYPE aaa Enter phone type as appropriate.
TN Iscu Terminal Number

DES Name Enter a name for the phone.

CUST 0-99 Customer number

KLS 1-7 Number of key/lamp strips attached
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Prompt Response Description

KEY 0 ACD xxxx yyyy | Where xxxx = ACD-DN, and yyyy = Agent
position ID

KEY 1 NRD Not ready

KEY 2 A06 6-party conference

KEY 3 MSB Make set busy

KEY 4 TRN Transfer

KEY 8 SCR xxxx xxxx=IDN

KEY 13 ACNT Activity key

REQ NEW, END Either define another multiline ACD phone, or
exit the overlay saving all of the changes
entered.

To use Not Ready reason codes, you must program a key as an activity key

(ACNT).

You program DWC functionality for Contact Center Manager Server in the same
way as ACD, but the functionality is not the same. See Chapter 10, “Agent
phones,” for information about the DWC key and Contact Center Manager

Server.

To enable the agent phone for CTI, set the AST prompt to enable the Incalls key,
and the secondary DN key for CTI. For example, if you have a personal DN on
key 7, set AST to 00 07 to enable key 0O (the Incalls key) and key 7.

Based on what is acquired, ACQ AS can show any or all of the following values:

m TNforTN

m  AST for position ID, indicating that a Meridian Link application registered

for the ID

= AST for DN, indicating that a Meridian Link application registered for the
secondary DN key
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To verify the TN configuration after it is acquired

After you configure a phone in the system using LD 11, and after Contact Center
Manager Server acquires it, the printout appears as follows:

>1d 11

REQ prt

TYPE tnb

™ 4 0 4 2

DATE

PAGE

DES

DES agtset

TN 004 0 04 02

TYPE 2616

CDEN 8D

CUST O

CDN 2003

AOM O

FDN

TGAR 1

LDN no

NCOS 0

SGRP O

RNPG O

SCI O

SSU

XLST

CLS CTD FBD WTA LPR MTD FND HTD ADD
MWD AAD IMD DOS XHD IRD NID OLD VCE DRG1
POD DSX VMD CMSD CCSD SWD LND CNDA
CFTD SFD MRD DDV CNID
ICDD CDMD LLCN MCTD CLBD AUTU
GPUD DPUD DNDD CFXD ARHD FITD CNTD CLTD ASCD
CPFA CPTA HSPD ABDD CFHD FICD NAID
DDGA NAMA
USMD USRD ULAD RTDD PGND OCBD FLXD

CPND_LANG ENG

HUNT

PLEV 02

AST

IAPG 0

AACS YES

ACQ AS: TN

ASID 16

SFNB 2 5 6 9 10 11 12 13 15 16 17 18 19
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SFRB 1
USFB 1
CALB 1
FCTB

21
2345
3456

ITNA NO

DGRP
PRI 01

MLWU_LANG 0

DNDR O

KEY 00 ACD 2001 0 2012

SPV
01
02
03
04
05
06
07
08
09
10
AA
12
13
14
15

AACS=YES indicates that the phone is acquired by an application. ACQ

NRD
AQ06
MSB
TRN

SCR 4702 0 MARP

RAG
AAG
AMG
DwC 2001
ACNT

10 12 13 14 15

AS=TN indicates that the TN is acquired, but no CTI application registered for

the phone. ASID=16 indicates that the application on AML 16 acquired the

phone. SFNB, SFRB, USFB, and CALB are bitmaps that control what messages
are sent to Contact Center Manager and are not user-definable.

Defining single-line ACD phones

To define single-line ACD phones, use LD 10 overlay and follow these prompts:

Prompt Response Description

REQ NEW Add a new phone.

TYPE 500 Enter phone type as appropriate.
TN Iscu Terminal Number
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Prompt Response Description
CUST 0-99 Customer number
DN XXXX DN for the phone
CLS AGTA Class of service—ACD agent assignment
THFA Switchhook flash allowed
UND Unrestricted access
WTD, (WTA) | Warning Tone Denied (Allowed)
SPID XXXX Supervisor’s position ID number
PRI (1)-48 Priority level for agent
AACD YES Associated set for ACD agent (X11 Release
17 or later software). Only for AST phones.
FTR ACD xxxx yyyy | ACD feature allowed, where
xxxx=the ACD-DN
yyyy=the ACD Position (POS-ID)
REQ NEW, END Either define another single-line ACD phone
or exit the overlay saving all of the changes
entered.
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To configure phantom TNs on the switch

You can define and configure TNs without the required phonesets or line cards,
which allows an agent or supervisor to log onto any phone.

To define and configure TNs without phonesets or line cards, you must have the
Phantom Terminal Numbers (PHTN) feature. The PHTN feature supports
Phantom Terminal Numbers to direct incoming calls to existing telephones
using the Call Forward All Calls (CFW) and Remote Call Forward (RCFW)
feature capabilities.

You must configure phantom TNs on the switch and on Contact Center Manager
Server (see “To configure agent phones on the server” on page 194). Each
configured TN has an associated DN. Before an agent or supervisor can log onto
any phone, you must assign each associated DN to an agent or supervisor in
Contact Center Manager Administration (see “To configure personal DNs on the
server” on page 191).

Configuring a TN for the phantom loop with LD 10

To configure a TN for the phantom loop with LD 10, use these prompts and

responses.

Prompt Response |Description

REQ NEW, CHG | Add, or change

TYPE 500 Telephone type

TN Iscu Terminal number (loop, shelf, card, and unit); if
the loop is a phantom loop, "PHANTOM" is
echoed to the technician

DN XXX...X Directory Number; must be a Single Appearance
DN

SCPW XXXX Station Control Password
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Prompt Response |Description
CLS aaaa Class of Service options, which cannot include
AGTA, CCSA, MNL, or LPA
FTR DCFW nn Default Call Forward where:
X...X nn = number of digits up to 23

X...X = Default Call Forward DN.
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To configure routes on the switch

A route defines a group of trunks. Each trunk carries incoming and outgoing
calls to and from the switch. You must configure the trunk routes on the switch.
To use the Give RAN and Give Music commands in your scripts, you must also
configure RAN and MUS routes.

Only RAN, MUS, FGDT, TIE, DID, COT, FEX, and WATS route types are
supported by Contact Center Manager Server.

If you do not use Symposium Voice Services on CallPilot or Meridian Mail,
configure a MIRAN card and RAN routes to supply messages to callers waiting
in queue.

To configure trunk routes

No special programming is required to work with Contact Center Manager
Server. Use LD 16 to configure the trunk routes, and use LD 14 to associate the
trunk routes with TNs.

If you want to generate reports on trunk routes, you must also configure the
trunk routes on Contact Center Manager Server. For detailed instructions, see
the Contact Center Manger Server Installation and Maintenance Guide.

Assumptions

In the following procedures, it is assumed that:

= You know the user ID and password to log on to the switch administration
terminal.

= You are familiar with switch Change and Diagnostics overlays.
= You obtained a listing of routes using LD 21 (REQ=prt, TYPE=RDB).
= At the switch, you ensured that physical trunks are defined for the routes.
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Configuring a RAN route with LD 16

To configure a RAN route using LD 16, use these prompts and responses.

Prompt Response Description

REQ NEW Add a route.

TYPE RDB Route data block

CUST nn Customer number

ROUT nn Route number

DES X...X Enter a description.

TKTP RAN Recorded Announcement trunk data block
requires package 7.

ASUP YES Answer supervisor

ACOD nnn Access code

REQ END Exit from overlay.

Configuring a MUS route with LD 16

To configure a MUS route using LD 16, use these prompts and responses.

Prompt Response Description

REQ NEW Add a route.

TYPE RDB Route data block

CUST nn Customer number

ROUTE 0-511 Route number

DES X...X Designator field for trunk. Enter a description.

TKTP MUS MUSIC trunk data block requires Music
package 44.

ICOG OGT Incoming and outgoing trunk
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Prompt Response Description
ACOD nnn Access code
REQ END Exit from overlay.

Associating a MUS route with TNs in LD 14

To associate a MUS route with a TN in LD 14, use these prompts and

responses.
Prompt Response Description

REQ NEW Action request

TN Iscu Terminal Number

TYPE MUS Music route

CUST 0 Customer number

RTMB 0-127 1-254 | Route and member number
CFLP 0-159 Conference loop

REQ END Exit from overlay.
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To configure Multiple Queue Assignments

To use Multiple Queue Assignments (MQA) with Meridian MAX when you
have Contact Center Manager, you must ensure that your MQA agent ACD-DNs
are separate from Contact Center Manager agent queues.

Allowing MQA and Contact Center Manager Server to coexist

1
2

Create new ACD-DNs for the Contact Center Manager Server agents.
Move the Contact Center Manager Server agents into the new ACD-DNs.

You can use the Meridian MAX configuration control feature to move the
agents. Perform this step during a maintenance window when all agents
are logged off.

Change RPRT to NO in LD 23 for the source ACD-DN.

This ensures that MAX does not report on this queue or the agent
positions. Because MAX does not understand skillsets, and it does not
know which agents staff the agent phones, reporting information is
inaccurate.

Ensure that the Contact Center Manager Server CDN has the appropriate
DFDN defined so that calls are handled properly in default mode.

Contact Center Manager Server can acquire MQA agents. When it does, only
one queue is assigned to the phone—the first queue the agent logs on to. If
Contact Center Manager Server goes down, calls are presented to agents in this
gueue. If agents log on to multiple queues while Contact Center Manager Server
is down, when Contact Center Manager Server comes back up and acquires the
agent phones, the phones revert to one queue.

Make sure that all Change Orders moving agent positions from one queue to
another are removed from MAX. If you want to continue to use MAX to move
agents to a different queue and you do not have Communication Server 1000M
Release 3.0 or the patch MPLR17921, then:

deacquire the agent phone in Contact Center Manager Server
make the change in MAX
ensure that the switch performed the change
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= acquire the phone in Contact Center Manager Server

If you have Communication Server 1000M Release 3.0, you can make the
change without deacquiring the agent position.
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Switch maintenance

Contact Center Manager Server can only process calls if the switch is
operational. Before performing upgrades or maintenance on the switch, you
must do the following:

= Shut down CallPilot
= Shut down Contact Center Manager Server
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Overview

This chapter provides the references and procedures required to set up Meridian
Link Services (MLS) for operation with Contact Center Manager Server. MLS is
a communications facility that provides an interface between a host application
and the switch. (A host is any computer on which the third-party application
runs.) This interface facilitates the integration of the computer and the Private
Branch Exchange (PBX). In this integrated environment, the host processor
interacts with the switch by exchanging application layer messages.

If you use CallPilot for your Symposium Voice Services, CallPilot
communicates with the switch using MLS, so you must configure the switch for
Meridian Link. After you configure MLS on the switch, your connection to the
host application is through the Nortel server subnet and ELAN subnet
connection points.

You can also use MLS to develop applications that allow you to use information
taken from the switch (such as Caller ID), connect to another application to get
that customer’s data, and then provide data to a PC to help agents prepare for the
call.

If you want to use CTI functionality for your Contact Center Manager Server
agents, you must use MLS. You cannot use legacy Meridian Link.

In an environment with multiple servers on the same switch, if you use TAPI to
provide CTI functionality, each server must have its own TAPI server.

The following diagram shows the relationships between the applications and
Contact Center Manager Server.
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Third-party Meridian Link
application server

Call Server
ELAN Subnet \
Media
Gateway

Customer LAN

Signalin
Server

CCMS CCMA

aQ

Rodting  Firewall

Nortel Server Subnet

(Managed Ethernet Switch — for
example, BPS 2000, Baystack 450,
and so on)

VPN
Router
1100

Modem

Meridian Link

With the introduction of Contact Center Manager Server, Meridian Link was
rewritten for Windows NT and renamed MLS. MLS runs as a separate process
on Contact Center Manager Server. MLS can provide CTI features for Contact
Center Manager Server agents, traditional non-Contact Center Manager Server
ACD agents, and non-ACD phones. It also provides support for host-enhanced
routing and host-enhanced voice processing.

Meridian Link Services features

MLS, wherever possible, preserves the functionality of Meridian Link 5. The
Contact Center Manager Meridian Link Services Interface Specification
describes in detail the differences in implementation between Contact Center
Manager Server with MLS and the Meridian Link 5 interface specification.
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To install and configure Meridian Link
Services

The configuration procedures on the switch for both Contact Center Manager
Server and stand-alone MLS are identical. You configure the switch using X11
software overlays.

Prerequisites

Before you configure MLS, you must install Contact Center Manager Server.
(MLS is installed as part of the Contact Center Manager Server software.) For
more information, see the Contact Center Manager Server Installation and
Maintenance Guide and the Contact Center Manager Administration
Installation and Maintenance Guide.

You must also install the switch software. For more information about installing
the switch software, see the installation documents that come with the switch.

Enable Meridian Link Services on the switch

To enable MLS to function on the switch, you must do the following:

= Allow CTI operations on the ELAN subnet (LD 17).
m  Configure phones for CTI (LD 11 and LD 10).
= Configure CDNs for Host-Enhanced Routing (LD 23).

After you configure the switch, you must connect the host application to the
Nortel server subnet.
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To allow CTI operations on the ELAN subnet

You configure LD 17 to allow CTI with third-party applications. Specifically,
where the VAS connection for Contact Center Manager Server is defined as
SECU, enter YES as the prompt response. This lets third-party applications to
control phone functions, such as answering or initiating a call.

Completing the basic Meridian Link Services configuration

Use these prompts and responses in LD 17.

Prompt Response Description

REQ CHG Change data in the database.

TYPE VAS Value Added Service

VAS NEW When migrating from Meridian Link, define the
VAS connection as YES.

VSID XX Associate link and VSID so that the messages
can be sent.

ELAN yy Associate VASID xx with ELAN yy.

SECU YES If the same ELAN subnet link is used for the
Meridian Link application.

INTL 1-12 Time interval for checking Meridian Link for
overload in increments of 5 seconds.

MCNT 5-100000 Message count threshold for number of
Meridian Link messages per time interval.
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To configure phones for CTI

To enable a phone for CTI messages, you must configure it as an associated set
(AST). This is done using LD 11 for digital (multiline) phones and LD 10 for
analog (single-line) phones.

Agents assigned multimedia capabilities must log onto a phone through the
Communication Control Toolkit. These agents cannot manually log onto a
phone.

Phones can be physical phones or voice ports (including line-side E1 and line-
side T1) used by Nortel IVVR or third-party 1\VR applications.

CallPilot voice ports are configured as digital voice ports. Nortel IVR voice
ports are configured as analog voice ports.

Contact Center Manager Server controls Status Change message filtering in
MLS during resource acquisition. IAPG groups configured using LD 10 and LD
11 do not impact the message filtering for Contact Center Manager Server-
controlled resources.

Types of phones

You can use MLS for:

= ACD phones where the routing is done on the switch

s ACD phones acquired by Contact Center Manager Server and used for
skill-based routing

= non-ACD phones that are not acquired by Contact Center Manager Server
but can be monitored by MLS

Configuration of ACD phones is identical to configuration of Contact Center
Manager Server-acquired phones.
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Defining multiline ACD phones as associated sets
Use LD 11.

For more information about using LD 11 and creating and defining phones, see
“To configure agent and supervisor TNs on the switch” on page 103.

Defining single-line ACD phones as associated sets

1 Use LD 10.
2 Ensure that AST = YES.
3  Ensure that AACD = YES.

For more information about using LD 10 and creating single-line ACD
phones, see “To configure agent and supervisor TNs on the switch” on
page 103.

Defining a non-ACD multiline phone as an associated set

Use these prompts and responses in LD 11. For prompts that do not appear in
the following table, use the default value.

Key layout varies depending on customer requirements. The key configuration in
this table is provided as an example only.

Prompt Response Description

REQ NEW Add new phone.

TYPE aaa Enter telephone type as appropriate.
TN Iscu Terminal Number

CDEN SD, (DD), 4D | Card density

CUST 0-99 Customer number

KLS 1-7 Number of key/lamp strips attached

Press Enter until the AST prompt appears.

AST 00 DN key with AST telephone assignment (Host
controllable. Up to two DN keys can be
assigned as AST). This example shows that
key 0 is an AST DN.
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Prompt Response Description

IAPG X AML link status message group, defined in LD
15. Set the message group to 1 to send
messages to the CTI application. Set the
message group to 0 if you do not want to send
messages.

KEY 0 SCR xxxx where xxxx = DN

KEY 1 TRN Transfer

KEY 2 AO6 6-party conference

KEY 9 RLS Release if type = SL1
Press Enter until the REQ prompt appears.

REQ NEW, END Either define another single-line ACD phone

as an AST, or exit the overlay saving all of the
changes entered.

Defining a non-ACD single-line phone as an associated set

Use the following prompts and responses in LD 10. For prompts that do not
appear in the following table, use the default value.

Prompt Response Description

REQ NEW Add new phone.

TYPE 500 Single-line telephone type

TN Iscu Terminal Number

CDEN SD, (DD), 4D | Card density

DES X...X Description

CUST 0-99 Customer number

DN XXXX DN for the telephone number

AST YES Phone is designated as an associated set.
IAPG Enter AML link status message group, defined in LD

15, is not used for MLS.
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Prompt Response Description
Press Enter until the REQ prompt appears.
REQ NEW, END Either define another single-line ACD phone
as an AST, or exit the overlay saving all of the
changes entered.
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To configure CDNs for host-enhanced routing

Host-enhanced routing is an MLS feature that lets a third-party application
control calls that wait at a Controlled DN (CDN). A CDN is a specialized ACD
gueue that has no agents. A CDN in controlled mode offers control of calls to
applications.

MLS cannot use a CDN that is already acquired (controlled) by Contact Center
Manager Server for host-enhanced routing. However, an application can register
for a CDN so that it can receive messages about calls handled at the CDN.

To set up a CDN for host-enhanced routing, follow the steps detailed in “To
configure CDNs on the switch” on page 86. These steps are identical to setting
up a CDN that is acquired by Contact Center Manager Server.

Defining a controlled DN

To define a controlled DN for host-enhanced routing, use LD 23. See “To
configure CDNs on the switch” on page 86 for more information.
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To connect the host application

The host application is connected on the Nortel server subnet. The host
application must be configured to access the Nortel server subnet IP address. For

more information, see the Contact Center Manager Meridian Link Services
Interface Specification.
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Overview

This chapter provides information about how to set up and configure Contact
Center Manager Server voice processing so that calls receive the appropriate
treatments.

The first section in this chapter provides a high-level feature summary and
background information about voice processing with Contact Center Manager
Server. The sections that follow provide specific instructions for configuring
CallPilot or Meridian Mail, or an external IVR system, to provide voice
processing.
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Section A: Voice processing
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Overview of voice processing

\oice processing provides automatic interaction with a caller. You can classify
interactions in the following ways:

m  Passive—playing prerecorded messages to a caller

m  Interactive—collecting input from a caller, usually with DTMF (Dual
Tone Multi Frequency)

Different voice processing methods

Contact Center Manager Server supports voice processing using the following
methods:

m  Script commands—Calls terminate on CDNs and enter the Contact Center
Manager Server script. Script statements can direct a call to connect to a
voice port or RAN trunk so that voice-processing interaction can take
place.

= Front-end IVR—Calls terminate directly on a CallPilot or Meridian Mail
voice menu or an IVR system and are not controlled by Contact Center
Manager Server until the voice-processing system transfers the call to a
CDN. This method of voice processing is largely transparent to Contact
Center Manager Server. Contact Center Manager Server must not acquire
the voice ports used for front-end IVR.

132 Contact Center Manager



February 2007 Voice-processing subsystem configuration

Different caller interaction

You can interact with callers in the following ways:

= Play a message to a caller—You can use any of the script commands listed
in the following section to play a message to a caller. You can use the Give
Controlled Broadcast Announcement command to play a recorded
announcement to a caller in either start/stop mode (where the caller hears
the entire message from start to finish), or continuous mode (where the
caller can enter and exit at any point in the message). Other announcements
do not use these specific modes.

= Broadcast announcements to multiple callers—You can use CallPilot or
Meridian Mail in stop/start mode to provide the same announcement to
multiple callers.

= Interact with an external voice system—Interaction with an external
voice system lets Contact Center Manager Server control communication
with the caller through commands and treatments placed in the scripts. You
can use the Open Voice Session and End Voice Session commands to
interact with a caller directly. To use these commands, you must use
Symposium Voice Services on CallPilot or Meridian Mail.

m  Interact with a caller indirectly—Communication with the caller is
controlled by the voice-processing system. You can interact with a caller
indirectly by using the Give IVR command to connect the caller to a voice
port controlled by CallPilot, Meridian Mail, or an external IVR system.
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Script commands

Contact Center Manager Server supports the following voice-processing
commands:

m  Give RAN—Use this command to play announcements using a MIRAN
card or an announcement machine connected to a RAN trunk. The RAN
broadcast feature in X11 Release 23 lets you to connect multiple callers to
the same RAN port. As the call is connected to a RAN trunk rather than a
voice port, this is not strictly a voice-processing command. However, it
does allow you to play a message to a caller.

m  Give IVR—Use this command to play an announcement or IVR session
using a CallPilot or Meridian Mail voice menu or an external IVR system.
The voice-processing system controls the treatment that the call receives.
You can base the treatment on the IVR ACD-DN or the treatment DN. You
can collect digits from the caller, but you cannot access the information
from the script unless you use Host Data Exchange (HDX).

m  Give Controlled Broadcast Announcement—Use this command to play a
message to multiple callers, using the same voice port. It requires
Symposium Voice Services on CallPilot or Meridian Mail.

The Give Controlled Broadcast feature is not supported on the CS 1000E.
For more information, see Bulletin Number P-2006-0312-Global.

= Open/End Voice Session—Use this set of commands to provide an
interactive voice session in which you can play prompts and collect digits.
It requires Symposium Voice Services on CallPilot or Meridian Mail.

During script execution, all voice-processing commands, as well as the Give
RAN command, suspend the script until the command is completed. After the
command is complete, the next statement in the script is executed.
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Typical uses of voice-processing commands

The following section describes typical uses of voice-processing commands.

Give RAN

Use Give RAN:

= when messages must be spoken to callers.
= when legacy RAN equipment exists.

= if RAN equipment is less expensive than a voice-processing system, and
other voice-processing functionality is not required.

Give IVR

Use Give IVR when:

= you use CallPilot or Meridian Mail to play announcements or give voice
menus to callers, and you do not want to use an ACCESS link. You usually
use this command if you migrate from Meridian CCR and you do not want
to re-record your announcements or voice menus.

= you use CallPilot or Meridian Mail and you want to give the caller the
option to leave a message in a mailbox.

= Yyou use a third-party voice-processing system for announcements or voice
menus while the call is controlled by a Contact Center Manager Server
script. Usually, if an external IVR system is used, the call is directed to the
IVR system before the call enters the Contact Center Manager Server script
(front-end IVR). Give IVR is not used unless you use Nortel integrated IVR
CTI applications.

Give Controlled Broadcast Announcement

Use Give Controlled Broadcast Announcement when you use Symposium Voice
Services on CallPilot or Meridian Mail, and the same message must be given to
multiple callers simultaneously (the traditional RAN scenario, “All agents are
busy...”). Its port use is more efficient than when using Give IVR.
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Open/End Voice Session

Use Open/End Voice Session commands when:

= you use Symposium Voice Services on CallPilot or Meridian Mail, and you
must give customized messages (for example, a caller’s expected wait
time).

= you use Symposium Voice Services on CallPilot or Meridian Mail, and
caller interaction (collect digits) is required.

For more information about using these script commands in scripts, see the
Contact Center Manager Scripting Guide for the Communication Server 1000/
Meridian 1 PBX.
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Operation modes for voice-processing
commands

The following section describes the operation modes for voice-processing
commands.

Listen only or interactive

If callers listen to the recorded message only, you can use the following
voice-processing commands:

= Give RAN

m GivelVR

= Give Controlled Broadcast Announcement
= Open/End Voice Session, Play Prompt

If callers can interact, you can use the following voice-processing commands:

= Open/End Voice Session, Collect Digits (Symposium \Voice Services on
CallPilot or Meridian Mail)

= Give IVR (CallPilot or Meridian Mail voice menus or external IVR)

Single connection or broadcast

If callers, or a large number of callers, must hear the same announcement, you
can use any of the listen-only commands specified in the previous section.
However, voice port use is more efficient if you use the broadcast type of
command, rather than the one-call-to-one-port commands. With broadcast, you
can sustain much higher call rates with fewer voice ports.

Use the one-call-per-port commands if you must give customized messages to
callers (for example, Expected Wait Time), if caller input is collected, or if you
have a third-party voice-processing system.

The following commands connect multiple calls per voice port:

= Give Controlled Broadcast Announcement
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m  Give RAN (if RAN broadcast is used)

The following commands connect one call per voice port:

m GivelVR
= Open/End Voice Session

Start/stop or continuous

You can choose whether callers must hear an entire message, or whether they
can enter and exit a message at any point.

Start/stop mode
Start/stop mode means that the caller hears the message from beginning to end.
These voice-processing commands can operate in start/stop mode:

= Give RAN
= Give IVR
= Give Controlled Broadcast Announcement

Open/End Voice Session

Continuous operation

Continuous operation means that the message repeats all of the time, and a caller
enters anywhere in the message. The following commands can support the
continuous mode:

= Give RAN
= Give Controlled Broadcast Announcement
Give Controlled Broadcast Announcement in continuous mode connects the

caller immediately upon arrival and continues the script only after one full cycle
of the message is heard.

RAN operation did not change with the introduction of Contact Center Manager
Server.
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Interruptible or non-interruptible

In Contact Center Manager Server, only the Give IVR command supports both
interruptible (option) and non-interruptible (default) operation. Both the Give
Controlled Broadcast Announcement and Open Voice Session commands
support interruptible (default) operation only.

Interruptible operation

Interruptible operation means that if the call is queued before the voice
processing statement is executed, the voice processing is discontinued if an
agent becomes available, and the call is immediately presented to the agent
instead.

Use this mode when the message played is for the caller’s information (for
example, “All agents are busy...”) or amusement (for example, advertising), and
it is important to get a call to an agent as quickly as possible.

Non-interruptible operation

Non-interruptible operation means that if the call is queued before the
voice-processing command started, the call does not qualify to be answered until
the voice processing session reaches its logical end. The call, however, retains
its place in queue during the voice-processing session.

If an agent becomes available during the voice-processing session, the next call
that can be answered is presented instead, and when the call in the
voice-processing session finishes, it goes to the next agent available.

This mode is useful when it is important that callers listen to a full cycle of a
message before speaking to an agent, or when interactive menus are presented to
the caller, and the input must be completed before it makes sense to speak to an
agent.

If a call is not queued before a voice-processing session, the interruptible versus
non-interruptible operation has no effect; the call always operates in a non-
interruptible fashion.
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Resource acquisition

The following table summarizes the resources that Contact Center Manager
Server must acquire for the different voice-processing commands.

ATTENTION Do not configure extra voice ports on the Communication
Server 1000/Meridian 1 PBX or on the Contact Center
Manager Server that are not accessed or acquired by Contact
Center Manager.

Voice Port

Command IVR ACD-DN Voice Port TN channel

Give IVR Yes Yes No

Give Controlled | Yes Yes Yes

Broadcast

Announcement

Open Voice Yes Yes Yes

Session

Front-end IVR No No No
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Voice port partitioning rules

Your voice-processing system can provide a variety of services, including:

= auto-attendant
m  Voice menus

[ ] fax

= voice mail

= application services to Meridian Link, MLS, Meridian (Integrated) IVR,
CCR, and Contact Center Manager Server

While some of these services and applications can share voice ports, Contact
Center Manager Server requires a dedicated set of voice ports behind a
dedicated ACD-DN to operate correctly. If you require other voice-processing
services, such as Call Answering or Voice Menus, set up a separate queue for
them (see “General Meridian Mail services” on page 142).

Voice port partitioning

Contact Center Manager Server uses two types of voice ports: IVR and
ACCESS ports. To allow for proper operation of Contact Center Manager and
the voice-processing system, each ACD-DN can only contain voice ports of one
type (Give IVR or ACCESS).

Contact Center Manager Server Give IVR voice ports

The Give IVR script command uses Give IVR voice ports. Make sure that only
Contact Center Manager Server Give IVR calls arrive at an ACD-DN containing
Give IVR voice ports.

Configure Give IVR voice ports as standard IVR voice ports. Contact Center
Manager Server must acquire the TNs for the voice ports.

Contact Center Manager Server ACCESS voice ports

The Give Controlled Broadcast Announcement and Open Voice Session
commands use the ACCESS voice ports. ACCESS voice ports are available only
for integrated voice-processing systems, such as CallPilot or Meridian Mail.
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Configure these ports as ACCESS voice ports, giving each voice port a unique
ACCESS class (channel number). Contact Center Manager Server must acquire
the TNs and Class IDs for these voice ports.

Set the maximum number of broadcast ports parameter (see “To configure
Global settings” on page 199) to limit the number of voice ports used by
broadcast announcements.

After this limit is reached, Contact Center Manager Server skips this command
and executes the next command in the script.

General Meridian Mail services

If you preface a Contact Center Manager Server CDN with a voice menu, the
voice menu is accessed through this ACD-DN. Contact Center Manager Server
does not acquire these voice ports.

These services include Call Answering, Express Messaging, Voice Menus, Fax
on Demand, and voice ports used by CCR for Give IVR. The voice ports for all
of these services can belong to the same ACD-DN.
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Section B: CallPilot

In this section

Overview 144
To update CallPilot configuration 146
To update the SDN table 147
To create voice segments 150
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Overview

To use CallPilot as your voice-processing system, you must update the CallPilot
server configuration:

m  Define the ELAN subnet address of Contact Center Manager Server in the
Contact Center Manager Server server ELAN IP Address field.

m Identify channels that are used to provide ACCESS and IVR services to the
server in Contact Center Manager Server.

m  Define SDNs for use by Symposium \Voice Services.

ATTENTION You must configure the channels that provide ACCESS and

IVR services to Contact Center Manager Server as dedicated
Voice channels. Do not use Fax or Speech Recognition
channels.

ACCESS voice ports

When the CallPilot connection IP (CLAN network interface IP address) is set, it
controls these voice ports over the ACCESS link (the IP link that connects
CallPilot and Contact Center Manager Server). You use these voice ports for
Give Controlled Broadcast Announcement and Open Voice Session.

CallPilot supports 96 voice ports in Release 4.0. Reserve one voice port for
messaging; the remaining 95 voice ports are available for voice services.

To use ACCESS voice ports, you must configure some or all of the following
entities in CallPilot:
=  Vvoice ports (virtual agent TNSs)

For information about configuring ACCESS voice ports in CallPilot, see
“To update CallPilot configuration” on page 146.

m  Service Directory Numbers (SDN)

For information about creating SDNs, see “To update the SDN table” on
page 147.

m  Voice segments
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For information about creating voice segments (voice items), see the
CallPilot 4.0 Administrator’s Guide.

Non-ACCESS ports

CallPilot controls these voice ports. The treatment that the caller receives is
determined by the treatment DN or IVR ACD-DN. You use these voice ports for
Give IVR.

To use Give IVR voice ports, you must configure some or all of the following
entities in CallPilot:

=  Vvoice ports (virtual agent TNSs)

For information about configuring Give IVR voice ports in CallPilot, see
“To update CallPilot configuration” on page 146.

= Service Directory Numbers (SDN)

For information about creating SDNs, see “To update the SDN table” on
page 147.

] announcements, menus, and so on

For an example procedure, see “Creating an announcement” on page 217.
For more information about creating announcements and menus, see the
CallPilot 4.0 Administrator’s Guide.

CallPilot and multiple servers on the same switch

If you use CallPilot to provide front-end 1VVR, the same CallPilot server can
support all three Contact Center systems.

If you use Symposium Voice Services on CallPilot—that is, if CallPilot is
providing Give IVR or ACCESS voice services (Open/Close Voice Session,
Collect Digits, and Give Controlled Broadcast Announcement)—CallPilot can
serve only one Contact Center system. Therefore, you must connect each
Contact Center system to a separate CallPilot.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 145



Voice-processing subsystem configuration Standard 6.0

To update CallPilot configuration

In the CallPilot Configuration Wizard, you must do the following:

Define the Nortel server subnet address of Contact Center Manager Server
in the Symposium Call Center Server CLAN IP Address box.

Identify channels that are used to provide ACCESS and Give IVVR services
to Contact Center Manager Server.

Updating CallPilot configuration

1
2

On the CallPilot server, start the Configuration Wizard.

Advance to the Switch Information page. (For detailed instructions, see
the CallPilot 4.0 Planning and Engineering Guide.)

In the Symposium Call Center Server CLAN IP Address box, type the
Nortel server subnet address of Contact Center Manager Server. The
Nortel server subnet address is previously known as the CLAN address.

On the left side of the page, click the link for the set of channels you want to
configure.

Result: The Channel Name column appears the channels on the selected
link.

In the Channel Name column, click the first channel that you want to
configure.

Result: The Channel Detail Information page appears.

For each TN used to provide IVR services to Contact Center Manager
Server, select the IVR check box.

For each TN used to provide ACCESS services, select the ACCESS check
box, and specify a class ID.

The class ID is used to communicate between the server and CallPilot over
the ACCESS link. When you define the TN as a voice port on Contact
Center Manager Server, make sure that the channel number you assign to
the voice port matches the class ID for the TN.

Click Fill.
Click OK.
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To update the SDN table

You must define Service DNs for use by Symposium Voice Services. Define the
Contact Center Manager Server IVR and ACCESS ACD-DNs, as well as any
treatment DNs.

Defining IVR and ACCESS ACD-DNs
1  Start CallPilot Manager.

2 Choose System > Service Directory Number.
3 Click New.
Result: The SDN Details window appears.

CallPilot Manager ﬂ

LDAP server: cp1005:1 | Mailbox Number: 000000

Home  User v  System v  Mai r M ing ¥ Tools ¥ Help »

Location ® System * Senvice Directory Humber ® SDN Details
SDN Details:

General

Service DN
Application Name: | Symposium Voice Services A
Media Type: |%oice v
Minimum Channels: |0

. Use Default
Maxirmurm Channels

Comments

4 Inthe Service DN box, enter the Contact Center Manager Server IVR and
ACCESS ACD-DN numbers, as defined on the switch.

From the Application Name list, select Symposium Voice Services.
From the Media Type list, select Voice.
7 Click Save.
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8 Go to Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

Contact Center

Configuration Audit Trail

Management

-Lo out
Access and Partition Scripting 2
Management

Real-Time Reporting Emergency Help

Quthound

e©6 6 6
®666

Historical Reporting

9 On the system tree, double-click the appropriate server.
Result: The server expands to reveal its resources.
10 Select the Global Settings folder.

Result: The Global Settings window appears.

NERTEL CONFIGURATION

CARLING =
E g GUNNIESS Haywwards Clobal Settings
[#-{Z) Haloween
= Haywards
(L] Activity Codes

- [ Call Presentstion Classes Agent Creler Preference: |Lnngast time in ldle state since last status change %
[ cContact Types _ _ <

-~ [L1DMISE Maximum Ports With Queding For Broadcast: 95
o

rmulas - .
7 g Brogdcast Yoice Port Wait Timer: 10
- [ Historical Statistics Defautt Access IWR DM | 993, Default_[VRE b
~-[_IMR ACD-DNg

[ Metwvorking Communication Paramet Merichan Mailbox: 11111

[:I Phonesets and Yoice Potts

il G Meridian Mail Fassword. | wess
e oneset Displays ) ; '
L1 Real-time Statistics
[ Skilsets
[ Threshold Classes
[#-{Z) Heiniken
#1421 Kilkenny
+-{2) knockout

¥ -{=) Sandpiper

|-
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11 Select the Default Access IVR DN.
12 Click Submit.

To define treatment DNs
Start CallPilot Manager.

Choose System > Service Directory Number.
Click New.

In the Service DN box, enter the treatment DN.

a A WO N =

From the Application Name list, select the Application Builder application
name.

From the Media Type list, select Voice.
Click Save.
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To create voice segments

You can use voice segments as building blocks to create powerful, flexible voice
applications. If you use voice-processing commands (specifically, the Play
Prompt element), you must define voice segments.

Use the Application Builder to create, record, and manage voice segments. For
more information, see the CallPilot 4.0 Administrator’s Guide.

150

Contact Center Manager



February 2007 Voice-processing subsystem configuration

Section C: Meridian Mail

In this section

Overview 152
Channel Allocation Table 154
Voice Services DN table 155
To configure Meridian Mail for ACCESS 157
To configure Meridian Mail for Give IVR 169
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Overview

Meridian Mail uses two types of voice ports to provide voice-processing
services for Contact Center Manager Server: ACCESS voice ports and Give
IVR voice ports.

ACCESS voice ports

Contact Center Manager Server controls these voice ports over the ACCESS
link (the serial link that connects Meridian Mail and Contact Center Manager
Server). You use these voice ports for Give Controlled Broadcast
Announcement and Open Voice Session commands. Meridian Mail supports 96
voice ports.

To use ACCESS voice ports, you must configure some or all of the following
entities in Meridian Mail:

=  voice ports (virtual agent TNs)—You configure voice ports in the CAT (see
“Channel Allocation Table” on page 154).

m  Meridian Mail mailboxes—For information about creating Meridian Mail
mailboxes, see “To create Meridian Mail mailboxes” on page 160.

= voice segments—For information about creating voice segments, see “To
create voice segments” on page 161.

Give IVR voice ports

Meridian Mail controls these ports. The treatment that the caller receives is
determined by the treatment DN or IVR ACD-DN. You use these ports for
Give IVR.

To use IVR ports, you must configure some or all of the following entities in
Meridian Mail:

= voice ports (virtual agent TNs)—For information about configuring voice
ports, see “Channel Allocation Table” on page 154.

= treatment DNs (VSDNs)—For information about configuring treatment
DNs, see “To configure VSDN entries (treatment DNs)” on page 171.
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m  Voice Menu service or Announcement service—For information about
configuring treatment DNSs, see “To create announcements and voice
menus” on page 169.

This section provides procedures for configuring each of these entities. It also
describes the CAT and the Voice Services DN table where you configure these
entities.

Meridian Mail and multiple servers on a switch

If you use Meridian Mail to provide front-end IVR, the same Meridian Mail
system can support all three Contact Center systems.

If you use Symposium Voice Services on Meridian Mail to provide IVR services
(that is, with the Give IVR command), the same Meridian Mail can support all
three Contact Center systems. However, the following restrictions apply:

= You must allocate the Meridian Mail I\VVR ports between three IVR queues,
and dedicate a queue to each server.

= All of the servers must belong to the same customer group. (Therefore, you
cannot network the servers together.)

If you use Symposium Voice Services on Meridian Mail to provide ACCESS
voice services (Open/Close Voice Session, Collect Digits, and Give Controlled
Broadcast Announcement), Meridian Mail can serve only one Contact Center
system.
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Channel Allocation Table

You can use the Channel Allocation Table (CAT) to:

= view how channels (voice ports) are currently allocated across different
gueues and services

= see the distribution of voice port types (that is, the number of basic, full-
voice, and multimedia ports)

= move agents from one queue to another, to dedicate a voice port (Moice
ports are relocated on the switch. The CAT is used to notify Contact Center
Manager Server of the new location.)

Agents and DSP ports

The CAT determines how agents on the switch are associated with DSP ports on
Meridian Mail. You must associate each DSP voice port with an ACD agent
defined on the switch. Agents are identified by a Terminal Number (TN), an
ACD directory number (DN), and a single call non-ringing (SCN) DN. This
association lets both the queuing of calls coming in to Meridian Mail, and dial-
out features such as Remote Notification, Delivery to Non-Users, and the Voice
Prompt Editor.

When Meridian Mail is installed, the CAT is populated automatically by the
installation technician. This is also true when you perform a channel expansion
(to add new voice ports).

When to modify the CAT

Modify the CAT when you need to:

= move voice ports from one queue to another (to dedicate them to a
particular service)

m  program the ACCESS class (channel number) for ACCESS voice ports

For non-ACCESS voice ports, use the default datafill settings for voice ports in
the CAT.
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Voice Services DN table

\Voice Service Directory Numbers (VSDN) are defined for every Meridian Mail
service that you want to make accessible to callers. These directory numbers
(DNs) are entered in the Voice Service DN (VSDN) table, which maps DNs to
services.

Define a VSDN for:

= Meridian Mail services that are accessed through a Treatment DN (for
example, Express Messaging)

= Voice Menus and Announcement Services that are accessed through the
Contact Center Manager Server Give IVR command

The VSDN entries used by Contact Center Manager Server are referred to as
Treatment DNs.

Meridian Mail uses Treatment DNs that are accessed from the VSDN table.
Treatment DNs accessed from the VSDN table have a default value associated
with an ACD. However, Contact Center Manager Server can override the default
value by placing a call to the ACD. The value used by Meridian Mail (either the
default value or the Contact Center Manager Server value) determines which
Meridian Mail service to start (for example, a recorded announcement).

You also need a VSDN entry for the IVR ACD-DN for the ACCESS voice ports.

Tip: Ensure that ACCESS DNs in your VSDN definitions do not duplicate
mailbox numbers or switch trunk route access codes.

Nightly audits

Meridian Mail performs an audit every morning at 3:30 a.m. This audit can take
anywhere from 10 minutes (if you did not modify the system since the last audit)
to 2 hours (if you made many changes, such as adding or modifying users or
services).
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If you use Meridian Mail Call Path Diagnostics (CPD), you may receive error
events indicating that calls arriving on voice ports are not under the control of

Contact Center Manager Server.

Do not add, modify, or delete VSDNSs during the nightly audit.

156 Contact Center Manager



February 2007 Voice-processing subsystem configuration

To configure Meridian Mail for ACCESS

To use ACCESS voice ports (Give Controlled Broadcast Announcement or
\oice Session), configure the following on Meridian Mail:

m  ACCESS link to Contact Center Manager Server (see “To configure the
ACCESS link” on page 77)

m  ACCESS IVR ACD-DN entry in the VSDN table

= voice ports in CAT

= mailbox for storing voice prompts (voice segments)
m  Voice segments

To configure the ACCESS IVR ACD-DN

The ACCESS voice ports must belong to a dedicated ACD-DN called the
ACCESS IVR DN. You must add the ACCESS IVR DN to the Meridian Mail
VSDN table.

As with all of the IVR ACD-DNs, you must configure this DN on the switch in
LD 23 with IVR = YES (see “To configure IVR ACD-DNs on the switch” on
page 96), and Contact Center Manager Server must acquire it (see “To configure
IVR ACD-DNs on the server” on page 188).

The ACCESS IVR ACD-DN is the DN that you use in your scripts (for
example, Open Voice Session 7001 or Give Controlled Broadcast
Announcement 7001 [where 7001 is the ACCESS IVR ACD-DN]).

Adding a VSDN entry for the ACCESS Treatment DN

1 From the Meridian Mail Main menu, Select Voice Administration > Voice
Services Administration > Voice Services DN table.

From the VSDN table, click Add.

Enter the ACCESS DN.

In the Service box, type ACC.

Type 0 as the ACCESS class. Do not enter a Revert DN.

a H W DN
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6 Inthe Comment box, type an optional comment such as Contact Center
ACCESS DN.

7 Click Save.

Result: You return to the VSDN table. There is a new entry in the table for
this DN.

To configure ACCESS voice ports

You must configure voice ports in the CAT. You must also configure voice ports
as virtual agent TNs on the switch (see Chapter 4, “Switch subsystem
configuration™), and you must configure voice ports on Contact Center Manager
Server (see Chapter 7, “Contact Center Manager configuration”).

Prerequisites

Before you configure a voice port in Meridian Mail, you must configure the
voice port on the switch using LD 11. The voice port must belong to the
ACCESS IVR ACD-DN.

Rules for configuring voice ports
Use the following rules for voice-processing commands when configuring voice
ports in Meridian Mail.

Voice-processing command Type of port required

Give IVR Full service
Give Controlled Broadcast Basic service with ACCESS enabled
Announcement
Open-End Voice Session Basic service with ACCESS enabled
Play Prompt
Collect Digits
Play Expected Wait Time Basic service with ACCESS enabled

(or other intrinsics)
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Configuring voice ports in the CAT

These steps can vary slightly in different releases of Meridian Mail. Refer to
your Meridian Mail documentation.

1 From the System Status and Maintenance menu, disable the DSP port or
ports that you want to configure.

Tip: If you must disable multiple ports, it is quicker to change to range
mode.

2  From the System Status and Maintenance menu, select Channel
Allocation Table.

a. If you have a single-site system, the Channel Allocation Table appears.
Go to step 5.

b. If you have a multisite system, go to step 3.
Enter the number of the site on which the port resides.
Press Enter.

5 Modify the port. For each disabled port, you can change the values in the
following fields:

ACD DN: The ACCESS IVR ACD-DN.
SCN DN: This must match the switch configuration.

Capability: Basic ports can be used only for ACCESS. Full service ports
can be used for ACCESS as well, and are required for the Give IVR
command.

You cannot use Basic ports for Voice Messaging or Express Messaging.

Service: ACC for ACCESS. When you are prompted for an ACC Class,
enter a unique number to identify the channel. The ACC Class is the
channel number that you specify when creating an ACCESS voice port on
Contact Center Manager Server. See “To configure voice ports on the
server’ on page 196.

You can only modify ports that are disabled. For disabled ports, the port
capability (Full or Basic) is highlighted, and the ACD-DN, SCN, and
Outbound fields are underlined.
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6 Click Save.

Result: On a single-site system, you return to the System Status and
Maintenance menu. On a multisite system, you are prompted for another
site. To reallocate ports on another site, return to step 3. Otherwise, click
Cancel to return to the System Status and Maintenance menu.

7 Reenable any DSP ports that you put out of service before configuring the
voice ports.

To create Meridian Mail mailboxes

You must define a Meridian Mail mailbox to hold the voice files and segments
used by Contact Center Manager Server. Assign a password to the mailbox, and
identity the mailbox and password in the Global Settings dialog box of Contact
Center Manager Server (see Chapter 7, “Contact Center Manager
configuration™).

To create Meridian Mail mailbox passwords

When you first create the password, Nortel recommends that you create a
password that is the maximum length. Change the password periodically, but
only when the system is not in use.

ATTENTION Do not allow individual Meridian Mail passwords to expire.

If a Meridian Mail password expires, all voice processing
in Contact Center Manager Server stops. Nortel recommends
that the administrator configure all passwords to never
expire or, alternatively, change individual passwords based
on the system-defined frequency.

To change Meridian Mail mailbox passwords

Use the Meridian Mail MMI on the Administration Console to change
passwords. Do not use the phone logon interface. This mailbox is actively
logged on for the ACCESS voice sessions, and voice processing can be affected
while changing the password.
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If the password expires and you cannot access the Voice Prompt Editor (VPE),
on the Modify Local User screen, change the Meridian Mail logon status field
from disabled to enabled, and reenter your password in the New Password and
Confirm Password fields. (Do not change your password. Enter the password
you used before you were unable to access the VPE.)

If you enter a new password, you must also change the mailbox password on
Contact Center Manager Server in the Global Settings dialog box.

Number of allowed invalid logon attempts

You must configure the number of invalid logon attempts the user is allowed
when logging on to Meridian Mail. The number of invalid logon attempts should
be the same as or greater than the number of voice channels configured for the
system.

To create voice segments

Use the Voice Prompt Editor (VPE) to create and delete voice files, and to record
voice segments. You can use voice segments as building blocks to create
powerful, flexible voice applications. The maximum length of a voice segment
is 120 seconds.

\Voice segment file names are case-sensitive. Enter voice segments included in
scripts exactly as they appear in the Voice Prompt Editor.

Meridian Mail assigns sequential numbers to each segment created in a voice
file using the VPE. The administrator must keep track of which file or segment
number corresponds to which spoken prompt.

To use the Voice Prompt Editor, the CAT on Meridian Mail must include at least
one channel that has an outbound service value of all.

ATTENTION Do not delete voice segments. This renumbers the segments

and puts the configuration of Meridian Mail and the voice
segment variables on Contact Center Manager Server out of
sync. If segments are deleted, you must manually update
the Contact Center Manager Server variables.
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ATTENTION Nortel recommends that you limit the number of voice files

to two.

To configure voice prompts

To include a Play Prompt element in your script, configure voice prompts.

Prerequisites
Before beginning, set up the ACCESS link between Meridian Mail and Contact
Center Manager Server.

Configuring voice prompts

1 In Meridian Malil, create a mailbox for prompt storage. Make sure that the
mailbox is empty and note the password.

2 Go to Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?ﬁ?ﬁf:ﬁ:e’ Configuration

-LD out
Access and Partition Scripting E
Management

Real-Time Reporting Emergency Help

©666

Qutbound

66 6 6

Historical Reporting

3 On the system tree, double-click the server in which you want to configure
global settings.

Result: The server expands to reveal its resources.
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4

5

Select the Global Settings folder.
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Make the desired changes to the properties. You can change the following
properties:

m Agent Order Preference: Choose how to present calls to agents based

on their idle time. Valid values:

Longest total time in idle state since login: Choose this option if you
want calls to be presented to the agent who accumulated the most idle
time since logging on (this is the system default for the Communication
Server 2x00/DMS switch).

Longest time in idle state since last status change: Choose this
option if you want calls to be presented to the agent who accumulated
the most idle time since his or her last status change (this is the system
default for the Communication Server 1000/Meridian 1 switch).

Longest total time since last CDN/ACD call: Choose this option if
you want calls to be presented to the agent with the longest elapsed
time since handling a CDN/ACD call.

The system does not reset the timer when the agent switches to the Not
Ready state.
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= Default RAN Route: The default route to use when a script contains
route commands but does not explicitly state a route number.

Valid values: 3-digit maximum
Valid range: 0-511 (999 reserved for internal route)
The route you specify must already exist.

= Maximum Ports With Queuing For Broadcast: The total number of
IVR ports that can be user-controlled for broadcast at any time.

Valid values: 150 maximum

m Broadcast Voice Port Wait Timer: Type the number of seconds the
system waits for a voice port to become available.

m Default Access IVR DN: Select the default DN to use in the event that a
script contains voice-processing commands that may take an IVR ACD-
DN as a parameter, but does not explicitly state an IVR ACD-DN.

Valid values: 7-digit maximum IVR DN, followed by the name of the
default IVR DN (for example, 999, Default_IVRQ)

= Meridian Mailbox: Enter the DN of the Meridian Mail mailbox.
In CallPilot, this field is not used, but you must enter any two digits.

= Meridian Mail Password: Enter the password required to access the
Meridian Mail mailbox.

In CallPilot, this field is not used, but you must enter any four digits or
use the default.

Click OK.

Choose one of the following actions:

a. If you have a prompt tape, go to step 9.

b. If you want to create your own voice prompts, go to step 10.

Nortel does not provide a voice prompt tape as part of the standard
product. You can create a tape by creating the prompts manually, and then
using a Meridian Mail tool to transfer them to tape. (For instructions about
how to create a voice prompt tape, see the Meridian Mail documentation.)
Create the tape at one contact center. Use this facility to copy the prompts
to other contact centers in the network.

If you have a prompt tape, load the prompt files into the Meridian Mail
mailbox by following these steps:
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9

In Meridian Mail, go to the TOOLS level.
Select Others, and then select Transfer voice prompts.

Follow the Meridian Mail screen steps. All system-provided Contact
Center Manager Administration script variables must already be
mapped to the file and segments previously created and loaded from
the tape to the Meridian Mail mailbox.

To create your own prompts:

a.
b.

C.

Log on to Contact Center Manager Server.

Go to Server Utility > System Administrator > Voice Prompt Editor
> Create a Voice File.

[El|Nortel Contact Center Manager Server Utility

File Wiew Utilities Windows Help

= B o

_EI Server Ukility
+-{@] User Administration
= @@ Syskem Administration
= @ Syskem Configuration
B Serial Ports

_g Connected Sessions
¥l @ Server Backup
=) @ Alarms & Events
P Alarm Monitor
Q Event Browser
{BB Event Preferences
+ @ Syskem Performance Monitoring

Start the Voice Prompt Editor and create the appropriate prompts.
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B voice Prompt Editor. - ajith
File Edit Wiew Recorder Help

0O B“‘|FI 2|

-~ Waice Segment

ID Name Diuration

: (0:04:272
2 ajith2 0:14:656
3 gjthd 0:43:120

Saarchl Mew | Delete | Group I

~ Selected Segrment

Mame; Ia“tm
Title: I

Seript

Undo

«[m]> )@

Ready

A

d. Go to Contact Center Manager Administration Launchpad >

e.

Scripting.

> CONTACT CENTER — MANAGER

Contact Center
Management

Access and Partition
Management

Real-Time Reporting

G606 6

Historical Reporting

>THIS IS N&QRTEL.

@ configuration
@? Scripting

@3 Emergency Help
@ outbound

In the system tree, click the server on which you want to view scripts.
The server expands to reveal a series of folders.
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NERTEL SCRIPTING

Status | Launchpad | Help
- oI
(L) Seript Manager
(] Script Yariskles
D Application Thresholds

Scripting

e Click & server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading.

» Frorm the tree, select a script variable under the desired
server. Then, click Script Variable > Print to print the

variable.

f. Click the Script Variables folder.

Result: The Script Variables tree expands, listing all types of script
variables.

NERTEL SCRIPTING

Status | Launchpad | Help
= {Z) ottawa ~
(L2 Seript Manager il
=[] Script Warishles
+--[(Jach L.
CIAGENTID Scripting
[CIBOOLEAN

oo e Click & server name to log on to the server. Then, launch

Capay the Script Manager, Script Variables, or Application

gg:Y‘OF‘MONTH Thresholds by clicking each heading.

CaDms

CamTEGER

CALANGUAGE
Server. en, click Script Variable > Print o print the

%LOC Th lick Script Variable > Pri h

MONTH
Camusic variable.

» Frorm the tree, select a script variable under the desired

A F ] B [

[CAPRIORITY v

g. Right-click on the VOICE_SEGMENT folder and select New.

Result: Script Variables window appears.
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h. Below the table, click Script Variable Properties.
Result: The heading expands to reveal the General and Attribute tabs.

i. On the General tab, in the Name box, type the name of the new
variable.

j- Click the Call Variable option button if the variable is for one specific
call only; otherwise, click Global Variable to be able to use the variable
in all scripts.

k. Inthe Comment box, type any comments you want to save with the
variable.

. Click the Attribute tab.

m. From the Language list, select a language.

¥ Script Watiable Properties
General Attribute I
Type: | VOICE_SEGMENT v Language:

B A S Acld
French

German
Englizh
Chinese
Spanish
Portuguese
Japanese

* | [

‘ o
.

n. Type in a value in the format filename:segment number.
o. Click Add to add it to your list of values.
p- Click Submit to save your data.

Result: The new variable appears in the system tree in the folder
corresponding to the variable type.

10 After you create all of the prompts, write the application script, which
includes the Play Prompt command. For more information about scripts and
script variables, see the Contact Center Manager Scripting Guide for the
Communication Server 1000/Meridian 1 PBX.
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To configure Meridian Mail for Give IVR

If you use Meridian Mail for Give IVR, use non-ACCESS voice ports.
Configure the following elements on Meridian Mail:

= VOiCe menus or announcement services, or both
= VSDN entries (treatment DNs) for each voice menu or announcement
= Vvoice ports in the CAT

You can use announcement services to give in-queue announcements (“Your call
is in queue and will be answered shortly”). Prior to Meridian Mail 11, the
announcement service did not have the Silent Disconnect option, and the
announcement was repeated twice. If your Meridian Mail is earlier than Release
11, use voice menus instead.

You can use voice menus to give the caller a choice (“Press 1 for Sales or press 2
for Support”). You can also use voice menus without any options as an
alternative to an announcement service.

To create announcements and voice menus

The following section describes recommendations and where to find instructions
to create announcements and voice services.

Announcement services
Follow the instructions in the Meridian Mail Voice Services Application Guide
to create your announcement service.

Nortel recommends that you perform the following when you create the
announcement service:

= Enable Silent Disconnect (so that the caller does not hear “Good-bye” at the
end of an announcement).

= Set Number of times to play announcement to 1.
= Do not set an ACCESS password.
m  The access to the announcement is through the Give IVR command.
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Voice menu services

To give the customer a simple voice menu (“Press 1 for Sales or press 2 for
Support™), Nortel recommends that you use ACCESS ports with the Voice
Session Play Prompt/Collect Digits command. This is easier to configure and is
more flexible.

To use a Meridian Mail voice menu, follow the instructions in the Meridian Mail
Voice Services Application Guide t0 Create your voice menu service.

Voice menu as an announcement

If you use a voice menu to provide an announcement service, Nortel
recommends that you perform the following when you create the announcement
service:

= Enable Silent Disconnect (so that the caller does not hear “Good-bye” at the
end of an announcement).

s Do not set an ACCESS password.

= Record the announcement you want the callers to hear as the Greeting.

= Do not record the Menu Choices.

= Do not assign any action to each key.

= Enable Initial No Response DS (disconnect).

s Enable Delayed Response DS (disconnect).

Disconnect (DS) means that Meridian Mail drops out of the call and control
returns to the Contact Center Manager Server script. It does not mean that the
caller is disconnected.

Voice menu to offer choices to a caller
If you use a voice menu to offer choices to a caller, Nortel recommends that you
perform the following:

= Enable Silent Disconnect (so that the caller does not hear “Good-bye” at the
end of an announcement).

= Do not set an ACCESS password.

= Record the announcement you want the callers to hear as the Greeting.

= Record the Menu Choices.

= Assign an appropriate action to each key.
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Typically, this is a call (CL) with an ACD-DN. For more information, see
“Caller hears voice prompts but is never presented to an agent” on page
300.

= Enable Initial No Response DS (disconnect) or RP (Repeat Menu Choices)
as appropriate.

m  Enable Delayed Response DS (disconnect) or RP (Repeat Menu Choices)
as appropriate.

The DNs in the actions for each key can be a CDN controlled by Contact Center
Manager Server or a Phantom DN that forwards the call to a Contact Center
Manager Server CDN. In these cases, the call returns to the Master Script as a
new call and must be treated appropriately.

ATTENTION If you use Meridian Mail voice menus to transfer a call to a

CDN, the call is pegged as a new call.

To configure VSDN entries (treatment DNs)

To access the voice menu or announcement services, or both, create an entry for
each in the VSDN table.

These entries are known as treatment DNs and are used in Contact Center
Manager Server scripts to specify which treatment the caller receives (for
example, Give IVR 7002 With Treatment 1001, where 1001 is a treatment DN in
the VSDN table that points to a specific announcement).

The treatment DN is passed by the application to the switch, which, in turn,
relays it to Meridian Mail. The switch does not interpret a treatment DN, and it
does not need to appear anywhere in its configuration.

The Give IVR With Treatment command applies only to the Meridian Mail
voice-processing system or the Nortel integrated IVR CTI application.
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Defaults

You can specify an explicit treatment DN in the script for all Give IVR
commands. If a treatment DN is not specified, the default treatment DN given on
the switch in LD 23 (TRDN prompt) for the ACD-DN is used. A null value is
sent from the server to the switch, prompting the switch to insert its default
before relaying it to Meridian Mail.

Creating a VSDN entry

1 From the Meridian Mail Main menu, select Voice Administration > Voice
Services Administration > Voice Services-DN table.

2 Click ADD to add a new entry.

a. Enter the treatment DN used by Contact Center Manager Server in the
script command.

b. Select AS for Announcement Service or MS for the Voice Menu
Service.

c. Enter the Voice Menu or Announcement Service ID that was assigned
when you created it.

d. For a Voice Menu, select Basic as the session profile.

ATTENTION If you have Basic ports defined in the CAT and you select

anything other than Basic in the session profile, the Give
IVR command fails on these ports and the caller receives
an announcement similar to “Your session cannot be
completed at this time.”

e. Add an optional comment (for example, Contact Center
Announcement).

f. Click Save.

3 Repeat for each Announcement or Voice Menu Service.

To configure IVR voice ports

You must configure voice ports in the CAT. You must also configure voice ports
as virtual agent TNs on the switch (see Chapter 4, “Switch subsystem
configuration”), and you must configure voice ports on Contact Center Manager
Server (see Chapter 7, “Contact Center Manager configuration”).
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The voice ports must belong to a dedicated IVR ACD-DN, and the CAT must
match the switch configuration. The dedicated IVR ACD-DN is the DN that you
use in your scripts (for example, Give IVR 7002, where 7002 is the dedicated
IVR ACD-DN).

Prerequisites

Before you configure a voice port in Meridian Mail, you must configure the
voice port on the switch using LD 11. The voice port must belong to the IVR
ACD-DN.

An IVR ACD-DN cannot contain both Basic and Full Service ports. If you use
both types of ports, you must have at least two VR ACD-DNs.

Configuring voice ports in the CAT

These steps can vary slightly on different releases of Meridian Mail. Refer to
your Meridian Mail documentation.

1  From the System Status and Maintenance menu, disable the DSP ports
that you want to configure.

Tip: If you must disable multiple ports, it is quicker to change to range
mode.

2  From the System Status and Maintenance menu, select Channel
Allocation Table.

a. If you have a single-site system, the Channel Allocation Table appears.
Go to step 4.

b. If you have a multisite system, go to step 3.
Type the number of the site on which the port resides, and then click Enter.

Modify the port. For each disabled port, you can change the values in the
following fields:

ACD DN: The IVR ACD-DN.
SCN DN: This must match the switch configuration.

Capability: The Meridian Mail keycode determines the types of ports that
are available. Basic ports are less expensive to purchase and provide the
capability required for ACCESS ports. If the keycode allows it, you can set
the capability to Full.
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You can only modify ports that are disabled. For disabled ports, the port
capability (Full or Basic) is highlighted, and the ACD-DN, SCN, and
Outbound fields are underlined.

5 Click Save.

Result: On a single-site system, you return to the System Status and
Maintenance menu. On a multisite system, you are prompted for another
site. To reallocate ports on another site, return to step 3. Otherwise, click
Cancel to return to the System Status and Maintenance menu.

6 Reenable any DSP ports that you put out of service before configuring the
voice ports.
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Section D: Third-party voice-processing
systems

In this section

Overview of third-party voice-processing systems 176
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Overview of third-party voice-processing
systems

External IVR systems can connect their voice channels to the switch in a variety
of ways, including as 2500 (analog) set TNs, 2500 (analog) set ACD TNs, and
T1, DPNSS, or ISDN channels.

In this section, an external VR system refers to any device not already
discussed that can provide voice services. This includes third-party IVR
systems, Nortel IVR (an integrated CTI application), and third-party voice mail
systems.

External IVR systems not accessed from Contact Center Manager
Server scripts

Usually, if an external IVR provides a voice menu or other caller interaction, the
calls terminate on it directly and are transferred to the Contact Center Manager
Server CDN at the end of the IVR session (front-end 1VR).

If the call is already under the control of a Contact Center Manager Server
script, it can be handed off to the IVVR system by using the Route Call script
command.

IVR systems used in this manner do not require any special configuration on
Contact Center Manager Server. The voice ports and ACD-DN do not need to be
acquired.

Using external IVR systems with Give IVR

You can use IVR systems that connect as ACD sets (including Line Side T1 and
Line Side E1 connections, which the switch treats as analog ACD agents) to
service the Contact Center Manager Server Give IVR script command. You can
use IVR systems to give announcements or offer voice menus while the call is
under the control of the script and is waiting in a queue.
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Treatment DNs

Most external VR systems do not support the With Treatment part of the Give
IVR command. This means that each IVR ACD-DN can only offer one type of
treatment.

Some IVR systems support an APL link or Meridian Link that can be used to
deliver the treatment DN to the IVR system to determine the message played.
the Nortel IVR CTI application uses Meridian Link to deliver the treatment DN
to Nortel IVR.

Switch and Contact Center Manager Server configuration

To use an external IVR system with the Give IVR command, the required
configuration is similar to using Meridian Mail for Give IVR:

= The voice ports must belong to an IVR ACD-DN (with IVR = YES).

As with Meridian Mail, configure the switch so that only Contact Center
Manager Server Give IVR calls terminate on this ACD-DN.

= Contact Center Manager Server must acquire the IVR ACD-DN.

= Contact Center Manager Server must acquire the voice port TNs.

You can configure IVR ACD agents as agents in a skillset if you require Contact
Center Manager Server real-time and historical reporting and call routing

control. For more information, see “To configure IVR ACD-DNSs on the server”
on page 188 and “To configure agent phones on the server” on page 194.

Configuration of the external IVR

Configuration of the external IVVR varies from one I\VVR system to another and is
beyond the scope of this document.
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Overview

The Contact Center requires the following major configuration elements for call
processing:

voice connection
CDNs

IVR ACD-DNs
agent phones (TNs)

voice ports (virtual agents)
global settings

Agent Order Preference

Default RAN Route

Maximum Ports With Queuing For Broadcast
Broadcast Voice Port Wait Timer

Default Access IVR DN

Meridian Mailbox

Meridian Mailbox Password

voice segment variables

the application scripts

Configure resources such as agent phones, CDNSs, and voice ports on the switch
and in the voice-processing system (if applicable) before acquiring them on
Contact Center Manager Administration.

For detailed information about how to configure switch resources for the
application, see the Contact Center Manager Administration online help.

For detailed information about how to plan and write scripts, see the Contact
Center Manager Scripting Guide for the Communication Server 1000/Meridian

1 PBX.
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To configure voice connections

If you use Symposium Voice Services on CallPilot or on Meridian Mail, you
must configure the voice connection. To configure the voice connection, you
must perform these tasks:

1. Shut down Contact Center Manager Server (if it is running).

2. Configure the CallPilot or Meridian Mail connection.

Shutting down the server

1 From the Windows Start menu, choose Programs > Nortel Contact
Center > Manager Server > Shutdown.

Result: The Contact Center Manager Server Shutdown dialog box
appears.

2 Click OK.

Result: The utility shuts down all services, and then the Service Status Log
window appears. This log lists any services that failed to shut down.

Click Recheck to refresh the service statuses.
If any services are still running:

a. From the Windows Start menu, choose Control Panel >
Administrative Tools > Services to display the Services window.

b. Manually shut down the listed services.
c. Close the Services window.
d. Click Recheck to update the status log.
5 Click Accept to exit the utility.
Click Start > Run
In the command line, type serman.
Result: All the services are placed in manual mode.

8 Restart the server.
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Configuring the CallPilot connection

1

On Contact Center Manager Server, choose Programs > Nortel Contact
Center > Manager Server > Server Setup Configuration.

Click the Voice Services tab.

Result: The Voice Services property page appears.

Local Area Network IP VoiceSenices | RSMIPAddiess | SieName | Usies

CJ

Please fil in the voice senaces setup mformation below,

Woice Connection Typs: " Senal [Mendian Mail]

Call Filot Serves [P: 172185041
Call Piot Server Port 10008
> CONTACT CENTER i !
MANAGER SERVER
>THIS IS NERTEL
[0k | camca | o | e

For Voice Connection Type, choose TCP (CallPilot).
Enter information into the following boxes:

CallPilot Server IP: Enter the ELAN subnet IP address of the CallPilot
server.

CallPilot Port: Enter 10008.
For Single-NIC configuration, follow these steps:

a. Ensure the ELAN subnet is connected to the Nortel server subnet
though one (and only one) router.

b. Enter the CallPilot Nortel server subnet NIC IP address as opposed to
the ELAN subnet NIC.

c. In CallPilot, do not configure a default gateway (for example, router)
address associated with the CallPilot ELAN NIC. A default gateway for
the CallPilot's NIC connected to the Nortel server subnet is required.
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Click OK.

Result: The following message appears: “The configuration data has been
validated and can be used to configure the server database. Do you wish to
use this data to complete server configuration now?”

Click Yes.

Result: The Server Configuration utility runs and then the following
message appears: “You must reboot now to commit changes. Press OK to
reboot or Cancel to stop.”

Click OK.

Result: The server restarts.

Configuring the Meridian Mail connection

1

3

On Contact Center Manager Server, choose Programs > Nortel Contact
Center > Manager Server > Server Setup Configuration.

Click the Voice Services tab.

Result: The Voice Services property page appears.

£¥. Nortel Contact Center Management Server Setup Configuration Utility [ %]
Customer Information | Licenze Manager I Succeszion CSE 1000 Switch Infarmation I
Local drea Metwark IP VoiceServices | RSMIPAddiess | SteMame | Utiities
7 " Fleaze fill in the voice services setup information below.
Woice Connection Type:
" TCP (Call Pilat)
Call Pilot Server ELAN P |
Call Pilat Server Port: ID
> CONTACT CENTER
MANAGER SERVER
>THIS IS NERTEL
QK I Cancel | Lpply | Help |

For Voice Connection Type, choose Serial (Meridian Mail).
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The CallPilot server ELAN IP box clears, and the CallPilot Port box is set to
0. Do not change these values.

Click OK.

Result: The following message appears: “The configuration data has been
validated and can be used to configure the server database. Do you wish to
use this data to complete server configuration now?”

Click Yes.

Result: The Server Configuration utility runs and then the following
message appears: “Server Setup Configuration is completed successfully.”

Click OK.

Result: The following message appears: “You must reboot now to commit
all changes. Do you wish to reboot now?”

Click Yes.

Result: The server restarts.
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To configure CDNs on the server

You must configure and acquire all CDNs referenced by scripts and on which
calls for Contact Center Manager Administration arrive. These CDNs must
match those that are configured on the switch. For more information about
referencing CDNSs in scripts, see the Contact Center Manager Scripting Guide
for the Communication Server 1000/Meridian 1 PBX.

Configuring and acquiring a CDN

1 Goto Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

ﬁ:n;agc:nf:;ter Configuration Audit Trail

-LU out
Access and Partition Scripting .
Management

Real-Time Reporting Emergency Help

G666

Qutbound

666 6

Historical Reporting
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On the system tree, double-click the server in which you want to add the
CDN.

Result: The server expands to reveal its resources.

NERTEL CONFIGURATION

|

Server |

aring

-4 ottawa

Download

[ activity Cades

D Call Presentation Clazses
[C2CDMs (Route Points)

D Contact Types

=

D Formulss

D Global Settings

[ Histarical Statistics

[CIWR ACD-DMs

I:I Metweorking Communication Paramet
D Phonesets and Yoice Ports
[ Phoneset Displays

[ Realtime Statistics

D Routes

[ skilsets

D Threshold Classes

Status

Configuration

o Double-click a server to view configuration
resources, such as CONs (Route Points)

and DNISs. Then click a resource to add,

edit, or delete configuration data

Launchpad | Help

Click the CDNs (Route Points) folder.

Result: The CDNs (Route Points) window appears.

NERTEL CONFIGURATION

Sandpiper CONs (Route Points)

=@

| Sandpiper

- DAHNW Codes

- [ Call Presentation Clazzes
---[Z CDMs (Route Points)

[ Contact Types

- [1DMiss

[IFormulas

[ Glokal Settings

4 DHlsmrlcal Statistics

- [ZIWR ACD-DNs

i D Metwworking Communication Pararme

[CPhonesets and voice Ports

= DPhUnesﬁ Displays

[ Real-time: Statistics

s DRuulss
[ skilsets
[ Threshold Classes

SMITHWICKS

CDNs | OpenCuets ‘
Mame LIR Call Type

[ =S e morelcom Cpen Glueus Local
nortel] v Tlesc canotel com COpen Glueue Network
mortel2 sy nioHel com Open Glsue Loca|
norteld v e canotel. com COpen Gusus MNetwork
norteld vy abo0] 2348678901 2345678501 23 |Oper Queus Locs|
lest ey a0l 2345678001 23456780901 23 |Open Qusus Locs|

*

In the Name box, type the name of the CDN as you want it to appear in
reports.
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10

In the Number box, type the CDN number. This number must match the
number configured on the switch.

From the Call Type list, select whether you want the CDN to be Local calls,
MCDN Network calls, or DNIS Network calls.

To use the CDN for MCDN Network calls, the server must have Network
Skills Based Routing (NSBR) enabled and be connected to a
Communication Server 1000/Meridian 1 PBX. To use the CDN for DNIS
Network calls, the server must have Universal Networking enabled.

Click any other row of the table.

Result: The system adds the CDN, and Not Acquired appears in the Status
column.

Select the Acquired? check box in the row containing the CDN that you
just added.

Click any other row in the table to acquire the CDN.

Result: The system acquires the CDN, and the status appears in the
Status column.

If necessary, click Refresh Status to view the current status of the
acquisition.

Repeat steps 2 to 9 for each CDN that you want to configure and acquire.

If you want to reconfigure a CDN, you must first deacquire the CDN, edit
the configuration parameters, and then reacquire the CDN.
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To configure IVR ACD-DNs on the server

Configure and acquire every switch ACD-DN used in voice processing (an
ACD-DN behind which the voice ports are defined) by Contact Center Manager
Administration.

Configuring and acquiring an IVR ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

©666

Qutbound

666 6

Historical Reporting

2 On the system tree, double-click the server in which you want to add the
IVR ACD-DN.

Result: The server expands to reveal its resources.
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Click the IVR ACD-DNSs folder.
Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

Server | Download
=) BALTIKA
CARLING
GUINNESS
+-{Z) Haloween
=) Haywards
(L Activity Codes

Haywards VR ACD-DMNs

Mame Mumber Threshald Class
D Call Prezentation Classes Default WVRE 899 IvF_Template
[ZCOMs (Route Poirts) SLIS0201 =00 IVR_Template 1]
(L] Contact Types * ]
[aDHss

D Formulas

[ Global Seftings

([ Histarical Statistics

Status
Mot Acquired
Mot Acouired

Acuired?

b d

D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
Heiniken
kilkenny
knockout
[+1-4)) Sandpiper

In the Name box, type the name of the IVR ACD-DN as you want it to
appear in reports.

In the Number box, type the IVR ACD-DN number. This number must
match the number configured on the switch.

From the Threshold Class list, select the threshold class for the IVR ACD-
DN.

Click any other row of the table.

Result: The system adds the IVR ACD-DN, and Not Acquired appears in
the Status column.

Select the Acquired? check box in the row containing the IVR ACD-DN
that you just added.

Click any other row in the table to acquire the IVR ACD-DN.

Result: The system acquires the IVR ACD-DN, and the status appears in
the Status column.

If necessary, click Refresh Status to view the current status of the
acquisition.
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10 Repeat steps 2 to 9 for each IVR ACD-DN that you want to configure and
acquire. To reconfigure an ACD-DN, first deacquire the ACD-DN, edit the
configuration parameters, and then reacquire the ACD-DN.
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To configure personal DNs on the server

After you configure phantom TNs on the switch, you must configure the
associated personal DNs in Contact Center Manager Administration.

Configuring a personal DN for a supervisor

1 In Contact Center Manager Administration, from the launchpad, select
Contact Center Management.

Result: The Supervisor view of the Contact Center Management window
appears.

2  Onthe system tree, double-click the server in which you want to add the the
personal DN.

Result: The server expands to reveal a list of configured supervisors.
On the system tree, right-click the supervisor that you want to configure.
From the resulting menu, select Supervisor Details.

Result: The Supervisor Details window appears.

NEIRTEL CONTACT CENTER MANAGEMENT

view /Edit | Add Status | Launchpad | Help
= (Z1CCM Servers (Supervisors)  sypervisor Details : Derrick Lavigne Server: ottawa
= (C: ot
+ ﬁLavignn Tirrirk = Lizgt Details

Add Agenl

Supervisor Details irst Name: * | Derrick. il User Type: | Supervisor V]
Delete Supervisar e e | Login [0t |
addmaby Users,  [TiomeiE lavigne | RRILE: 20
Title: | | Personal D | |
Department: | |
Languae ! English v

Comment: | |

m Agent [nformation

* Superdsor Information
Contact Center Manager
Administration

. o Telephony/Fort: il User IDx | ! |

|

5 Inthe Personal DN box, type the DN associated with the phantom TN that
you configured on the switch.
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6

Click Submit to save your changes.

Configuring a personal DN for an agent

1

In Contact Center Manager Administration, from the launchpad, select
Contact Center Management.

Result: The Supervisor view of the Contact Center Management window
appears.

From the View/Edit menu, select Agents.

Result: The Agent view of the Contact Center Management window
appears.

On the system tree, double-click the server in which you want to add the the
personal DN.

Result: The agent window appears.

Using the search boxes, search for the agent to whom you want to assign
the personal DN. To list all agents, click List All.

Result: The agents appear in a table below the search boxes.

NERTEL CONTACT CENTER MANAGEMENT

view /Edit | Add Status | Launchpad | Help
= [ CCM Servers (Agents)
=) ott:
@ dtaws Agents List : 2 Agents Server: ottawa

Show all agents on ottawa where:

[LastMame +| | Contains v| [ | | v

[ Loginm Agent llame (2) ~ Agent Status. Functions Delete [ |
2003 Lavigne Brayden Logged Out L il
2002 Lavigne Logan Logged Out - ]

< | B
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Click the agent name.

Result: The Agent Details window appears.

NERTEL CONTACT CENTER MANAGEMENT

view /Edit | Add Status | Launchpad | Help
- C0CCM Servers (Agents) ooy petaiis : Brayden Lavigne Server: ottawa
i -@.’Uﬂawa
w User Details
First Mame: * | Brapden Uszer Type:
Last Maime: * lﬁ\:igne Lagin ID: + 2003
Ttle: [ Personal DN |
Department: ‘ lACD Glueue: |4530

Language: Enalish w

ACD Queue Errar:

Commert: ‘

* Agent Infarmation

Primary Supervizor: + | Lavigne Derick %

1 nnine Stetis

£

]

Call Presertation: | Call Centre_Administrator »

Threshold, Agent_Template  w
Tn Name
| 8

In the Personal DN box, type the DN associated with the phantom TN that

you configured on the switch.

Click Submit to save your changes.
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To configure agent phones on the server

Configure and acquire phones (TNSs) for all agents and supervisors.

The switch system types use the following TN formats:

m  For Meridian 1 PBX 11 systems, the TN format is loop-0-0-unit (for
example, 8-0-0-5).

m  For all other Communication Server 1000 system types, and the Meridian 1
PBX, the TN format is loop-shelf-card-unit (for example, 24-0-4-5).

Configuring and acquiring a phone

1  In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁzg;ﬁ:ﬁf:ﬁ:er Configuration

Logout
Access and Partition Scripting
Management

Real-Time Reporting Emergency Help

Qutbound

OO 6 6
®666

Historical Reporting

2 On the system tree, double-click the server in which you want to add the
phone.

Result: The server expands to reveal its resources.
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3 Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

CONFIGURATION

Blakus | Launchia

Haywards PhonesstsiVoics Pons

[ emesn =

iR e [ acgurear [eauz

[Acepired Login
Acqured
Ayt

Mot Azuired

[Aceparea
Mot Azauieea

i e e e e |

4 In the Name box, type the name of the phone as you want it to appear in
reports.

From the Type list, select Not Voice Port.
In the Address box, type the address of the phone on the telephony server.
Click any other row of the table.

Result: The system adds the phone, and Not Acquired appears in the
Status column.

8  Select the Acquired? check box in the row containing the phone that you
just added.

9 Click any other row in the table to acquire the phone.

Result: The system acquires the phone, and the status appears in the
Status column.

If necessary, click Refresh Status to view the current status of the
acquisition.

10 Repeat steps 2 to 9 for each phone that you want to configure and acquire.

To reconfigure a phone, deacquire the phone, edit the configuration
parameters, and then reacquire the phone.
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To configure voice ports on the server

Configure and acquire the voice ports and channel numbers used by Contact
Center Manager Administration.

Adding a phone as a voice port

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁgztaagc:nf:mer Configuration

-Lo out
Access and Partition Scripting 2
Management

Real-Time Reporting Emergency Help

®©e66

Qutbound

G606 6

Historical Reporting

2 On the system tree, double-click the server in which you want to add the
voice port.

Result: The server expands to reveal its resources.
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10

Click the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download

i) BALTIKA

{iZ) CARLING :

&) GUINNESS Haywards Phonesets/Voice Ports

-{iZ)) Haloween

(- - [

=) Haywards
(L2 Activity Codes Mame Type Address Channel VR Mame
[ZCall Presentation Classes p [10-0-0-2 oice Port 10-0-0-0 7080 (7080)
D CDMs (Route Points) 10-0-0-1 “oice Port 10-0-0-1 FATER anfe))
D Contact Types 5-0-0-0 Agent 5-0-0-0
[aoMiss 5-0-0-1 Agert 5-0-0-1
[CaFarmuas 5002 Ertar 5-0-0-2
[ Globel Settings: 5.0-0-3 Agent 5.0-0-3
[ Historicsl Statistics 5-0-0-4 Supervisar 5-0-0-4
MR ACD-DHs 5.0-0-9 Error 5.0-0-9
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[CIReal-ime Statistics
[Routes

[ Skilzets

D Threshold Clazsses

[#-{Z] Heiniken
-4z kilkenny

In the Name box, type the name of the voice port as you want it to appear in
reports

From the Type list, select Voice Port.

In the Address box, type the address of the voice port on the telephony
server.

For ACCESS voice ports only, in the Channel box, type the channel
number.

Click any other row of the table.

Result: The system adds the voice port, and Not Acquired appears in the
Status column.

Select the Acquired? check box in the row containing the voice port that
you just added.

Click any other row in the table to acquire the voice port.

Result: The system acquires the voice port, and the status appears in the
Status column.

If necessary, click Refresh Status to view the current status of the
acquisition.
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11 Repeat steps 2 to 10 for each voice port you want to configure. To
reconfigure a voice port, deacquire the voice port, edit the configuration
parameters, and then reacquire the voice port.
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To configure Global settings

To support voice processing in Contact Center, you must configure the following
items in the Contact Center Manager Administration Global Settings window:

= the number of voice ports that can be used for broadcast announcements

= the wait time for a start/stop broadcast announcement (the amount of time
between the arrival of the first call for the start/stop broadcast
announcement and when the announcement actually starts)

m the default ACCESS treatment DN for the Give Controlled Broadcast
Announcement and Voice Session script commands (This is the ACCESS
ACD-DN.)

= the DN and password for the mailbox containing the voice files and
segments used by Give Controlled Broadcast Announcement and Voice
Session script commands (if you use Symposium Voice Services on
Meridian Mail)

If you use CallPilot, you must enter any value (even though the fields are
not used).

Maximum number of broadcast ports

Configure the number of voice ports that are available for use for Give
Controlled Broadcast Announcement at any given time. Up to 50 calls can be
attached simultaneously to a single voice port on a broadcast announcement.
The fifty-first call for an announcement is connected to a new voice port, as long
as the maximum number of broadcast voice ports is not exceeded. After the
maximum is exceeded, new calls do not receive a broadcast announcement.
(New calls skip past the prompt and execute the next command in the script.)

If the voice ports are partitioned so that broadcast calls are directed to a
dedicated IVR ACD-DN (that is, it does not share voice ports with Open Voice
Session), then the setting of this parameter is not important as long as it is set to
greater than the number of voice ports in this IVR ACD-DN. This lets new calls
to be queued to the broadcast voice ports.
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However, if voice ports are shared between broadcast announcements and voice
session, it may be important to limit the number of voice ports that can be used
by broadcasts so as not to limit the Voice Session calls from getting a voice port.

You can estimate the number of broadcast voice ports needed using the call
arrival rate, the length of the announcement, and, if start/stop operation is used,
the Broadcast Wait Timer. The goal is to minimize the number of voice ports
used by broadcast and to maximize the number of voice ports used by Voice
Session. (Because Voice Session needs a one-call-to-one-port arrangement, the
\Voice Session voice port use for the same call traffic is generally higher.)

Broadcast voice port wait timer

The value of this timer determines how many calls have a chance to be
connected to the same voice port. The timer matters only if broadcast
voice-processing is used in start/stop mode. Continuous mode connects calls
immediately upon arrival.

A longer timer lets more calls to connect to the same voice port. Conversely, a
shorter timer lets calls to get into the announcement more quickly, but, on
average, fewer calls use a single voice port (which means less efficient use of
voice ports). The default setting is 10 seconds and the appropriate setting for this
parameter can vary widely from one contact center to the next.

Default ACCESS treatment DN

Do not explicitly specify a treatment DN in the Open Voice Session or Give
Controlled Broadcast Announcement command within a script. Use the default
ACCESS treatment DN instead.

The default ACCESS treatment DN must be the same as the ACCESS IVR DN.
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Meridian Mail mailbox and password

To use the Give Controlled Broadcast Announcement and Open/End Voice
Session commands with Meridian Mail, you must configure the Meridian Mail
mailbox and password containing the voice files. Only one mailbox is
configurable for the application system.

ATTENTION  Nortel recommends that you use the Meridian

Administration terminal only to change the Meridian
Mail mailbox password on Meridian Mail. Do not use the
phone to change the password as the mailbox may be in
use by voice-processing and this can interrupt service.

Prerequisites

Before you configure global settings in the application, perform the following
tasks:

m  Ensure that the Meridian Mail mailbox and password are defined on the
Meridian Mail subsystem (if you use Symposium Voice Services on
Meridian Mail).

s Ensure that the IVR ACD-DN is defined on the switch.
s Ensure that the Treatment DN is defined on CallPilot or Meridian Mail.
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Configuring the global settings

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

©666

Historical Reporting Outbound

666 6

2  On the system tree, double-click the server in which you want to configure
global settings.

Result: The server expands to reveal its resources.
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3 Click the Global Settings folder.
Result: The Global Settings window appears.
NERTEL CONFIGURATION
server | Dowmload
+ €: BALTIKA
i arime Haywards Global Settings
+-{] Haloween
-1 -{i=) Haywards
[ Activity Codes o —
DCaI\ Presentation Clazses Agent Order Preference: |Lungast time in ldle state since |ast status change v |
L1CoMs (Route Points) Default Ran Route: |303 - 7 .
D Contact Types d
Maximum Ports With Gueuing For Broadca:
Broadcast Yoice Port \Wait Timer: ITD )
Difault Access MR DN, | claut_WRE |
IR ACD.DHs ! e —
[ Metworking Communication Paramel Merician tailbo: _!
DPthesas and Yoice Ports MEFiian sl Passwor
[ Phoneset Displays
[LReal-time Statistics
D Routes
[ Skilsets
D Threshald Classes
i) Heiniken
enny
knockout
) Sandpiper
4  From the Agent Order Preference list, choose how to present calls to

agents based on their idle time. Valid values:

Longest total time in idle state since login—Choose this option if you
want calls to be presented to the agent who accumulated the most idle
time since logging on (this is the system default for the Communication
Server 2x00/DMS switch).

Longest time in idle state since last status change—Choose this
option if you want calls to be presented to the agent who accumulated
the most idle time since his or her last status change (this is the system
default for the Communication Server 1000/Meridian 1 switch).

Longest total time since last CDN/ACD call—Choose this option if
you want calls to be presented to the agent with the longest elapsed
time since handling a CDN/ACD call.

The system does not reset the timer when the agent switches to the Not
Ready state.
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10

11

In the Default RAN Route box, type the default route to use when a script
contains route commands but does not explicitly state a route number.

Valid values: maximum of 3 digits
Valid range: 0-511 (999 reserved for internal route)
The route you specify must already exist.

In the Maximum Ports With Queuing For Broadcast box, type the total
number of IVR ports that can be user-controlled for broadcast at any time.

Valid values: 150 maximum

In the Broadcast Voice Port Wait Timer box, type the number of seconds
the system waits for a voice port to become available.

From the Default Access IVR DN list, select the default DN to use in the
event that a script contains voice-processing commands that may take an
IVR ACD-DN as a parameter, but does not explicitly state an IVR ACD-DN.

In the Meridian Mailbox box, type the DN of the Meridian Mail mailbox. In
CallPilot, this field is not used, but you must enter any two digits.

In the Meridian Mail Password box, type the password required to access
the Meridian Mail mailbox. In CallPilot, this field is not used, but you must
enter any four digits or use the default.

Click Submit.
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To define voice segment variables

Contact Center Manager Server scripts reference voice segments on CallPilot or
Meridian Mail by using voice segment variables. \oice segment variables can
contain one or more voice segments. These voice segments contain specific
words or phrases recorded in the Voice Prompt Editor or Application Builder.
Each voice segment variable has a name, number, and value that indicates the
language used to record the segment.

Two types of voice segments are available:

= user defined
= system predefined

User-defined voice segments

Record user-defined voice segments for CallPilot or Meridian Mail. For
CallPilot, you record the voice segments using Application Builder. For
Meridian Mail, you record the voice segments using the Voice Prompt Editor
(VPE) on the Contact Center Manager Server.

Then you define the variables using the Script Variables dialog box. A voice
segment variable has the type VOICE SEGMENT, and is a global variable. You
can define any number of variables.

You can define the variables on Contact Center Manager Administration at any
time. Neither Contact Center Manager Administration nor CallPilot or Meridian
Mail checks for the existence of the segments on the other platform except at run
time. When Contact Center Manager Administration instructs CallPilot or
Meridian Mail to play a specific voice segment from a specific file, the
referenced segment must exist.

\Voice segment file names are case-sensitive. Enter voice segments included in
scripts exactly as they appear in Application Builder or the Voice Prompt Editor.

For more information about creating voice segments, see the Contact Center
Manager Administrator's Guide.
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System-predefined phrases

To generate spoken numbers, Contact Center Manager Server provides a number
of predefined voice segments representing spoken numbers. Contact Center
Manager Server strings the segments together automatically to create the ability
to speak numbers 0-999,999,999,999,999.

Predefined voice segment variables have file and segment number placeholders
when the Contact Center Manager Server system is installed. Record the file and
segment numbers referenced by these variables.

Script example

In the following example, a voice session begins in which a caller hears a
message prompting the caller to enter an identification number by pressing the
phone keys. The seven digits entered are collected into a variable named
vardigit_cv. The caller hears a second message in which the numbers entered are

spoken back:

OPEN VOICE SESSION 2299
PLAY PROMPT VOICE SEGMENT enter_ID number_ vs
COLLECT 7 DIGITS INTO vardigit_cv
PLAY PROMPT NUMBERBYDIGIT vardigit_cv

END VOICE SESSION
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To define scripts

You use script commands to determine how calls are handled. The services that
a particular caller hears depend on the path the call follows through the Master
Script and any secondary scripts. Information about the voice-processing
treatment that a call receives by Contact Center Manager Server is pegged in the
database. This lets you to run reports showing details about voice processing and
its effects in your contact center.

For more information about scripts, see the Contact Center Manager Scripting
Guide for the Communication Server 1000/Meridian 1 PBX.

CDNs

Ensure that the script references a CDN that is configured and acquired on
Contact Center Manager Administration.

NACD ACD-DNs

To route calls to a remote ACD-DN, the Contact Center Manager Server script
must contain the following command:

QUEUE TO NACD acd-dn [WITH PRIORITY priority]
The script can contain other commands to control the wait time or to change the
priority.

IVR ACD-DNs and treatment DNs

All voice-processing script commands need and use both an IVR ACD-DN and
a treatment DN. Both parameters are optional in the script statement, and the
defaults are drawn from different places.
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Routes

The IVR ACD-DN on the voice-processing script statement specifies the switch
ACD-DN to which the voice port TNs belong in the switch configuration.
Contact Center Manager Server directs voice-processing calls to the IVR ACD-
DN, and the switch ACD software distributes the calls over the voice port (that
is, the switch selects the actual voice port, not the Contact Center Manager
Server software).

If TRDN is not configured in the switch IVR ACD-DN, you must include with
treatment in the Give IVR script element.

Contact Center Manager Server must acquire the IVR ACD-DN for
voice-processing to operate correctly.

If you want to generate all trunks busy (ATB) reports, you must configure trunk
routes on Contact Center Manager Administration, and you must acquire the
routes.

To use Give Music or Give RAN commands, in the Contact Center Manager
Server script, you must reference a RAN or MUS route. You do not need to
acquire music or RAN routes.
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Configuration information for other
Contact Center products

In this chapter

Contact Center Multimedia and Outbound 210
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Contact Center Multimedia and Outbound

This section describes the tasks to complete when you configure agent phones
for Communication Control Toolkit (CCT).

To configure agent phones for CCT control

The agent desktops for Multimedia and Outbound must have their associated
configuration terminals, users, addresses, and so on, configured in
Communication Control Toolkit. The switch requirements are the same as for
voice desktop.

Agents assigned multimedia capabilities must log onto a phone through the
Communication Control Toolkit. These agents cannot manually log onto a
phone.

Communication Server 1000/Meridian 1 PBX checklist for agent
phones

When engineering agent phones (TNs) for use with Communication Control
Toolkit, you must complete the tasks in this checklist.

Communication Server 1000/Meridian 1 PBX for the agent |/

Create a TN entry for each contact center agent as per instructions
in the Contact Center Manager Server Installation and
Maintenance Guide.

Ensure that key 0 has ACD functionality. You can configure TNs
with a Contact Center Manager Server-specific ACD queue or a
normal ACD queue used for both voice and media.

If you enable scheduled callback dialing, ensure that a personal
DN key is created on the contact center agent phone.

Enable Associated Set Assignment (AST) for the ACD key and
for one of the other personal DN keys.

You can configure AST on a maximum of two keys.
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Communication Server 1000/Meridian 1 PBX for the agent |/

Ensure that IAPG is enabled.

Sample agent phone configuration for Communication Control
Toolkit

The following sample provides the switch configuration of the agent phone
configured for Communication Control Toolkit. You perform this setup on LD
11.

DES 8446

TN 017 0 00 09
TYPE 2616

CDEN 8D

CUST O

AOM O

FDN 8383

TGAR 1

LDN NO

NCOS 6
SGRP 0
RNPG 0
SCI O
SSU

LNRS 16

XLST

SCPW

CLS CTD FBD WTA LPR MTD FNA HTA ADD HFD

MWA LMPN RMMD SMWD AAD IMD XHD IRA NID OLA VCE DRG1
POD DSX VMD CMSD SLKD CCSD SWD LNA CNDD

CFTD SFD MRD DDV CNID CDCA MSID DAPA BFED RCBD

ICDD CDMD LLCN MCTD CLBD AUTU

GPUD DPUD DNDD CFXD ARHD CNTD CLTD ASCD

CPFA CPTA ABDD CFHD FICD NAID BUZZ AGRD MOAD AHA
DDGA NAMA

DRDD EXR

USMD USRD ULAD RTDD RBDD RBHD PGND OCBD FLXD FTTC
MCBN

CPND_LANG ENG

RCO O

HUNT 8383

LHK 8

LPK O

PLEV 02
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SPID NONE
AST 00 08
IAPG 1

AACS YES
ACQ AS: TN,AST-DN,AST-POSID
ASID 16
SPFNB 1 2 3 4 5 6 9 10 11 12 13 15 16 17 18
19 22 24

SFRB 1 2 15

USFB 1 2 3 4 5 6 7 9 10 11 12 13 14 15
cCAIB 0 1 3 4 5 6 8 9 10 11 12
FCTB

ITNA NO

DGRP

PRI 01

MLWU_LANG 0

DNDR O

KEY 00 ACD 8710 0 4715

AGN

01 DwC 8710

02 AO06

03 TRN

04

05 NR

06MSB

07

08 SCR 8446 0

CPND

NAME Mark Smith

XPLN 27

DISPLAY FMT FIRST, LAST

09 SCR 8476 0 MARP

CPND

NAME Paula Jones

XPLN 27

DISPLAY FMT FIRST, LAST

10 ACNT

11 SCR 4305 0 MARP

12 ADL 16

13 CFW 4 8396

14 MWK 8383

15

DATE 30 APR 2004
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Testing integration

In this chapter

Overview 214
To test basic voice services (Give IVR) 216
To test advanced voice services (ACCESS) 231
Test scripts 242
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Overview

If you use CallPilot for voice services, you can use the test scripts supplied in
Contact Center Manager Server to test the integration. Script CP_Test1 tests
basic voice services (Give IVR). Script CP_Test2 tests advanced voice services
(ACCESS). Before using the test scripts, you must create test voice items using
CallPilot Application Builder and script variables in Contact Center Manager
Administration.

Configuration information

The following configuration information applies to the Give IVR and ACCESS
commands, and CallPilot configuration limits.

Give IVR voice services

On the switch, you must configure the following:

= an ACD-DN where IVR = YES and ALOG = YES

= agents in this ACD-DN with the following attributes:
s CLS=MMA and FLXA
m ASTonkeysOand1

In CallPilot, you must configure the following:

= a Service Directory Number (SDN) entry for the IVR ACD-DN. Set the
Application Name to Symposium Voice Services, and Media Type to Voice.

= an SDN entry for the Application Builder application. Set the Application
Name to equal the application name, as defined in Application Builder, and
Media Type to Voice.
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ACCESS voice services

On the switch, you must configure the following:

= an ACD-DN where IVR = YES and ALOG = YES

= agents in this ACD-DN with the following attributes:
» CLS=MMA and FLXA
m ASTonkeysOand1

In CallPilot, you must configure the following:

= a Service Directory Number (SDN) entry for the IVR ACD-DN. Set the
Application Name to Symposium Voice Services, and Media Type to Voice.

= an SDN entry for the Application Builder application. Set the Application
Name to equal the application name, as defined in Application Builder, and
Media Type to Voice.

= On Contact Center Manager Server, the Access Class ID configured in
Contact Center Manager Administration against the Voice Port should be
consistent with the Access Class ID associated with the port in CallPilot.

Notes:

= You can file Prompts as in Meridian Mail.

= CallPilot does not require unique SDN entries for voice prompts. You can
define voice prompts under one or more Application Builder applications.

CallPilot limits

Applications 2500 maximum (500 on drive D, 1000 on drive E, and
1000 on drive F)

Prompts per application 3000

SDN entries 1500 maximum (enforced)

Each entry requires a unique number, which does not
need to be a Meridian 1 PBX dialable number, if used
as a Treatment DN for Contact Center Manager
Server.

This also applies for Communication Server 1000.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 215



Testing integration Standard 6.0

To test basic voice services (Give IVR)

Before you use test script CP_Test1 to test the Give IVR command, you must do
the following:

Create an announcement application using CallPilot Application Builder,
and record a prompt.

Create an SDN numerical entry point to the application name.
Create the script variables in Contact Center Manager Administration.

Write a test script, or import the CP_Test1 script from
C:\Program Files\Nortel Networks\WClient\Server\SampleScripts.

Associate the script with the test CDN in the Master Script.
Activate the script.

After you complete these steps, you can test basic voice services.
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Creating an announcement

1 In CallPilot, launch Application Builder.

Result: Application Builder appears.

2  Click File > New.

Result: The New dialog box appears and lists the existing folders.

scce-test

FCCE 1001
file 1003
|2 file2 1004
: J closed_msg 1005
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In the File Name box, type a name for the application. (For CP_Test1, use
welcome.) This is the name that appears as an option in the Application
Name menu in the CallPilot Manager SDN table.

Result: The system assigns the next available Application ID. You can
change the ID by typing an ID that is not in use.

Click New.
Result: The application is created.

In Application Builder, click the Announcement Block in the pallet, and
then drag the block onto the drawing board.

Result: The Add Announcement Block dialog box appears.

Add Announcement Block

Enter block name: Iwelcome
Cancel |

Help |

In the Enter block name box, type a descriptive name for the
announcement. The name can be up to 30 characters.

Tip: Create a name based on what the message repeats to the caller. For
CP_Test1, name the welcome message welcome.
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7 Click OK.
Result: The new Announcement block appears on the Application Builder

drawing board.

% application Builder - call pilot - Toronte (CallPilot Server Yersion 02.01.26) - [welcome *] o [}
S Fle Edt View Options Define Window Help _l8) x|
HEE| glalalq) lmlE xE) <lE] @
—r |
- = oq
m -
Announcement  Cal Transfer Begin welcome .\ EREERESSEE
- =
- :
f.54]
= b} Start
Date Contral Day Contral
B B
Fax Select Fax Send
8
o
ad
Languags Select Menu
i 4
& -
Password Cheek  Thiu-Dial
Time Contral
Rotaty Transfer Attendant CannotTransfer Goodbye End
® P Feg| - Sueess|—gng al a
|— |- Dione -— |- Failed |- Done -——— |- Done f————— ‘
e ] = [C e T m [
Rotary Dial ARnouncement Caill Transfer Announcement Announcement End
‘ v
4
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8 Double-click the Announcement block.

Result: The Announcement property sheet appears, on which you can
define properties for the new announcement.

Announcement R _)_(]

Parameters i Outputs/Mates

&+ Play custom voice item

Custom Yoice ltem 6]

<new voice items _:] I Hew. .

" Play system prompt

Mumber of times to play |1 ﬁ I Pause before exiting

i~ Key handling option

[ Accept menu keys [1-9]
¥ Save ke far riest bloe

[ Accept attendant key (0]

[ Accept help key 7]

-

ok I Cancel I

i Help I

9 Click Play custom voice item, and then click New.
Result: The Add voice item dialog box appears.

10 In the Name box, type a name for the voice item. (For CP_Test1, use the
name welcome_msg.) The system assigns an ID.

11 In the Description box, type a description for the voice item.
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12 Click Done.

Result: The Edit voice item content dialog box appears.

Edit voice item content x|

The voice item haz been added. r'ou may now
record or impart the voice content.

If you da not wish to update the voice content at
thig time, press ‘0K

1~ Woice item identification

i Mame iwelcome_msg 1D I‘I

[~ Woice item content

[rescription

13 You can import an existing voice item or record a new voice item.
= To import an existing voice item, click Import.

Result: The Import voice item dialog box appears, in which you can locate
and select a .WAV file as a voice item.

m To record a new voice item, click Record.
Result: The Specify Phoneset dialog box appears.

Tip: If you want to record a new item, you must have the CallPilot Desktop
Player installed, or an error message appears. To get the CallPilot Desktop
Player, select Download Player from the right side of the main CallPilot
Manager menu.

14 Type the DN of the phone from which you want to record.
15 Click OK.

Result: The Application Builder Player dialog box appears.
16 Click Record (the red button).

Result: The phone rings.

17 Pick up the receiver, record the voice item after the tone, and then click
Stop.
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18

19
20
21

22

23

24

Click Play to review the recorded voice item. When you are satisfied, hang
up the phone.

Click Save.
Click Close.

In the Announcement property sheet (which is still open on your desktop),
in the Number of times to play box, select the number of times you want
the announcement to play.

Clear the Pause before exiting check box and all of the Key handling
option check boxes.

Announcement i _)_(]

Parameters l OutputsMates

& Play custom voice item

Custom Yoice ltem 16}

welcome_mag __'_| 11 Edit... |

" Play system prompt

r o

Mumber of times to play |1 ﬂ I Pause before exiing

i Key handling option
™ Accept menu keys [1-9]

¥ Save ke for Hest blosk
[ Accept attendant key (0]
™ Accept help key 7]
C

1] I Cancel Appli Help |

Click OK.
Result: The Announcement property sheet closes.

In the Application Builder drawing board, connect the Begin block to the
Announcement block, and connect the Announcement block to the End
block:

a. Click the tip of the Begin connector (it turns red). Then click the
Announcement block.

Result: A connection line appears from the Begin block to the
Announcement block.
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b. Click the Done box of the Announcement block.
c. Click the End block.

Result: A connection line appears from the Done box of the
Announcement block to the End block.

Note: When the connections are properly completed, the blocks turn

from pink to black, and you can save the application.

%’ application Builder - call pilot - Toronte (CallPilot Server Version 02.01.26) - [welcome *] —|of x|
S Fle Edt View Options Define Window Help _18] ]
izlal slelaja] [ -|5] x| <[] @]
—— E|
-~ = dq
m -
Announcement:  Cal Transfer Begin welcome
’ = ‘
- Done
= ' 3' Start Announcement
Date Control  Day Control
Fax Select Fax Send
8
o =
ad
Language Select  Menu
i 4
& -
Password Cheek  Thiu-Dial
Time Contral
Rotary Transfer Atendant CannatTransfer Goodbye End
® -~ 0 | rRuccessl-End -~ - ‘
prEse—- o — [ o - poris E ) m—
e ] =[S T m [
Retary Dial Announcement Call Transfer Announcement Announcement Endl
EEE]

25 Click Save and close Application Builder.

Creating an SDN numerical entry point

1 Inthe CallPilot Manager browser window, select System > Service
Directory Number.

Result: The Service Directory Number window appears.
2  Click New.
Result: The SDN Details window appears.
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3 Inthe Service DN box, type a numeric value for the SDN.

Note: This value is used as the Treatment DN in the Contact Center
Manager Server script.

4  From the Application name list, select the name of the application (for this
example, use the application name welcome). Leave all other fields at the
default settings.

Note: The Media Type must be defined as Voice.
5 Click Save.

Creating the script variables in Contact Center Manager

Administration

1 Goto Contact Center Manager Administration Launchpad > Scripting.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

@ ﬁ:n;agc:n(-:.:.?:er @ configuration

@ Access and Partition @j: Scripting
Management !

@ Real-Time Reporting @ Emergency Help

@ Historical Reporting @:: Outbound
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2  From the system tree, click the name of the server on which you want to
create the script variable.

Result: The server expands to reveal a series of folders.

NERTEL SCRIPTING

Status | Launchpad | Help
SR Glottawal
D Script Mansger
+ - [ Seript Variskles
D Application Thresholds

Scripting

» Click a server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading

= From the tree, select a script variable under the desired
server. Then, click Script Variable = Print to print the

vatiable

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 225



Testing integration Standard 6.0

Click the Script Variables folder.

Result: The Script Variables tree expands, listing all types of script
variables.

NERTEL SCRIPTING

Status | Launchpad | Help
=42 ottawa A
DScr\pt Manager
-1 [ Script Variskles
+-- (LI ACD L.
(CJ4GENT_ D Scripting
[ABOCLEAN
Cacon
Acue = Click a server name to log on to the server. Then, launch
[CIDaTE
[Capay the Script Manager, Script Variables, or Application
ggﬁY’OF’MONTH Thresholds by clicking each heading
[ons
[CANTEGER
[CALANGUAGE
Dvoc server. Then, click Script Variable = Print 1o print the
[CamonTH
Camusic variable.
Campa
CAMPaNKy
Canxx
[CAPRIORITY A

= From the tree, select a script variable under the desired

B I R 3~ I S SR I e I B S e SO 3

Tip: All existing variables on the selected server appear beneath the Script
Variables heading in the folder corresponding to the type of variable. If you
do not see the Script Variables heading on the system tree, your
administrator did not grant you access to this component of Scripting.
Contact your administrator and request access to Script Variables on the
selected server.

On the system tree, right-click on the variable type folder of the variable you
want to create and select New.

Tip: Doing this pre-populates the Type drop down box in the Attributes tab
with the relevant script variable type. You can also right click on the Script
Variables folder and select New to create a new variable. In this case, the
Type drop down box is pre-populated with the first script variable type which
is ACD. The user can change it to the variable type they want.

Below the table, click Script Variable Properties.
Result: The heading expands to reveal the General and Attribute tabs.

On the General tab, in the Name box, type the name of the new variable.
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7 Click the Call Variable option button if the variable is for one specific call
only; otherwise, click Global Variable to be able to use the variable in all
scripts.

8 Inthe Comment box, type any comments you want to save with the
variable.

9 Click the Attribute tab.

10 From the Type list, select the variable type, and then type the value or a
range of values for the variable type in the Value box.

Tip: Based on the variable type, you may be able to choose the class
assigned to the script variable. The class indicates if a script variable has a
single value (ltem), or a set of values (Set).

11 Select or enter the value or value range.
12 Click Add to save your data, if applicable.
13 Click Submit to save your data.

Result: The new variable appears in the system tree in the folder
corresponding to the variable type.

To import the test script

Next, you create a test script or import test script CP_Test2 provided by Contact
Center Manager Server. For more information about script CP_Test2, see
“CP_Test2” on page 245.

When you install Contact Center Manager Administration, the system
automatically installs the sample scripts in the following folder on the Contact
Center Manager Administration server:

C:\Program Files\Nortel Networks\WClient\Server\SampleScripts where C: is
the drive on which you installed Contact Center Manager Administration.

You can use these sample scripts in Contact Center Manager Administration by
importing them into either an existing script or a new script in the Scripting
component. The Import command adds the text of the imported sample script at
the end of any text in the current script.

For more information about scripts, see the Contact Center Manager Scripting
Guide for the Communication Server 1000/Meridian 1.
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Importing the test script

1 Go to Contact Center Manager Administration Launchpad > Scripting.

> CONTACT CENTER — MANAGER

G606 6

Contact Center
Management

Access and Partition
Management

Real-Time Reporting

Historical Reporting

>THIS IS NQRTEL.

Configuration
-
Scripting

Emergency Help

Qutbound

®©e66

2 Inthe system tree, click the server on which you want to view scripts. The
server expands to reveal a series of folders.

NERTEL SCRIPTING

S

=@

D Script Mansger
(O Seript varisbles

(1) #pplication Thresholds

Status | Launchpad | Help

Scripting

» Click a server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading

= From the tree, select a script variable under the desired
server. Then, click Script Variable = Print to print the

vatiable
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10

11
12
13

Click the Script Manager folder.

Result: The Script Manager appears in the right pane, listing all the scripts
on the currently selected server.

You can import a sample script into Contact Center Manager Administration
in one of two ways:

a. Toimport a sample script into an existing script, in the Script Manager,
double-click the script into which you want to import the sample script.
The script appears in the Script Editor.

b. To import a sample script into a new, blank script, right-click on the
Script Manager folder and select New from the resulting menu. The
Script Editor appears with a blank starting page.

In the Script Editor, click File > Import.
Result: The Import window appears.

Click the From Server option button, and then navigate to the location on
the server where the sample scripts are stored.

Select the sample script that you want to import.
Click OK.

Result: The system adds the text of the sample script to the end of the
current script, or to the place at which you put your cursor before importing
the script.

To save the script, click File > Save.
Result: Confirmation dialog box appears.
Click Yes to confirm saving the script to the server.

Result: If you import into a new script, the New Script Name dialog box
appears.

Enter a name for the new script.
Click OK.
Close the Script Editor window.

Result: Script appears in Script Manager window in the list of scripts.
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Testing the Give IVR application

To complete the test of Give IVR, do the following:

1

a H WO DN

Validate and activate the test script. (See “Making sure the correct script is
activated” on page 272.)

Associate the script with the test CDN in the Master Script.
Activate the Master Script. (See “Master Script” on page 243.)
Call the test CDN.

Verify that you hear the test message.

If you do not hear the test message, verify that the configuration is correct.
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To test advanced voice services (ACCESS)

Before using test script CP_Test2 to test the ACCESS command, complete the
following:

= Create an application using CallPilot Application Builder. See “Defining
ACCESS voice prompts” on page 232

= Create new applications (folders) to hold the voice prompts used for Open
Voice Session and Give Controlled Broadcast Announcement.

= Record the prompts in Server Utility. See “Configuring voice prompts” on
page 162.

m  Create the script variables in Contact Center Manager Administration.
“Defining voice segment variables” on page 235.

m  Write a test script, or import the CP_Test2 script from
C:\Program Files\Nortel Networks\WClient\Server\SampleScripts.

m  Associate the script with the test CDN in the Master Script. See “Testing
the ACCESS application” on page 239.

= Activate the test script.

After you complete these steps, you can test advanced voice services.
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Defining ACCESS voice prompts

In CallPilot, launch Application Builder.

Result: Application Builder appears.

Dy Conbed

Fax Salect Fax Send

Theudisl

Click File > New.

Result: The New dialog box appears and lists the existing applications
(folders).

In the File name box, enter a unique name for the application. (For
CP_Test2, use sccs_prompts.)

Tip: The system assigns the next available Application ID. You can change
the ID by typing an ID that is not in use.

Click New.
Result: The application is created.

On the Application Builder drawing board, click the tip of the BEGIN
connector.

Result: The connector turns red.
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6 Click the END block.
Result: A line is drawn from the BEGIN block to the END block. All of the

lines turn black.

S Fle Edt View Options Define Window Help

% application Builder - call pilot - Toronto (CallPilot Server Version 02.01.26) - [file1]

=laix
=181

wlelal slalalal fsle] xs] <(0] @

e sy

-

By

Announcement:

N

Date Control

[
d

|

Fax Selex

le®
LI |4

Language Select

ot

Password Check

d

Time Contral

i o

all Transfer

3

Day Control

ey

=)

Thi-

Begin

Start

Rotery

- - ;|
e m| - |

Rotary Disl

EEE]

Transter

Annourcement

Aftendant

Cail Transter

- Success | —End
il

Failed
=

CannetTransfer

Annourcement

Goodbye

Announicement

e a—
- Done |- Daore.

End

End

7 Click Save.

8 Click Define > Voice ltems.

Result: The Define voice items dialog box appears.
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9 To add a voice item, click Add.

Result: The Add voice item window appears.

Add voice item

T Woice item identification

|
| |
i M ame iclnsed o] i1 i

Dezcription

Thank vou for caling. Somy we are curently :_]
clazed our hours of operation are Monday thru
Friday from 9&M to 5PM. Flease call back ther|

Done I Cancel I Help |

10 In the Name box, type a name for the voice item (for this example, type
closed_messsage_vs).

Result: The system assigns an ID number.
11 In the Description box, type a description of the voice item.
12 Click Done.

Result: The Edit voice item content dialog box appears.

13 You can record or import voice content for each voice item as you define it,
or you can continue defining all of the voice items, and then record or
import the voice content later.

To record the content for a voice item, click Record and follow the same
steps you used in the Give IVR procedure, starting at step 13 on page 221.

14 After you finish recording or importing the voice item, click Done.

15 Repeat the procedure for adding and recording a voice item, starting at
step 8 on page 233. For this example, add and record voice item
hold_option_vs.

16 In Application Builder, click Save and close Application Builder.
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Voice segment variables
Store all voice prompts in voice segment variables. Follow these rules when you
name your script variables:

= Script variable names must be unigue. Names cannot be the same as any
script language keywords or intrinsics.

= Names can contain up to 30 characters, must begin with an alphabetic
character, and cannot contain spaces.

m  Valid characters for script variable names are A-Z, a-z, 0-9, and _
(underscore). Use an underscore in place of a space.

Defining voice segment variables

1 Go to Contact Center Manager Administration Launchpad > Scripting.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁgztaagc:nf:mer Configuration

Logout
Access and Partition Scripting
Management

Real-Time Reporting Emergency Help

®©e66

Historical Reporting Outbound

G606 6
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2 Inthe system tree, click the server on which you want to view scripts. The
server expands to reveal a series of folders.

NERTEL SCRIPTING

Status | Launchpad | Help
SR Glottawal
D Script Mansger
+ - [ Seript Variskles
D Application Thresholds

Scripting

» Click a server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading

= From the tree, select a script variable under the desired
server. Then, click Script Variable = Print to print the

vatiable

3 Click the Script Variables folder.

Result: The Script Variables tree expands, listing all types of script
variables.

NEIRTEL SCRIPTING

Status | Launchpad | Help
=--(E) ottawa ~
(C) Script Manager
] DScr\pt Warisbles
#--[Jaco L.
CIAGENT I Scripting
[aBocLESN
Cacon
Jcup = Click a server name to log on to the server. Then, launch
o g
DATE
[apay the Script Manager, Script Variables, or Application
EESY_OF_MONTH Thresholds by clicking each heading.
ons
CANTEGER
[IL&NGUAGE

@voc server. Then, click Script Variable = Print to print the

= From the tree, select a script variable under the desired

[music vatiable

o e (] (] - (- - [ -

[CAPRICRITY ~
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4  Right-click on the VOICE_SEGMENT folder and select New.
Result: Script Variables window appears.

5 Below the table, click Script Variable Properties.
Result: The heading expands to reveal the General and Attribute tabs.
On the General tab, in the Name box, type the name of the new variable.

Click the Call Variable option button if the variable is for one specific call
only; otherwise, click Global Variable to be able to use the variable in all
scripts.

8 Inthe Comment box, type any comments you want to save with the
variable.

9 Click the Attribute tab.

10 From the Language list, select a language.

w ScriptVariable Properties

General Attribute |

Type: | YOICE_SEGMENT v Language:

| French "
German
English
Chinese
Spanish
Portuguese
Japanese

# | [

Add

: -
.
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11 Type in a value in the format <filename>:<segment number>.

Tip: This corresponds to the file you created in Voice Prompt Editor. See
“Configuring voice prompts” on page 162.

w Script Yariahle Properties

General Attribute |

Tome: [VOICE_SEGMENT = | Language: | French =l

“alle: |aj'rlh:1\
<filename=:<segi= (e.g. VM _Prompt:111)

List of Yalues:

¥ [French aith:1
*I | Remaove I
| i3
Submit

12 Click Add to add it to your list of values.

13 Click Submit to save your data. The new variable appears in the system
tree in the folder corresponding to the variable type.
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Testing the ACCESS application
1 From the menu, select Launchpad > Scripting.
2  On the system tree, double-click the appropriate server.

Result: The server expands to reveal its resources.

NERTEL SCRIPTING

Status | Launchpad | Help
(L) Seript Manager
(] Script Yariskles
D Application Thresholds

Scripting

e Click & server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading.

» Frorm the tree, select a script variable under the desired
server. Then, click Script Variable > Print to print the

variable.

3  Click the Script Manager folder.

Result: The Script Manager window appears, listing all the existing scripts.
4  Double-click the appropriate script.

Result: The script appears in the Script Editor window.

5 Ensure that the script is in Active state. If the script is not active, click File >
Activate.

Result: A message box appears, asking you to confirm your choice.
6 Click OK.

Result: The system activates the script. The script’s status changes to
Active when the activation process finished successfully.
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7  While in Script Manager, select Master_Script.

NERTEL SCRIPTING

%) monaca

2-(Z) ottawa c
(1 5cript Managsr
£ (L seript variables Name Type Status Mode: Lasth
(] pplication Thresholds c_Basic Secondary Edited User Defined 4412006 25242 Pt
c_Pasic_Backup_Skilsst | Sscondary Editel User Dsfined 4412006 25415 P
c_Emergency_Boolean | Sscondary Editel User Dsfined 41412006 2:56:57 Pt
c_Emergency_Skilset_Chec|Sscondary Editel User Dsfined 47412006 3:00:35 1
c_Excess_Cal_volume_Giv | Sscondary Editel User Dsfined 47412006 3:0206 P
c_Expected_Watt_Message |Sscondary Editel User Dsfined 4412006 3:04:26
c_Forced_Announcement | Sscondary Editel User Dsfined 4412006 31212 M
c_Holiday_Broadcast_Anno|Sscondary Editel User Dsfined 4412006 31910 Pt
C_Master_Handlss_Mutiimec Sscondary Editel User Dsfined 4412006 236:49 Pt
c_Priority_n_cusue_DNIS | Sscondary Editel User Dsfined 4412006 319:54 Pt
C_Gueue_Mutlimedia_Conta Sscondary Editel User Dsfined 4412006 2.41:33 P
C_Scheduled_Contact_Hane Sscondary Editel User Dsfined 4412006 2:48:04 Pt
EM_Email_Primary Secondary Editecl User Dsfined 4412006 2:46:29 Pt
hetwork_Seript hetwork Active User Dsfined 4362006 32243 P
*

8 Ensure that the Master Script is in the Active state. If the script is not active,
click File > Activate.

Result: A message box appears, asking you to confirm your choice.
9 Click OK.

Result: The system activates the script. The script’s status changes to
Active when the activation process finished successfully.

10 Go to File > Use voice segment.

Tip: This is the voice segment created previously. See “Defining voice
segment variables” on page 235.
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11 Associate the script with the test CDN in the Master Script.

2 Master_Script - Web Scripts Editor - Microsoft Internet Explorer

NERTEL

File | Edit | View

4 = (@-oﬂnwa
Bdmaster_Script

Ohject Browser Script Commands

gy mBoc@ad

SCRIPTING

1 /% Title: Master Seript */
GIVE RINGBACK
3/
{ROUTE CALL DEFAULT DN
i
i
flif cdn=2222 then
‘open voice session
play prompt voicesegment abo

l0/end if

12 Call the test CDN.

13 Verify that you hear the test message. If you do not hear the test message,
verify that the configuration is correct.
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Test scripts

The following information explains how prompts and applications are
referenced in the test scripts:

When you create an Application Builder application, you define a file name
or application name. Application Builder assigns an application ID for the
application and a segment ID for each segment flow that you create in your
application.

In Contact Center Manager Administration scripts, when you want to
access a voice segment (over an Contact Center Manager Administration
ACCESS port), you use a global variable. The value of the variable must be
application-name:segment-ID, as defined in Application Builder. (In
CallPilot, the application name is the same as the file name when using
Meridian Mail and Voice Prompts. The application name is case-sensitive.)

For the Contact Center Manager Administration IVR port, you reference
the Application Builder application (either directly or through a global
variable) using a treatment number. This treatment number must
correspond to a CallPilot Service DN (SDN) entry that you defined on
CallPilot. The CallPilot SDN links to the Application Builder application
that you created. You can define the SDN to be the same as the Application
ID assigned by Application Builder as long as there is ho numbering
conflict.
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Sample scripts

The following section includes sample scripts.

Master Script

/* Add the test CDN to the existing MASTER SCRIPT. To test
Basic Voice Services using the Give IVR command, use
CP_Testl. To test advanced voice services using the Open
Voice Session and Controlled Broadcast Announcements, use
CP_Test2. All configuration must be complete on Meridian 1
PBX (Same for CS 1000), callpilot, and Contact Center
Manager Administration before testing. Variables must be
created and Scripts must be imported, saved, and validated.
Then, add the commands below to the Master Script and

activate.

Variable name |Class Type Value Comment

test_cdn Global CDN XKXXX CDN wvalue used
for testing

*/

/* Tests the Give IVR functionality, use CP_Test2 to test
advanced voice services */

IF CDN = test_cdn THEN
EXECUTE SCRIPT CP_Testl

END IF
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CP_Test1

/* This simple script tests the Give IVR command using
CallPilot. For the Contact Center Manager Administration
IVR port you reference the Application Builder application
(either directly or through a global variable) using a
treatment number that corresponds to a CallPilot SDN
service-DN entry that you defined on CallPilot. The
CallPilot service-DN links in the Application Builder
application that you created. By convention you define the
service-DN to be the same as the Application ID assigned by
Application Builder (just for consistency). Assign a test
agent to the default skillset and log the agent in. At the
Give IVR command, you should hear the IVR speak a simple
welcome greeting and then be queued to the default
skillset. Answer the call.

Variable name |Class Type Value Comment

ivr_qgueue Global ACD XXXX Symposium Voice
Services DN in
CallPilot

(dedicated ACD-
DN for Give IVR)

welcome_msg Global Treatment |xxxx Announcement/
DN voice menu DN in
CallPilot SDN
table
*/

GIVE IVR ivr_qgueue WITH TREATMENT welcome_msg
QUEUE TO SKILLSET Default_Skillset

WAIT 2

QUIT
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CP_Test2

/* If the desired skillset has no agents logged in, the
caller receives a closed broadcast message and is
disconnected. If the skillset is staffed, the caller is
queued to the default skillset. After the call has waited
for 20 seconds, the caller is asked to press 1 if the caller
wants to keep on holding. If the caller selects 1, the
caller remains queued, otherwise the caller is
disconnected. Make sure that the default gqueue is set to
the Symposium Voice Services DN in CallPilot (dedicated
ACDN for ACCESS). To access a voice segment (over a Contact
Center Manager Server ACCESS Port), you do it through a
global voice segment variable that has as its value the
application-name:segment-ID, as defined in Application
Builder.

*/

Global Variable List:

Variable name Class Type Value Comment

access_gueue Global |ACD XXXX Symposium
Voice Services
DN in
Callpilot
(dedicated
ACD-DN for
ACCESS)

closed_message_vs |Global |Voice Application-
segment name:voice
item-ID needs
to be created
and recorded
in CallPilot

hold_option_vs Global |Voice Application-
segment name:voice
item-ID needs
to be created
and recorded
in CallPilot
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Variable name

Class

Type

Value

Comment

hold_choice_cv

Call

DN

*/

IF OUT OF SERVICE Default_Skillset THEN

GIVE CONTROLLED BROADCAST ANNOUNCEMENT

PLAY PROMPT VOICE SEGMENT closed_message_vs

DISCONNECT
END IF

QUEUE TO SKILLSET Default_Skillset

WAIT 2 /* Allow time in case an agent is available */

SECTION WaitLoop
WAIT 20

OPEN VOICE SESSION
PLAY PROMPT VOICE SEGMENT hold_option_vs
COLLECT 1 DIGITS INTO hold_choice_cv

END VOICE SESSION

IF hold choice_

Cv =

EXECUTE WaitLoop

ELSE
DISCONNECT
END IF

1 THEN
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Supported phones

This section describes the phones supported with Contact Center Manager. For
more information, see the Partner Information Center publications
(www.nortel.com/pic).

ATTENTION Agents assigned multimedia capabilities must log onto a

phone through the Communication Control Toolkit. These
agents cannot manually log onto a phone.

Contact center phones

Nortel recommends that you use phones that are designed specifically for
contact centers. These are specifically:

= M3905: Call Center Telephone

s M2216: ACD Digital Telephone

Communication Server 1000 or Meridian 1 PBX ACD phones

Contact Center Manager Server also supports all phones that can be configured
for use with Communication Server 1000 or Meridian 1 PBX ACD. These
include:
= Meridian modular telephones (MMT)

s M2216

= M2616
m  M39xx series telephones

= M3904

= M3905
= IP phones and Softphones

= IP Phone 2004

= |P Phone 2002

= |IP Phone 1120E
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= |P Phone 1140E
= |P Phone 1150E
= |IP Softphone 2050

These phones are not designed for a contact center environment and some
contact center features are not available for use.

Support of specific types of phones can change with each software release of the
call server (CS 1000). Consult the CS 1000 documentation for an up-to-date list
of supported phone types for the software release in use.

The Wireless 22xx series phones are not supported with Contact Center
Manager, but have limited ACD functionality. Refer to Wireless 22xx series
Phone documentation.
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Display Waiting Calls key/lamp

Contact Center Manager supports the Display Waiting Calls (DWC) key. This
feature lists skillset information when the DWC key on an agent’s phone is
pressed.

Contact Center Manager does not support the Directory Log feature.

ATTENTION The information displayed is different from the DWC

feature used in the Communication Server 1000 or
Meridian 1 PBX ACD environments.

Agent phone display

The following information is displayed on a Contact Center Manager agent’s
phone (the DWC agent) when the agent presses the DWC key:

AAA BBB CCC, where:

= AAA s the sum of the number of calls waiting in each skillset, to which the
DWC agent is currently logged on. A call is counted more than once if it is
gueued to more than one of the skillsets to which the DWC agent is logged
on.

If a call is queued to a specific agent ID (using the Queue to Agent
statement in the Contact Center Manager Server scripts), it is not included
in the number of calls waiting for the DWC agent. Only calls waiting in the
skillsets to which the DWC agent is logged on are reflected.

= BBB is the sum of the number of agents logged on to each skillset to which
the DWC agent is currently logged on. An agent is counted more than once
if logged on to more than one of the skillsets to which the DWC agent is
logged on.

m  CCC is the waiting time, in seconds, of the oldest call in all of the skillsets
to which the DWC agent is logged on.
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Supervisor phone display

The DWC key and associated lamp configured on a supervisor’s phone do not
support the display of any Contact Center Manager skillset information. If you
press the DWC key on a supervisor’s phone, it shows ACD gueue information
for that supervisor, as it currently does. The lamp also responds to ACD queue
loading and activity for that supervisor, as determined by the switch
configuration. Calls are not normally queued to ACD queues for Contact Center
Manager; therefore, the primary uses of this feature for Contact Center Manager
supervisors are when the contact center is handling Network ACD calls or
operating in default mode, and the switch ACD features are routing the calls.

Skillset information

Skillset information display is only available on phones that have numeric
display capabilities. Phones without numeric displays cannot get skillset
information by any other means (such as audible tones).

Display format

The information on the set is displayed with spaces between the fields. For the
phone set display of type 1 x 12, the data is displayed in three digits. For phone
displays larger than 1 x 12, the data is displayed in four digits. The maximum
displayable number of calls in queue is 9999, and the maximum number of
agents that Contact Center Manager currently supports is 40. The maximum
displayable amount of time that a call can be in queue is 9999 seconds or 2.78
hours. The following table summarizes the display types and field width for
phones that display DWC key information.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 251



Agent phones

Standard 6.0

DWC key phone display type and field width

Display type AAA BBB CCC

1x12 3 digits 3 digits 3 digits
1x16 4 digits 4 digits 4 digits
1 x40 4 digits 4 digits 4 digits
2 x24 4 digits 4 digits 4 digits

Sample phone displays

The displays illustrated in this section indicate the lengths and positions of the

various fields for each supported display configuration.

Notes:

No more than four digits are displayed per field.
n illustrates the full width of a field.
Leading zeros display as blanks.
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1 x 12 character displays

1 2 3 4 5 6 7 8 9 10 11 12

1 x 16 character displays

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 x 40 character displays

12 3 456 7 8 9 10 11 12 13 14 15 16 — 39 40

2 x 24 character displays

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 — 24

DWC examples for agent phones

Consider the following diagram with two agents logged on to two skillsets.
Three calls are queued to the two skillsets.
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Call 1 (waiting 45 seconds) -,
SkillsetA [, Agent 1
Call 2 (waiting 60 seconds) “
SkillsetB |« Agent 2
Call 3 (waiting 20 seconds) ]

The following display results when Agent 1 presses the DWC key:

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 --- 24

1WA I TI|N|G M|A N D L (WA I |T

2 1 2 4 |5

The following display results when Agent 2 presses the DWC key:

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 ..- 24

1WA|I | TI|N| G M|A N D L (WA I |T
2 4 3 6 |0

DWC key lamp

The DWC key lamp on a Contact Center Manager agent phone does not respond
to calls in skillsets; it always remains dark as far as skillset loading and activity
are concerned. However, the lamp continues to respond to the call loading and
activity in any ACD queues that the agent is logged on to, as determined by the
configuration on the switch. Calls are not normally queued to ACD queues for
Contact Center Manager; therefore, the primary use of this feature for agents is
when the contact center handles Network ACD calls or operates in default mode,
and the switch ACD features route the calls. When the agent presses the DWC
key, the agent phone display shows Contact Center Manager skillset information
as detailed in “DWC examples for agent phones,” on page 253.
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Unsupported phone keys

The following section describes unsupported phone keys.

ACD Waiting Calls key/lamp

The ACD Waiting Calls (AWC) key/lamp is not supported in Contact Center
Manager to indicate skillset information. Any AWC key/lamp defined on an
agent’s or supervisor’s phone indicates information on the ACD-DN for the

phone, as configured on the switch.

Other unsupported agent phone keys

Contact Center Manager does not support the following keys or report on them:
= Hotline

= Private line

= \oice call

= Dial Intercom
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Supported modifications on an acquired
phone

Although all the modifications listed in this chapter are supported on acquired
sets, there are minor consequences associated with some. Modifications are
grouped per consequence. The modifications are applicable to all phone types
unless otherwise stated.

CAUTION

& Risk of lost calls
It is assumed that any maintenance work performed on agent sets
of the Contact Center Manager system is performed outside of
office hours. Validate and test the changes prior to an agent
logging back on. Any maintenance undertaken during office hours
can result in calls lost or misdirected and ultimately abandoned,

causing a potential loss of revenue for the business.

No effect on agent status

M3900 firmware download (only affects M3904, M3905, M3904+KBA,
M3905+KBA)—No effect on agent status. Note that if the agent is idle before a
firmware download, an incoming call can be presented to the agent. As the set is
non-functional during firmware download, the call is not answered. Therefore,
Nortel recommends either log the agent off prior to a firmware upgrade or
perform the upgrade outside office hours.

ACD queue changes (IVR queue changes)—An IVR queue change is specific
to an ACD queue profile in Contact Center Manager, it has no effect on the
agent status. The Contact Center Manager Administrator needs to add the IVR
gueue to the Contact Center Manager database accordingly. ACD changes to
default queues do not effect the agent status, for example, modifying MAXP,
NCFW, and so on. Changing the default ACD-DN for an acquired CDN has no
effect on the agent status.
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Changes to resources acquired by CTI applications such as Call Monitoring
applications (does not apply to Analog 500 set)—Changes to AST (Associate
Set Assignment) made with TAPI 3.0 for Meridian. If you add a key to AST, you
must restart TAPI; if you remove a key, there is no issue.

Agent must log back on after modification

Any parameter modification that is done with LD 10, 11, 20, 84, and 85 causes
the set to be logged off and, therefore, the agent must log on again after the
modification. Following is a list of modifications that trigger a log off:

s CLID changes—If the change is to LDN_Data in LD 15 there is no effect
on the agents.

= DES (Designation) changes (LD84 for analog sets; LD 85 for digital)—A
DES change for the i2004 and i2050 sets can only be made in LD 20.

MPLR18387 is required on Succession 3.0 and earlier to prevent a
mismatch in state between Contact Center Manager Server and the switch.
This service update is included in the latest Contact Center Manager
Deplist.

m  Agent Supervisor (SPID) changes

m  Adding or deleting key features such as Auto Dial and Hunting
Allowed (HTA)

= Name change (digital sets)
= Key changes
m  Class of Service changes

m  Change or add AST (Associate Set Assignment) and IAPG (ISDN/AP
status message group) due to addition of a person to the performance
recording tool-ETalk.

Need to reacquire the line (agent/supervisor TN) after modification

The Telephony/Port Address line, associated with an agent or supervisor, is
deacquired as a result of the following modifications and the Contact Center
Manager administrator must reacquire the line after the modification is made.
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Agent queue changes (moving agents between queues)

A change in ACD queue causes the line (agent/supervisor TN) to become
deacquired in Contact Center Manager. If using ECHG to change agent
positions between queues, assign the ACD key a null value and then add with
the new ACD queue in another change pass. The administrator must still
deacquire the set, make the change, and reacquire the set.

Change only the position ID on a set

When attempting to change the position 1D of a set, an error SCH6683 is
encountered. You cannot change the position ID while this agent is acquired.
Therefore, the line must be deacquired in Contact Center Manager before
making the modification.

Name change (analog sets)

When attempting to make a change to the DN key of an analog set (500) the
following message is encountered: “SCH5039 — Already configured with
AGTA.” The set can only be defined as a single appearance DN. The
administrator must remove the ACD association of the set to make the name
change, and then reapply the ACD functionality of the set. The removal of the
ACD functionality of the set causes the line to be deacquired in Contact Center
Manager.

Name changes can also be made with LD 95, which does not affect the state of
the sets—the agents remain logged on and acquired in the case of analog and
digital sets.
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Create a new TN in Contact Center Manager

The Contact Center Manager administrator must create a new TN in Contact
Center Manager.

MOV/OUT

When attempting to MOV/OUT an acquired line, the error SCH1509 Cannot
MOV/OUT acquired TN is encountered. The TN (Terminal Number) must be
deacquired in Contact Center Manager before the MOV/OUT operation can
proceed.

The administrator must delete the item from the phone section and then create a
new item for the new TN. The new TN must be acquired before the agent logs
on.

Nortel does not support the use of the CPY command in LD 10 or LD 11 on
ACD agents.
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Overview

This section provides information about how and where to check for the status
of the various configuration elements and parameters mentioned in the
checklists.

For detailed information about how to configure the elements in each of the
subsystems used with the switch, MLS, and voice processing for use with
Contact Center Manager Administration, see Chapter 2, “Configuration
overview.”
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To Run Meridian Link traces

Contact Center Manager provides a tool for saving Meridian Link messages into

a text file. You can use this tracing tool to debug problems with a third-party

application using MLS.

The executable for the tool is called ml_trace.exe and is in the
NORTEL\ICCM\bin directory.

Enabling message tracing

1
2

From the Windows Start menu, select Command prompt.
At the command prompt, type
c:\Nortel\iccm\bin\ml_trace.exe

where c is the location of the Nortel directory.

Result: The ICCM Meridian Link Services Manager Trace Tool window
appears.

Click Configuration, and then select Trace.
Result: A dialog box appears.

From the dialog box, select the association ID of the application or
applications to be traced.

Click On.
Click Activate.
Click Done.

Result: The dialog box disappears.

Disabling message tracing

1
2

From the Windows Start menu, select Command prompt.
At the command prompt, type

c:\Nortel\iccm\bin\ml_trace.exe
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where c is the location of the Nortel directory.

Result: The ICCM Meridian Link Services Manager Trace Tool window
appears.

3 Click Configuration, and then select Trace.
Result: A dialog box appears.

4  From the dialog box, select the association ID of the application or
applications.

Click Off.
Click Done.

Result: The dialog box disappears.

To view the trace file

View the file MLSMTraceFile.txt in the NorteNICCM\bin directory.

264 Contact Center Manager



February 2007 Troubleshooting

Subsystem link problems

The following section describes possible solutions to subsystem link problems.

Making sure the server is up

1  On the Contact Center Manager Server: In the SMonW utility, all
components must have the status UP.

2  On the switch: ELAN subnet connection to the switch is functioning (see
the following section for detailed instructions).

3  On the Contact Center Manager Administration: You can successfully
log on to the Contact Center Manager Administration server.

Checking the ELAN subnet connection between the server and switch

1 On the switch, in LD 48, use the following command:
stat ELAN

2 The status for the ELAN subnet connected to the server must be ACTIVE
EMPTY and APPL ACTIVE. (If there are multiple ELAN subnets, match the
IP addresses.)

Example
>1d 48
LNKOOO
.stat elan
SERVER TASK: ENABLED
ELAN #: 16
APPL_IP ID: 47.166.111.14
LYR7: ACTIVE EMPTY APPL ACTIVE
ELAN #: 17
APPL_IP ID: 47.166.111.13
LYR7: ACTIVE EMPTY APPL ACTIVE

Checking the CSL connection between the switch and Meridian Mail

1 On the switch, in LD 48, use the following command:

stat AML
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2 The status for the link number connected to Meridian Mail must be ACTIVE
EMPTY.

Example:

1d 48

LNKOOO

.stat aml

AML: 07 MSDL: 07 PORT: 03 DES: mail
LYR2: EST AUTO: ON LYR7: ACTIVE EMPTY

Checking the ACCESS Link between the Contact Center Manager
Server and Meridian Mail

1 In Meridian Mail, log on as tools (using the password configured for your
system). Then navigate through the following menus:

a. 130ther
b. 2ACCESS Diagnostics

2 LinkStatus for the link to the server must be Synchronized.
Example

Links Description Location TKMstat TCstat LinkStatus

1 ACCESS 1-6-1 Running Running  Synchronized

Checking the ACCESS Link between the Contact Center Manager
Server and CallPilot

1  CallPilot: From System Utilities > Support Tools > CallPilot Processing
Utilities > Trace Viewer <nbtview>, in Trace Control, select:

a. MLink_Trace for messages on MLink
b. NBAPE for messages on ACCESS Link

2  Contact Center Manager Server: From Start > Run, enter tsm_oam, and
then select option 3.
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For VSM and MLSM session traces:
From the OAM menu, select option 2, and then enter 0 at the prompt.

Note the Session ID for VSM_Service and MLink SP (CallPilot
Application). Press Return to go back to the OAM menu.

Select option 5, enter the Session ID, and then respond to the prompts
as appropriate.

For AML trace:

From the OAM menu, select option 7.
From the AML Trace menu, select option 4.
For Access Protocol trace:

From the OAM menu, select option 9. Select option 3 to enable the
trace.

For Access Protocol Debug trace:

From the OAM menu, select option 10. Select option 3 to enable the
trace.

Checking the switch loop, shelves, and cards

1

On the switch, in LD 32, use the following command:
stat nl n2 n3

where n1 is the loop, n2 is the shelf, and n3 is the card that contains either
agents or voice ports.

The status for real agents must be LOG IN or LOG OUT, depending on the
state of the agent.

The status for Meridian Mail or CallPilot voice ports must always be LOG
IN. If it is not, disable and enable the port on Meridian Mail or CallPilot to
trigger the auto-logon.

Example:
Loop

1d 32

NPROOO

.stat 24

SUPER LOOP

000 DSBL 038 BUSY
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Example:

Real agents (2500 set agents)

.stat 24 0 O

00 = UNIT 00 =
01 = UNIT 01 =
02 = UNIT 02 =
03 = UNIT 03 =
04 = UNIT 04 =
05 = UNIT 05 =
06 = UNIT 06 =
07 = UNIT 07 =
08 = UNIT 08 =
09 = UNIT 09 =
10 = UNIT 10 =
11 = UNIT 11 =
12 = UNIT 12 =
13 = UNIT 13 =
14 = UNIT 14 =
15 = UNIT 15 =

Example:
Voice Ports (SL1

.stat 4 0 3

00 = UNIT 00 =
01 = UNIT 01 =
02 = UNIT 02 =
03 = UNIT 03 =
04 = UNIT 04 =
05 = UNIT 05 =
06 = UNIT 06 =
07 = UNIT 07 =

IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE

sets)

IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE
IDLE

LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG

LOG
LOG
LOG
LOG
LOG
LOG
LOG
LOG

IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN
IN

IN
IN
IN
IN
IN
IN
IN
IN

Making sure Meridian Mail ports are enabled

1

— o e e e e e e e e e e e e

—~— e~ e o~

In Meridian Mail, navigate through the following menus:

a. System Status and Maintenance
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b. DSP Port Status

The status for the ports must be one of the following:

Idle m if the ports are acquired by the TN only from the

server

Active m if the ports are acquired by the TN and the channel by

the server
m if the ports are busy on a call

m if the ports are acquired by another ACCESS
application

Making sure CallPilot ports are enabled

1 On the CallPilot client, navigate to CallPilot Manager.

2  Select Channel Monitor link. Channels are in Idle state.

Location = Maintenance  Channel Manitor
Channel Monitor
Stanl Courtesy Stop Stop | Help
Refresh Rate
Delay between updates: |5 7| seconds

Channel Status

a1 Select Al |2 3 4 |5 B

r? sotoo iiiiiiyi

Legend
\_‘Actwe 1 dle L In Test

Loading | Mo Resources | g Nat Configured i Remots {
A Off Duty | g Remote Off Duty

T “ellow) Alarm IACCESS Channel
!A Digabled L Shutting Down 1 Uninitialized i Local (Red) Alarm

Start: | Courtesy Stop Stop | Help

IR Channel

Copyright @ 2003 Hortel Netnods Corparation and its licensors. All rights resenred.

On this screen, ACCESS channels are blue, and Give IVR channels are
green.
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Making sure the CDN is acquired

Go to Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration

-LD out
Access and Partition Scripting E
Management

Real-Time Reporting Emergency Help

©666

Qutbound

666 6

Historical Reporting

Standard 6.0

Select CDN (Route Points). The CDN status must be Acquired.
On the switch: In LD 23, use the following commands:

= REQ PRT

= TYPE CDN

Result: The following values appear on the printout:

= AACQ=YES

m  ASID = ELAN connected to Contact Center Manager Server
m CNTL=VYES

Example:

>1d 23

ACDO0O0O

MEM AVAIL: (U/P): 3591770 USED: 405925 TOT:
3997695

DISK RECS AVAIL: 2682

ACD DNS AVAIL: 23758 USED: 242 TOT: 24000
REQ prt

TYPE cdn
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CUST O

CDN 2003

TYPE CDN

cusT 0

CDN 2003

FRRT

SRRT

FROA NO

MURT

DFDN 7700

CEIL 2047

OVFL NO

TDNS NO

RPRT YES

AACQ YES

ASID 16

SFNB 1 2 3 4 5 6 9 10 11 12 13 15 16
17 18 19

UsFB1 2 3 4 5 6 7 9 10 11 12 13 14 15
caLeo 1 2 3 4 5 6 7 8 9 11
CNTL YES

VSID

HSID

CWTH 1

BYTH O

OVTH 2047

STIO

TSFT 20
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Making sure the correct script is activated

1  Go to Contact Center Manager Administration Launchpad > Scripting

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration

-LD out
Access and Partition Scripting E
Management

Real-Time Reporting Emergency Help

666 6
©666

Historical Reporting Outbound

2 On the system tree, click the server containing the script that you want to
activate.

3 The server expands to reveal a series of folders.

NERTEL SCRIPTING

Status | Launchpad | Help
SR clJottaws:
s Seript Manager
(O Seript varisbles
D Application Thresholds

Scripting

» Click a server name to log on to the server. Then, launch
the Script Manager, Script Variables, or Application

Thresholds by clicking each heading

= From the tree, select a script variable under the desired
server. Then, click Script Variable = Print to print the

vatiable
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4  Click the Script Manager folder.

Result: The Script Manager window appears, listing all the existing scripts.
5 Double-click the appropriate script.

Result: Script appears in the Script Editor window.

Ensure that the script is in Active state.

If the script is not active, click File > Activate.

Result: A message box appears, asking you to confirm your choice.
8 Click OK.

Result: The system activates the script. The script’s status changes to
Active when the activation process finished successfully.

Making sure that the IVR ACD-DN is acquired

1 Goto Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

ﬁ:n;agc:nf:;ter Configuration Audit Trail

-LU out
Access and Partition Scripting .
Management

Real-Time Reporting Emergency Help

666 6
@666

Historical Reporting Outbound

2  Select IVR ACD-DN. The IVR ACD-DN status must be Acquired.
3  On the switch: In LD 23, use the following commands:
= REQPRT

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 273



Troubleshooting Standard 6.0

s TYPE ACD

Result: The following values appear on the printout:

= AACQ=YES

m  ASID = ELAN connected to Contact Center Manager Server
s IVR=YES

m  TRDN = default treatment DN, if any

Example:

14 23

ACDO0OO0O

MEM AVAIL: (U/P): 3591770 USED: 405925 TOT:
3997695

DISK RECS AVAIL: 2682

ACD DNS AVAIL: 23758 USED: 242 TOT: 24000
REQ prt

TYPE acd

CUSsT 0

ACDN 7725

TYPE ACD

CUST 0

ACDN 7725

MWC YES

IMS YES

CMS YES

IMA YES

IVMS YES

EES NO

VSID 7

MAXP 48

SDNB NO

BSCW NO

AACQ YES

ASID 16

SFNB 1 2 3 4 5 6 9 10 11 12 13 15 16
17 18 19

UsFkB1 2 3 4 5 6 7 9 10 11 12 13 14 15
cALBO 1 2 3 4 5 6 7 8 9 11
ALOG YES

RGAI NO

ACAA NO

FRRT
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CCBA NO

IVR YES
TRDN 3600
CWNT NONE

Making sure Give IVR voice ports are acquired by the TN

1 Go to Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁ‘:gt:gc:nf:me' Configuration

-Lo out
Access and Partition Scripting 2
Management

Real-Time Reporting Emergency Help

Quthound

Historical Reporting
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Select Phonesets and Voice Ports. The voice port status must be
Acquired Login.

NERTEL CONFIGURATION

Server | Download

[+ Carling

[ o i

: E f::;:;f; sandpiper Phonesets/Voice Ports
/) Heiniken

[+ Kilkenny

(=102 sandpiper Mame Type Address Channel VR Mame
(L0 Activity Codes p |4-0-0-0-0 Agert 4-0-0-0
[ Call Presentstion Classes T Supervisar 4-0-0-2
(L3 CON= (Route Points) 4-0-0-3 Agent 4.0-0-3
[Z0 Contact Types 7-0-0-0 Vaice Part 7-0-0-0 3100 (3100)
[ [el(=23 7-0-0-1 ‘Yoice Port 7-0-01 3100 (3100)
[CIFormuias 710 aics Part 7-0-0-10 3200 (3200)
([0 Globsl Settings 711 ‘Yoice Port 7-0-0-11 3200 (3200)
[ Historical Statistics 712 ‘oice Port 7-0-0-12 3200 (3200)
[CA™R ACD-DNs 70-0-2 ‘/oics Part 7-0-0-2 3200 (3200)
D Metwiorking Communication Parame 7-0-0-3 ‘oice Port 7-0-0-3 3200 (3200)
(it s il Vaice Part 7-0-0-4 3200 (3200)
[LdPhoneset Displays 75 ‘Yoice Port 7-0-0-5 3200 (3200)
(I Real-time Stetistics 75 aics Part 7-0-0-6 3200 (3200)
[[Routes 77 ‘Yoice Port 7-0-0-7 3200 (3200)
(L skilsets 78 ‘oice Port 7-0-0-8 3200 (3200)
([0 Threshold Classes 79 aice Part 7-0-0-9 3200 (3200)

[#1-{i=)) SMITHWICKS *

[+ (20 tequila

In CallPilot: On the CallPilot client, in the CallPilot Manager, select
Channel Monitor link. Make sure that the Give IVR (green) channels are in
Idle state.

In Meridian Mail: Navigate through the following menus:

m 5System Status and Maintenance

= 3DSP Port Status

Make sure that the status for the ports is Idle.

On the switch: In LD 20, use the following commands:

REQ TNB

for Meridian Mail with all switches except Meridian 1 PBX PBX 11:
TYPE SL1

for CallPilot and for Meridian Mail with Meridian 1 PBX PBX 11:
TYPE 2008

Result: The following values appear on the printout:
ACQAS=TN
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Example: (Meridian Mail)

1d 20

PT0000

REQ:

TYPE:

TN
DATE
PAGE
DES

DES
TN
TYPE
CDEN
CUST
KLS
FDN
TGAR
LDN
NCOS
PLEV
SPID
AST
IAPG
AACS
ACQ
ASID
SFNB
17
SFRB
USFB
CALB
FCTB
ITNA
DGRP
PRI

18

prt
tnb
4 030

MAIL

004 0 03 00
SL1

DD

0

1

1
NO
0

02
NONE

YES

AS:

16

1 2 3 4 5 6 9
19

TN

10 11

1 2 3 4 5 6 7 9 10 11

o 1 2 3 4 5 6 7 8

NO

01

MLWU_LANG 0

DNDR
KEY

0

00 ACD 7725 0
AGN

01 SCN 4500 O

02 MSB

03 NRD

4550

MARP

12 13 15 16

12 13 14 15
9 11
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04
05
06 TRN
07 AO3
08
09 RLS

Example: (CallPilot and Contact Center Manager Server)

DES CLPLT
TN 024 1 13 26
TYPE 2008
CDEN 8D
CTYP XDLC
CUST O

FDN

TGAR 1

LDN NO
NCOS 3
RNPG 0

SCI O

SSU

XLST

SCPW

CLS CDT
CPND_LANG ENG
HUNT

SPID NONE
AST 00 01
IAPG O
AACS YES

ACQ AS: TN,AST-DN,AST-POSID

ASID 16

SFNB 1 2 3 4 5 6 11 12 13 18 22

SFRB

USFB 1 2 3 4 5 6 7 9 10 11 12 13 14 15

CALB 0 1 2 3 4 5 6
FCTB

ITNA NO

DGRP

PRI 01

DNDR O

DTMK

KEY 00 ACD 5990 0 5356
AGN

01 SCN 5386 0 MARP

CPND

8 9 10 11 12
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NAME CallPilot
XPLN 27
DISPLAY_ FMT FIRST,LAST
02 MSB
03 NRD
04 TRN
05 AO03
06
07

Making sure ACCESS voice ports are acquired by the TN and CallPilot
class ID or channel

1 Go to Contact Center Manager Administration Launchpad >
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration

-LD out
Access and Partition Scripting E
Management

Real-Time Reporting Emergency Help

666 6
©666

Historical Reporting Outbound
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2  Select Phonesets and Voice Ports. The voice port status must be
Acquired Login.

NERTEL CONFIGURATION

Server | Download

[+ Carling

[ o i

s E f::;:;f; sandpiper Phonesets/Voice Ports

/) Heiniken
Kilkenny

=12 sandpiper Mame Type Address Channel VR Mame
(L0 Activity Codes p |4-0-0-0-0 Agert 4-0-0-0
[ Call Presentstion Classes T Supervisar 4-0-0-2
(L3 CON= (Route Points) 4-0-0-3 Agent 4.0-0-3
[COContact Types 7-0-0-0 ‘Voice Part 7-0-0-0 3100 (3100)
[ [el(=23 7-0-0-1 ‘Yoice Port 7-0-01 3100 (3100)
[CaFarmuas 710 ‘oice Part 7-0-0-10 3200 (3200)
([0 Globsl Settings 711 ‘Yoice Port 7-0-0-11 3200 (3200)
[ Historical Statistics 712 ‘oice Port 7-0-0-12 3200 (3200)
[CA™R ACD-DNs 70-0-2 ‘/oics Part 7-0-0-2 3200 (3200)
D Metvworking Communication Pararmed 7-0-0-3 ‘Yoice Port 7-0-0-3 3200 (3200)
(I s 74 ‘Voice Part 7-0-0-4 3200 (3200)
[LdPhoneset Displays 75 ‘Yoice Port 7-0-0-5 3200 (3200)
[[DRealtime Statistics 76 ‘oice Part 7-0-0-6 3200 (3200)
[[Routes 77 ‘Yoice Port 7-0-0-7 3200 (3200)
(L skilsets 78 ‘oice Port 7-0-0-8 3200 (3200)
([0 Threshold Classes 79 aice Part 7-0-0-9 3200 (3200)

[#-{Z) SMITHWICKS *

# % tequila

3 In CallPilot: On the CallPilot client, in the CallPilot Manager, select
Channel Monitor link. Make sure that the ACCESS (blue) channels are in
Idle state.

4  In Meridian Mail: Navigate through the following menus:
m 5System Status and Maintenance
= 3DSP Port Status
Make sure the voice ports are in Active state.

5 On the switch: In LD 20, use the following commands:

= REQTNB

= for Meridian Mail with all switches except Meridian 1 PBX PBX 11:
TYPE SL1

m for CallPilot and for Meridian Mail with Meridian 1 PBX PBX 11:
TYPE 2008

Result: The following values appear on the printout:
m ACQAS=TN
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m  ASID = ELAN connected to Contact Center Manager Server

Example: See the examples in “Making sure Give IVR voice ports are
acquired by the TN” on page 275.

Verifying that the system default Treatment DN is configured correctly

In Contact Center Manager Administration Launchpad > Configuration,
ensure that the default treatment DN specified in the Global Settings window is
set appropriately.

Making sure treatment DNs are defined in the CallPilot SDN table

In CallPilot, check the SDN table. (From the Configuration Manager, choose
System > Service Directory Number.)

The table must contain an entry for each treatment DN, in which the Application
Name is the name of the application created in Application Builder.

Making sure treatment DNs are defined in the Meridian Mail VSDN
table

See page 171 for a discussion about how treatment DNs are used with Meridian
Mail.
1 In Meridian Mail, navigate through the following menus:

= 3 Voice Administration

m 4 Voice Services Administration

= 1 Voice Service-DN Table

2  Verify that the treatment DN is defined here as the appropriate service. The
following example shows the service defined as an Announcement (AS)

service.
Example:
DN Service Comment
3600 AS 2020 Call Center - Manager

announcement

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 281



Troubleshooting Standard 6.0

DN Service Comment

5555 AS 2021 Call Center - Manager
announcement

6666 ACC ACCESS service

3 Navigate through the following menus:
= 3 Voice Administration
m 4 Voice Services Administration
= 3 Announcement Definitions

4  Verify that the service number displayed in the Voice Service DN table is
defined as an announcement.

Example:
D Title
2020 hello
2021 default

Making sure IVR ACD-DNs match on the switch, Contact Center
Manager Administration, and voice-processing system

The ACD-DNs must match in the following locations:

= Channel Information page in CallPilot Manager

= Meridian Mail CAT

= switch DN

= Contact Center Manager Administration script

= IVR ACD-DNs window in Contact Center Manager Administration
1 To verify that they match, follow these steps:

a. In CallPilot: In CallPilot Manager, choose System > Service
Directory Number. Check the value specified in the Service DN field.
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Location = System * Semice Directory Number

Service Directory Number

Service Directory Mumber

N Delete Selected | Refresh List |ﬂ|
# [ |service DM App Matne Media Type hin Channels |Max Channels  |Comments
1 [ 4604 Symposium Yoice Senices  [Voice ) Default Max. |Symposium ACCESS channels
2 [T 4800 “oice Messaging Woice ] Default bfax.
2| [T 4802 CBC Main Menu “oice 0 Default Max. |[CBC Main menu
4 [T 4805 Express Yoice Messaging Woice 0 Default Max. Express messaging english
5 [7 4810 Speech Activated Messaging |Speech Recognition |0 Default bax. TH 100006
o [ 4811 Custom Commands Speech Recognition |0 Default Max. |Custom command TN 10000 7
7 [T 4850 Multimedia Messaging Fax ] Default bfax.
3 [ 4851 oice Messaging Fax 0 Diefault bax.

b. In Meridian Mail: Navigate through the following menus:
m 5 System Status and Maintenance

m 4 Channel Allocation Table

Example:
# CDP TN ACN-DN SCN Type Capability
21 2-1-1 004-0-03-00 4604 4500 VWoice FULL Basic ACC

Class: 41

c. On the switch: In LD 22, use the following command:

REQ DNB
Example:

1d 22
PT2000
REQ prt
TYPE dnb
CUsT 0

DN 4604
DATE

PAGE

DES

DN 4604
TYPE MCDN
MCID 4500 TN 004 0 03 00

d. On Contact Center Manager Administration:
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m  The script command specifies the DN defined in the CallPilot SDN table
or the Meridian Mail Channel Allocation table:

Give Controlled Broadcast 4604

= In Contact Center Manager Administration Launchpad >
Configuration > IVR ACD-DNs, the IVR ACD-DN number matches the
ACD-DN defined on the switch and in the CallPilot SDN table or the
Meridian Mail Channel Allocation table. The status for the IVR ACD-DN
must be Acquired.

Note: In CallPilot, make sure that you configured the ACCESS IVR ACD-
DN in the Service DN table on the CallPilot Manager. In Meridian Mail,
make sure that you configured the ACCESS IVR ACD-DN in the VSDN
table.

Making sure voice port TNs match on the switch, Contact Center
Manager Administration, and CallPilot or Meridian Mail

The configuration of the TNs belonging to the ACD-DN (see previous section)
must match in the following locations:

Channel Information page in the CallPilot Manager

Meridian Mail CAT

switch DN

IVR ACD-DN acquired by Contact Center Manager Administration

To verify that they match, follow these steps:

1

In CallPilot: Choose Configuration Wizard > CallPilot Manager >
Channel Information. Check the value in the TN column.

Example:

STl Board 200i Board ID 67731456

Link STI07-001
#|Channel Mame TH KeyD Kewl Channel Allocation Clazs D
1|2TI01-001-001 G.0.0.0 4300 4400 Multimedia
2|STI0M-001-002 6.0.0.1 4301 4401 Multirnedia
3|STI01-001-003 0.0.0.2 4302 4402 ultimedia
AETI01-001-004 6.0.03 4303 4403 Multimedia
5| STI01-001-005 5.0.0.4 4304 4404 Multirnedia
6| 2TI01-001-006 8.0.0.5 4305 4405 Multimedia
7|STI01-001-007 5.0.0.6 4306 4406 Access 1
3| 2TI01-001-008 G.00.7 4307 4407 Access 2

al@Tine AR oo
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2 In Meridian Mail: Navigate through the following menus:
m 5 System Status and Maintenance
m 4 Channel Allocation Table
Example:
# CDP TN ACN-DN SCN Type Capability
21 2-1-1 004-0-03-00 7725 4500 Woice FULL Basic ACC
Class: 41
3  On the switch: In LD 22, use the following command:
REQ DNB
Example:
1d 22
PT2000
REQ prt
TYPE dnb
CUST 0
DN 7725
DATE
PAGE
DES
DN 7725
TYPE MCDN
MCID 4500 TN 004 0 03 00
MCID 4501 TN 004 0 03 01
4  On Contact Center Manager Administration: Go to Contact Center
Manager Administration > Phonesets and Voice Ports. The Channel
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column for the voice port contains a unique number. The voice port status
is Acquired Login.

NERTEL CONFIGURATION

Server | Download
[# -2 Carling
[#-{iZ) guinness

(50 haywards sandpiper PhonesetsfVoice Ports

) Heiniken

Kilkenny

=12 sandpiper Mame Type Address Channel VR Mame
(L0 Activity Codes p |4-0-0-0-0 Agert 4-0-0-0
[ Call Presentstion Classes T Supervisar 4-0-0-2
(L3 CON= (Route Points) 4-0-0-3 Agent 4.0-0-3
[COContact Types 7-0-0-0 ‘Voice Part 7-0-0-0 3100 (3100)
[ [el(=23 7-0-0-1 ‘Yoice Port 7-0-01 3100 (3100)
[CaFarmuas 710 ‘oice Part 7-0-0-10 3200 (3200)
([0 Globsl Settings 711 ‘Yoice Port 7-0-0-11 3200 (3200)
[ Historical Statistics 712 ‘oice Port 7-0-0-12 3200 (3200)
[CA™R ACD-DNs 70-0-2 ‘/oics Part 7-0-0-2 3200 (3200)
D Metwiorking Communication Parame 7-0-0-3 ‘oice Port 7-0-0-3 3200 (3200)
(I s 74 ‘Voice Part 7-0-0-4 3200 (3200)
[LdPhoneset Displays 75 ‘Yoice Port 7-0-0-5 3200 (3200)
[[DRealtime Statistics 76 ‘oice Part 7-0-0-6 3200 (3200)
[[Routes 77 ‘Yoice Port 7-0-0-7 3200 (3200)
(3 Skitsets 75 Voice Port 7008 3200 (3200)
([0 Threshold Classes 79 aice Part 7-0-0-9 3200 (3200)

[#1-{i=)) SMITHWICKS *

[+ (20 tequila

Making sure channels for ACCESS voice ports match on the server
and CallPilot or Meridian Mail

The channel number (the number shown in the Class ID column in the CallPilot
Channel Monitor or after the Class keyword in the Meridian Mail CAT) for a
specific TN must match the channel number for the same TN in the Voice Ports
window on Contact Center Manager Administration.

1 In CallPilot: Choose Configuration Wizard > CallPilot Manager >
Channel Information. Check the value in the Class ID column.

STl Board 200i ‘ Board ID 67731456

Link STI01-001
#|Channel Mame ¥ ™ keyd Key1 Channel Allocation Class ID
1|2TI01-001-001 6.0.00 4300 4400 Multimedia
2|STI01-001-002 5.0.0.1 4301 4401 Multirnedia
3|2TI01-001-003 §.0.0.2 4302 4402 Multimedia
4 STI0N-001-004 5.0.0.3 4303 4403 Multirnedia
5|2TI01-001-005 0.0.0.4 4304 4404 Multimedia
5| STI01-001-008 5.0.0.5 4305 4405 Multirnedia
7|STI01-001-007 0.0.0.6 4306 4406 Access 1
#|2TI01-001-003 6007 4307 4407 Access 2
oleTin nnt nna

2  In Meridian Mail: Navigate through the following menus:
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m 5 System Status and Maintenance

= 4 Channel Allocation Table

Example:
# CDP TN ACN-DN SCN Type Capability
21 2-1-1 004-0-03-00 7725 4500 Woice FULL Basic ACC

Class: 41

3 On Contact Center Manager Administration: Go to Contact Center
Manager Administration > Phonesets and Voice Ports. Ensure that
each TN has a unique number in the Channel column. Ensure that the
voice port status is Acquired Login.
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CallPilot problems

Use the following checklist to troubleshoot configuration problems with

CallPilot.

Subsystem

Description

ELAN subnet

Switch All VSIDs have SECU YES (see “To configure the
ELAN subnet” on page 73).

MLS

CallPilot Nortel server subnet IP address is configured correctly
on the Switch Information page (see “To update
CallPilot configuration” on page 146).

Switch Voice ports are configured with AST (Associated Set
Assignment) on key 0 and key 1 (see “Creating a
CallPilot voice port with LD 11” on page 100).

ACCESS link

Contact Center
Manager
Server

The connection to CallPilot is configured correctly on
the Voice Connection page of the Server Setup
Configuration utility (see “To configure voice
connections” on page 181).

ACCESS ACD-DNs

CallPilot

The ACD-DN is configured in the SDN table with
Application Name as Symposium Voice Services and
Media Type as Voice (see “To update the SDN table”
on page 147).
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Contact Center
Manager
Administration

The ACCESS ACD-DN is specified as Default IVR
Access DN and Default Access Treatment DN in
Global Settings (see “To configure Global settings” on
page 199).

Switch The ACD-DN is configured with IVR YES and ALOG
YES (see “Creating a CallPilot ACD-DN in LD 23” on
page 97).

ACCESS channels

CallPilot The channel has a Class ID. The TN assigned to the

channel matches the TN on the switch.

Contact Center
Manager
Administration

The channel defined for the voice port equals the class
ID assigned to the channel in CallPilot (see “To
configure voice ports on the server” on page 196). The
TN assigned to the channel matches the TN on the
switch.

Switch

\oice ports are configured with AST 00 01 and CLS
MMA FLXA (see “Creating a CallPilot voice port with
LD 11” on page 100).

Give IVR ACD-

DNs

CallPilot

The ACD-DN is configured in the SDN table with
Application Name as Symposium Voice Services and
Media Type as Voice (see “To update the SDN table”
on page 147).

Switch

The ACD-DN is configured with IVR YES and ALOG
YES (see “Creating a CallPilot ACD-DN in LD 23” on
page 97).

Give IVR channels

CallPilot

The TN assigned to the channel matches the TN on the
switch.
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Contact Center | The TN assigned to the channel matches the TN on the

Manager switch.
Server
Switch \oice ports are configured with AST 00 01 and CLS

MMA FLXA (see “Creating a CallPilot voice port with
LD 11” on page 100).
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Voice port problems

The following section describes possible solutions for voice port problems.

Voice ports become deacquired

To deacquire is to release an acquired switch resource from the control of the
Contact Center.

Note: To avoid this problem, assign new IVR ACD-DNs to Contact Center
Manager Administration.

This problem can occur if Contact Center Manager Server shares ACCESS
voice ports (voice ports acquired as both a TN and channel) with other
applications. If non-Contact Center Manager Server calls terminate on ACCESS
voice ports used by Contact Center Manager Server, those voice ports can
become deacquired. To troubleshoot the problem, perform the checks in the
following list.

Checking for non-Contact Center Manager Server calls

1  Examine the following to see if they direct incoming calls to the ACD-DN
owning the voice ports:

m switch IDC tables

= switch trunk auto-terminate destinations

m switch ACD-DN Night Call Forward destinations

m switch set Call Forward (No Answer, Busy, and All Calls) destinations
m switch Controlled Directory Number (CDN) Default DN destinations

m  Customer Controlled Routing (CCR) scripts

= Meridian Link applications

2 Examine Contact Center Manager Server scripts and look for Give IVR
commands that direct calls to an ACD-DN set up for Give Controlled
Broadcast Announcement and Open Voice Session.
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m If you use Meridian Mail Call Path Diagnostics (CPD), you may receive
error events indicating that calls arriving on voice ports are not under the
control of Contact Center Manager Server.

m To determine the cause of non-Contact Center Manager Server calls
that arrive at a voice port, see Contact Center Manager Server error
events. Use the originating DN and ACD-DN of the call for this purpose.

Channel number field in the Voice Ports window appears dimmed

The configuration guidelines recommend that the voice ports must be acquired
by the TN, and they are currently acquired by the TN and the channel. When you
double-click to delete the channel number, you cannot delete it because the field
appears dimmed. The same problem applies when voice ports are acquired by a
TN, and they must be changed to be acquired by the TN and channel.

You cannot change the acquire status (TN or TN-and-channel) while the port is
acquired.

1 If you must change the configuration, first deacquire the port. See
“Deacquiring a voice port,” on page 332.

2  Double-click the port to change the configuration (now the field is open to
be edited).

3 Reacquire the port. See “Acquiring a voice port,” on page 343.

Voice ports are Remote Out-Of-Service in CallPilot

To correct this problem, on the switch, verify that the voice ports are configured
with AST (Associated Set Assignment) on key 0 and key 1 (see “Creating a
CallPilot voice port with LD 11” on page 100).
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Call treatment problems

The following section describes possible solutions to call treatment problems.

Script skips over voice-processing commands

When the script is executed, it ignores the voice-processing commands and
continues to complete after the voice-processing commands.

1

For the Give IVR script command, verify the following:
a. The IVR ACD-DN is configured and successfully acquired.
b. The IVR ACD-DN is configured on the switch with IVR = YES.

c. Voice ports for that IVR ACD-DN are logged on and idle (check the
switch and CallPilot or Meridian Mail).

For the Give Controlled Broadcast Announcement and Open Voice Session
script commands, verify the following:

a. The IVR ACD-DN is configured and acquired.
b. Phones and voice ports are configured and acquired.
c. For Symposium Voice Services on CallPilot:

m Voice items and variables are valid and recorded.

= In CallPilot, on the Channel Monitor page, the ACCESS voice ports
are idle.

d. For Symposium Voice Services on Meridian Mail:

m The Meridian Mail mailbox and password are configured and match
the Contact Center Manager Administration global settings
configuration (check the password by changing it to VM class of
service, and dial in to the mailbox directly).

= Voice segment numbers and variables are valid and recorded.

m The DSP Port Status menu in Meridian Mail shows the channels in
use by Contact Center Manager Administration in the Active state
(this means that Meridian Mail registers that they are acquired).

e. The switch shows the TNs used as voice channels to be logged on and
idle.
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f. The ACCESS link is up.

Calls are suspended in the script at the voice-processing command

Scripts advance to the voice-processing commands, but never continue beyond
that. They remain there until the caller disconnects or an agent (if the call was
previously queued) answers the call.

For the Give IVR script command, ensure that the TNs used as voice ports are
acquired by Contact Center Manager Administration.

Voice-processing commands do not execute consistently

When using the Give Controlled Broadcast Announcement or Open Voice
Session script commands, some callers hear the prompts, and others do not.

1  To resolve this problem, perform these tasks:

a. Ensure that the switch and Contact Center Manager Administration
configurations match exactly: the TNs configured for the IVR ACD-DN
on the switch must be the same as the voice ports configured in
Contact Center Manager Administration > Configuration. There should
be no extra TNs. If extra TNs exist, disable them on CallPilot or
Meridian Mail, or move them to a different ACD-DN on the switch and
CallPilot or Meridian Mail.

b. Check whether non-Contact Center Manager Server calls arrive at this
IVR ACD-DN. For more information, see “Voice port problems” on page
291.
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Callers hear ringing, but the call is not answered

This problem occurs if the call is not routed to CallPilot, or if the call is routed to
CallPilot, but CallPilot does not answer.

Calls are not routed to CallPilot

If calls are not routed to CallPilot, follow these steps:

1

In Contact Center Manager Server, check the Services Monitor to
determine whether the Meridian Link Services Manager (MLSM) is running.
If it is running, continue with the next step. If it is not running, use the
Windows Services control panel to restart it. If it does not start, restart the
server.

Make sure that ACCESS is operational on both Contact Center Manager
Server and CallPilot.

a. In Contact Center Manager Server, look for event 40305, “The
ACCESS Link is up.” A subsequent event 40309, “ACCESS Link time-
out,” indicates a problem with the link.

b. In CallPilot, look for event 60921, “ACCESS link is up.” A subsequent
event 60920, “ACCESS link is down,” indicates a problem with the link.

If there is a problem with the ACCESS link, check the configuration on the
switch, CallPilot, and Contact Center Manager Server (see “Subsystem link
problems” on page 265). After making the required changes, restart the
VSM service from the Windows Services control panel on the server in
Contact Center Manager Server.

If ACCESS is operational on both servers, MLS may not be running on the
CallPilot server. Restart the CallPilot server.

CallPilot is not answering

If calls are routed to CallPilot, but CallPilot is not responding, follow these steps:

1

Check the CallPilot SDN table to verify that it contains an SDN for
Symposium Voice Services (see “To update the SDN table” on page 147).

Check the voice port status in CallPilot. If it is Remote Out-of-Service, the
voice ports are configured incorrectly on the switch. Make sure that voice
ports are configured with AST (Associated Set Assignment) on key 0 and
key 1 (see “Creating a CallPilot voice port with LD 11” on page 100).
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Callers wait too long to hear voice processing

The caller hears too many cycles of ringback before the message is played.

1

Call does n

For the Give IVR and Open Voice Session script commands, ensure that
there are enough voice ports available for the traffic.

For Give Controlled Broadcast Announcement in start/stop mode, ensure
that the Broadcast Wait Timer setting on the server is not too long. The
default setting is 10 seconds; when a single call is made, the software waits
10 seconds before connecting the call to a voice port for the
announcement.

ot receive voice treatment

The script executes the voice-processing commands, but callers are not
connected to the appropriate voice port.

1

To resolve this problem, perform these steps:

a. In Contact Center Manager Administration > Configuration, make sure
that the ACD-DN is configured and acquired.

b. Make sure all voice ports that are members of this ACD-DN are
configured appropriately on the switch, in Contact Center Manager
Administration > Configuration, and in CallPilot. Make sure that the TNs
and ACD-DN are the same in all three subsystems. Make sure that the
position ID defined on the switch matches key 0, as defined in CallPilot,
and that the SCN DN defined on the switch matches key 1, as defined
in CallPilot.

c. In Contact Center Manager Administration > Configuration, make sure
that the voice ports are acquired.

For ACCESS voice ports, make sure that the Voice Port Channel defined in
Contact Center Manager Administration > Configuration matches the
CallPilot class ID.

Callers hear silence instead of voice-processing treatments

The

script executes the voice-processing commands, but callers hear only

silence instead of the prompts and announcements specified in the script. This
problem occurs if there is no application running on the voice port.
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1 For the Give IVR script commands, ensure that the following elements are

in place:

a. The announcement on CallPilot or Meridian Mail indicated by the
treatment DN exists and is recorded.

b. The voice port where the call is acquired is in Idle state in CallPilot or
Meridian Mail.

c. The voice port is in Acquired Login state in Contact Center Manager

Administration.

2  Forthe Give Controlled Broadcast Announcement and Open Voice Session
script commands, ensure that the following elements are in place:

a.

In CallPilot, on the Channel Monitor page, the ACCESS voice ports are
idle, not active.

In Meridian Mail, the DSP Port Status menu shows the channels in the
Active state.

There are no extra TNs on the switch side in the same ACD-DN as the
channels acquired by Contact Center Manager Server.

The IVR ACD-DN used is the correct one, and the correct ports belong
to that ACD-DN on the switch and CallPilot or Meridian Mail.

The ACCESS link is up.

In CallPilot, on the Channel Monitor page, ensure that the ACCESS
voice ports are idle, not active.

In Meridian Mail, the DSP Port Status menu shows the channels in use
by Contact Center Manager Server in the Active state (this means that
Meridian Mail registers that they are acquired).

Callers hear a message different from the voice-processing treatment
specified in the script

Callers hear a message different from the one indicated by the voice-processing
command.

1  For the Give IVR script command, verify the following:

a.

b.

The treatment and recording on CallPilot or Meridian Mail indicated by
the treatment DN contains the correct recording.

In CallPilot, the default treatment DN on the switch is listed in the SDN
table.
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¢. In Meridian Mail, if the script statement contains no treatment DN,
check the switch default treatment DN and the treatment that is
mapped to the Meridian Mail VSDN table (and what is recorded for
that).

For the Give Controlled Broadcast Announcement and Open Voice Session
script commands, ensure that the mapping of the Contact Center Manager
Server voice segment variables (the file names and segment numbers in
their values) to those recorded on CallPilot or Meridian Mail is correct.

a. In CallPilot, check the file and voice items on Application Builder.

b. In Meridian Mail, you can use the Voice Prompt Editor to play the voice
segments.

Callers hear only one of multiple voice-processing treatments
specified in the script

At first, callers hear the correct voice-processing treatment. Then, after some
traffic, the script seems to skip the script statements and no longer executes the
voice-processing commands.

1

For the Give IVR script command, ensure that no ACCESS application
(Contact Center Manager Server or otherwise) is trying to acquire the TNs
(on CallPilot or Meridian Mail) used as voice ports by Contact Center
Manager Server.

For the Give Controlled Broadcast Announcement and Open Voice Session
script commands, ensure that no non-ACCESS calls end at the voice ports
used by Contact Center Manager Server.

These can come either from a different script using the Give IVR script
statement to route calls to the same IVR ACD-DN, or through non-Contact
Center Manager Server call routing (trunk auto-termination, call transfer
scenarios, call forward scenarios, Meridian Link, or CCR applications).

Callers hear broadcast announcement too many times

The script statement specifies a broadcast announcement to be repeated
X number of times, and the caller hears it between x and 2x times.
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For the Give Controlled Broadcast Announcement (continuous mode) script
command, calls are connected as soon as they arrive. Callers continue to listen to
the announcement until one full cycle of the message is played. With small
periods of silence at the start and end of the announcement, as well as the small
time frame between the time that a call is connected to a port and when it starts
hearing the announcement, the application software calculates that the call did
not hear the announcement all the way through on the first cycle. The human ear,
however, may sense that it heard the cycle. The software plays another cycle of
the message before continuing the script.

If the script commands specify multiple repeats of the announcement (for
example, four repeats), the caller can hear up to eight messages (or partial
messages) as each script command imposes the calculation in the proceeding
paragraph.

Callers hear “Your voice session cannot be completed” message

The caller hears the message “Your Voice Session cannot be completed” instead
of the prompts specified in the script.
1 Verify the following:

a. The ACCESS link is up.

b. In Meridian Mail, the Mailbox specified on Contact Center Manager
Administration is the correct one. (In CallPilot, you can have any input.)

c. In Meridian Mail, the Mailbox password on Contact Center Manager
Administration is correct and did not expire. (In CallPilot, you can have
any input.)

d. The voice segment requested exists (is recorded).

e. The voice ports are acquired correctly (and all of the ports in the
IVR ACD-DN are acquired).

Voice prompts do not play

If CallPilot comes up before Meridian Link Services Manager (MLSM) is
running, all Give IVR and ACCESS channels remain in Uninitialized state. To
avoid this problem, always start Contact Center Manager Server before
CallPilot.
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To ensure that CallPilot always starts after Contact Center Manager Server, even
if both servers are powered up at the same time, defer the CallPilot bootup by
five minutes by making the following change to the Windows settings on the
CallPilot server:

1 From the Windows control panel, open System.
2  Click the Startup/Shutdown tab.
3 Inthe System Startup box, set Show list for to 300 seconds.

Caller hears voice prompts but is never presented to an agent

This problem occurs if a transfer fails after a Give VR command used with a
third-party voice-processing system.

If the Give IVR script command is used with a third-party IVVR application or a
CallPilot or Meridian Mail voice menu to transfer a call to a DN that is busy,
Contact Center Manager Server loses control of the call. When using Give IVR,
always transfer the call to an ACD-DN.
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Other problems

The following section describes possible solutions to other problems.

Contact Center Manager Server and the switch do not communicate

If Contact Center Manager Server and the switch are not exchanging
information, the network traffic volume over the ELAN subnet may be
excessive. You must ensure that the network is designed to support the number
of devices installed on the ELAN subnet. For information about proper network
design, see the Contact Center Planning and Engineering Guide.

Contact Center Manager Server calls are not presented to agents

When agents become idle, they are presented with ACD calls rather than with
waiting Contact Center Manager Server calls.

If an ACD call is waiting when an agent becomes idle, the switch ACD software
routes the ACD call to the agent, and the switch notifies Contact Center
Manager Server that the agent is available. By the time that Contact Center
Manager Server receives the notification, the agent is already handling the ACD
call, and is no longer available to handle the skillset call.

To prevent this problem, do not use the ACD-DN for customer calls.

Notes:

m  If there are no ACD calls waiting when the agent becomes idle, a Contact
Center Manager Server call is presented.

= This problem does not occur with NACD calls. When an agent finishes
handling an NACD call, the switch provides a small time window to allow
a Contact Center Manager Server call to be presented. If no Contact Center
Manager Server call is available, the switch presents the next NACD call.
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Network call-by-call reports display inaccurate timestamps

In a contact center with multiple sites using the Network Skilled-Based Routing
(NSBR) feature, all switches are synchronized with identical timestamps. If the
network call-by-call reports from your site indicate a reporting inaccuracy, the
timestamp for your local switch may be out of synchronization with the switches
at other sites.

Check the timestamp of your local switch at the beginning of each shift. This
ensures that network call-by-call reports reflect the accurate time.

Ensuring the timestamp is accurate

1 Log on to the switch console.
Open a Command Prompt and type Id 2, and then press Enter.
Type ttad at the prompt, and then press Enter.

Result: The current date and time appear in the format DD-MM-YYYY
00:00.

4 To change the date and time, follow these steps:

a. Type stad.
b. Enter the correct date and time.

5 Log off the switch console.
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Frequently asked questions

The following is a list of frequently asked questions about voice-processing
operation.

What is the difference between the Play Prompt statement on the Give
Controlled Broadcast Announcement and the Open/End Open Voice
Session commands?

There are three differences:

1. The Give Controlled Broadcast Announcement play prompt has a
continuous option, which is not applicable to the Open/End Voice Session
command.

2. The Open/End Voice Session play prompt has a no-type-ahead option,
which is not applicable to the Give Controlled Broadcast Announcement
command.

3. The start/stop timer for starting the announcement applies only to broadcast
operation. When the Open/End Voice Session command is used, every call
is connected to its own voice port and the message starts immediately.

Other than the exceptions in the previous list, the statements’ syntax is the same
and they operate in the same way.

Which voice-processing commands use treatment DNs, and what are
they used for?
See “To configure VSDN entries (treatment DNs)” on page 171, which explains
how treatment DNs are used and determined.

What is the difference between using an initial IVR to Symposium and
Symposium Voice Services?

Using an initial IVR means incoming calls from the trunks are directly
terminated on a voice-processing engine. Based on the caller’s choice from the
menus, the call can be transferred to a CDN that enters Contact Center Manager
Server. This operation is largely transparent to Contact Center Manager Server.
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When you use Contact Center Manager Server voice services, the calls from the
trunks enter a CDN first. Then, as part of the script processing, the call is
directed to a voice-processing engine. The server is in full control of this
interaction.

When do you need channels set up? What are channels?

Channels refer to a voice channel as seen from an ACCESS application’s point
of view—a voice resource through which you can control what a voice call
hears—similar to the concept of a speech path on the switch.

On CallPilot or Meridian Mail, a channel is a port attribute (a TN configured
with ACCESS class of service and a class number assigned to it). On the switch,
a channel is a voice port TN.

CallPilot or Meridian Mail voice ports configured as channels, and Contact
Center Manager Administration having acquired these ports with channel
numbers assigned, are required for the Give Controlled Broadcast
Announcement and the Voice Session script commands to work correctly.

Why is the default operation of Give IVR non-interruptible, while the
default for Give Controlled Broadcast Announcement and Open Voice
Session is interruptible?

Interruptible operation as the default makes the most sense for all of the
voice-processing commands. However, keeping Give IVR’s operation the same
as it is in CCR minimizes confusion for customers who are familiar with its
operation.

What are the default IVR ACD-DN and default treatment DNs used for?
What should they be set to?

See Chapter 4, “Switch subsystem configuration,” which explains how IVR
ACD-DN and treatment DNs are used.

Can Meridian Link and CCR use the same Meridian Mail system as
Contact Center Manager Server?

Yes, they can. However, they cannot share voice ports or IVR ACD queues with
the server.

304

Contact Center Manager



February 2007 Troubleshooting

What is the difference between the number and numberbydigit
clauses on the Play Prompt script statement?

The numberbydigit clause speaks each number separately (for example, a “Play
Prompt numberbydigit 1234” statement reads: one-two-three-four).

The number clause speaks the number as a single entity (for example, a “Play
Prompt number 1234” statement reads: one-thousand-two-hundred-thirty-four).
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Overview

This appendix contains the following information:

= procedures for migrating from Symposium \Voice Services on Meridian
Mail to Symposium Voice Services on CallPilot

=  procedures for backing out of the migration (reverting from Symposium
\Voice Services on CallPilot to Symposium Voice Services on Meridian
Mail), if the migration is unsuccessful

m  description of the differences between the Voice Prompt Editor and
Application Builder

For further information about migration, see the Meridian Mail to CallPilot
Migration Utility Guide.

Comparison of CallPilot and Meridian Mail voice services

Functionality of Symposium Voice Services on CallPilot is the same as
Symposium Voice Services on Meridian Mail, except as shown in the following

table.

Feature

Meridian Mail

CallPilot

Call processing
control

Meridian Mail uses the serial
X.25 AML link.

CallPilot uses the TCP/IP and
MLS protocols on the Nortel
server subnet.

\Voice services
control

Meridian Mail uses the serial
ACCESS link.

CallPilot uses the TCP/IP and
ACCESS protocols over the
ELAN subnet.
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Feature

Meridian Mail

CallPilot

Managing
voice prompts

Use the integrated Voice
Prompt Editor to administer
and edit voice prompts.

Use the CallPilot Application
Builder to administer and edit
voice prompt. Application
Builder is shipped with
CallPilot, but you must install
it separately.

To edit segment length, you
must use a third-party
application.

\oice segment
storage

\oice segments are stored in a
mailbox; access is controlled
with a password.

\oice segments are stored in a
folder; access is controlled by
the Application Builder logon.

\oice segment
length

\oice segments cannot exceed
2 minutes (120 seconds).

\oice segments cannot exceed
2 minutes (120 seconds).

\oice segment
deletion

When a segment is deleted,
the IDs of all subsequent
segments are renumbered
consecutively.

Segment 1Ds do not change
when segments are deleted.

\oice prompt
migration

Not applicable

When you migrate voice
segments to CallPilot from
Meridian Mail, the segment
name is preserved. The title is
the item that is concatenated
with the description and
appears as [Title] Description.

Front-end IVR
robustness

Meridian Mail ACD-DN night
call forward (NCFW) to
Contact Center Manager
Server CDN.

CallPilot default ACD-DN
NCFW to Contact Center
Manager Server CDN.
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Feature Meridian Mail CallPilot
Maximum Meridian Mail supports 96 CallPilot supports 192 ports in
capacity ports. (One port is reserved for | Release 4.0. (One port is

messaging. Therefore, only 95
ports are available for voice
services.)

reserved for messaging.
Therefore, only 191 ports are
available for voice services.)
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Section A: To migrate from Meridian Mail
to CallPilot

In this section

Overview of migration 312
Premigration checklist 313
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Step 2. Migrate Meridian Mail voice prompts and voice segments 323
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Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 311



To migrate from Meridian Mail to CallPilot Standard 6.0

Overview of migration

If you currently use Symposium Voice Services on Meridian Mail as your voice-
processing system, and you want to use Symposium Voice Services on CallPilot,
use the procedures in this section to migrate from Meridian Mail to CallPilot.

CAUTION
& Risk of migration failure. Use the Migration checklist.

To complete the migration successfully, you must follow the
migration checklist (see page 318). This checklist lists the steps
you must perform, and indicates the order in which you must
perform them.

Gradual migration

Rather than migrating all of your voice ports at one time, in some cases you can
choose to do a staged migration. The following are the migration conditions:

= If you have a combination of ACCESS and IVR ports, you can migrate
your ACCESS ports to CallPilot, and continue to use Meridian Mail to
service your IVR ports.
Contact Center Manager Server supports only one ACCESS link; therefore,
you must migrate all of your ACCESS ports at the same time.

= Ifall of your ports are IVR, you can migrate some ports to CallPilot, and
continue to use Meridian Mail to service the other ports.

m If all of your ports are ACCESS, you must migrate all ports to CallPilot at
the same time (no staged migration).
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Premigration checklist

Before you begin the migration, complete the following checklist.

Description v

Review all the voice-processing scripts and check that the
voice-processing commands use variables instead of constants.
(This is helpful if you must back out of the migration process.)

For example:

m If ACCESS scripts use a constant number as the ACCESS
ACD-DN, consider using a global variable that can be
modified to represent a CallPilot ACCESS ACD-DN or a
Meridian Mail ACCESS ACD-DN.

m If treatment DNs are constant numbers, consider using
variables of type Treatment DN.

Verify that CallPilot Release 4.0 is installed and operational.
CallPilot ELAN subnet IP address:

Verify that Meridian Mail to CallPilot Migration package is
available for installation. The package consists of the following
components:

m CallPilot 4.0 Documentation CD-ROM Package
m Meridian Mail to CallPilot Migration Tape

Verify that Meridian Mail hardware platform meets the
requirements. See the Meridian Mail to CallPilot Migration Utility
Guide.

Verify that Meridian Mail 11 or later is installed and operational.

Verify that Meridian Mail tape drive hardware and media meet the
requirements. See “Tape drive hardware and media requirements”
on page 316.
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Description

Verify that CallPilot Application Builder is installed and
operational in the network.

Verify that Contact Center Manager Release 6.0 is installed and
operational. Nortel server subnet IP address:

Identify data that cannot be migrated.

In the Meridian Mail to CallPilot Migration Utility Guide, review
these sections:

= Section A: “Understanding what can be migrated to Nortel
CallPilot”

m Section B: “Migration strategies”

Check ACCESS mailboxes to ensure that:
m the mailbox DNs are three or more digits in length
m the DNs are unique across all mailboxes

Verify that Meridian Mail Class of Service (COS) names are
unique across all classes of service.

Ensure that the mailbox that contains the ACCESS prompts does
not have personal COS. If you migrate users with personal COS,
see the Meridian Mail to CallPilot Migration Utility Guide and the
Meridian Mail System Administration Guide.

Verify that Contact Center Manager Server prompt file names are
unique.

If Contact Center Manager Server prompts exist in more than one
mailbox on Meridian Mail, the data collection utility appends the
mailbox number to the end of the file name. If the prompt file
name and mailbox combination result in file names that are not
unique, the prompts in the duplicate files are collected by the
Meridian Mail data collection utility but not migrated to the
CallPilot server.
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Description v

Verify that the required number of blank tapes are available to
store the data collected from Meridian Mail.

The number of tapes required is based on the size of Meridian
Mail. If you migrate Contact Center Manager Server Voice
Services on an average system, you need two tapes—one for the
system data, which includes voice prompts (menus and
announcements), and one tape for the ACCESS mailbox content.

For more information, see Meridian Mail to CallPilot Migration
Utility Guide.

Arrange maintenance period for Meridian Mail, CallPilot, and
Contact Center Manager Server, so that system performance is not
impacted by the migration.

Freeze all modifications to the Meridian Mail system (such as
adding additional voice prompts) during the migration. If you do
not, these changes may not be migrated.

Verify that the distribution level password for the CallPilot 4.0
support tools is available.

Migration limitations

To migrate voice prompts from Meridian Mail to CallPilot Release 4.0, you
must have one of the following Meridian Mail platforms:

s Card Option

= OptionEC 11

= Modular Option

= Modular Option EC

If your Meridian Mail system is an Entopia system, you must run Meridian Mail
Release 12 or later to migrate voice prompts to CallPilot Release 4.0.

For more information, see the Meridian Mail to CallPilot Migration Utility
Guide.
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Tape drive hardware and media requirements

Use the following information to make sure that the tape you use to collect the
Meridian Mail data is compatible with your CallPilot tape drive.

Based on your Meridian Mail software release and hardware platform, your
Meridian Mail system uses one of the following tape drives and tapes:

= Archive Viper tape drive—250 MB tapes
s Tandberg SLR4 tape drive (TDC4220)—2.5 GB tapes
m  Tandberg SLR5 tape drive—2.5 GB tapes

Based on your CallPilot software and hardware platform, your CallPilot system
uses one of the following tape drives and tapes:

m  SLR4—2.5 GB tapes
s  SLR5—2.5 GB tapes
s  SLR32—2.5 GB tapes
m  SLR50—2.5 GB tapes

The CallPilot server tape drives SLR32 and SLR50 cannot read the 250 MB
tapes created on the Archive Viper tape drive. If the Meridian Mail system has
an Archive Viper tape drive, and the CallPilot server to which you migrate has
an SLR32 or SLR50 tape drive, you must upgrade the Meridian Mail system to
an SLR4 or SLR5 tape drive prior to performing the migration.

For more information, see the tape drive hardware and media requirements in
the Meridian Mail to CallPilot Migration Utility Guide.

316 Contact Center Manager



February 2007 To migrate from Meridian Mail to CallPilot

Migration process

The following flowchart illustrates the migration process.

77777777777

: Step 1. Create :
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Jresources on switchi

Step 2. Migrate
voice prompts to
Messaging Services
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Step 3. Configure
Messaging Services
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Step 5. Deacquire
Meridian Mail
switch resources
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Step 6. Configure
IVR ACD-DN
Global Settings
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Step 7. Update
scripts

|

Step 8. Configure
voice connection
and restart

|

Step 9. Acquire
voice ports

l

Step 10. Test

Perform tasks:

= in boxes with dash borders on the switch.

= in boxes with dark borders in CallPilot.

= ingray boxes (light borders) on Contact Center Manager Server or Contact
Center Manager Administration.
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Migration checklist

To ensure a successful migration, use the following checklist. Copy or print the
checklist, and review it carefully before you begin. The checklist contains each
step you must perform during the migration. The order in which you complete

certain steps is critical, so follow the order in the checklist. During the migration

procedure, check off each item in the checklist as you complete it.

Description

Complete the premigration checklist on page 313.

Step 1. Create CallPilot ACD-DNs and voice ports on the
switch

For instructions, see page 320.

Step 2. Migrate Meridian Mail voice prompts and voice
segments

For instructions, see page 323.

Step 3. Configure CallPilot
For instructions, see page 324.

Step 4. Configure CallPilot switch resources
For instructions, see page 327.

Step 5. Deacquire Meridian Mail voice ports and ACD-DNs
For instructions, see page 332.

Step 6. Configure Contact Center Manager Server connection
to CallPilot

For instructions, see page 336.

Step 7. Configure the global settings
For instructions, see page 338.

Step 8. Acquire CallPilot resources
For instructions, see page 341.
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Description v

Step 9. Update your scripts
For instructions, see page 345.

Step 10. Test the migration.
For instructions, see page 346.

Tip: Nortel recommends that you leave your Meridian Mail configuration intact,
in case you need to back out of the migration.
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Step 1. Create CallPilot ACD-DNs and voice
ports on the switch

You must create the CallPilot ACD-DNs (IVR and ACCESS) and voice ports on
the switch. CallPilot ACD-DNSs and voice ports have different properties from
Meridian Mail ACD-DN:s.

ATTENTION  vou must create separate ACD-DNs for your IVR and

ACCESS voice ports. (The configuration for IVR and
ACCESS ACD-DN:s is identical.)

Creating an ACD-DN in LD 23

Use the following prompts and responses in LD 23. For prompts not listed in the
table, press Enter to accept the default.

Prompt Response Description

REQ NEW Create a new queue.

TYPE ACD ACD data blocks

CUST 0-99 Customer number

ACDN XXXX The DN of the ACD queue. This is the IVR

ACD-DN acquired from Contact Center
Manager Server.

MWC NO Indicates that this is not a message center.

MAXP XX Indicates the maximum number of ACD
agents for this queue.

IVR YES Indicates that the queue can be used with the
Give IVR command defined in scripts.

TRDN XXXX Default treatment DN is used if treatment is
not specified in the script.
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ALOG YES ACD agents are automatically logged on.
REQ END Exit from overlay.

Creating a voice port in LD 11

Use the following prompts and responses. For prompts not listed in the table,

press Enter to accept the default.

Prompt Response Description

REQ NEW Add a voice port.

TYPE 2008

TN Iscu Terminal Number of the voice port, where | is
the loop, s is the shelf, c is the card, and u is
the unit. (For the Option 11C, TN is cu only.)

AST 00 01 Associated set assignment on key 0 and key
1.

CLS FLXA (units Flexible voice/data allowed.

16-31)

VCE Voice Terminal

WTA Warning Tone Allowed

CTD Conditionally Toll Denied

MMA Multimedia Agent
CTD is optional, but prevents outbound long-
distance calls from a voice port.

KEY 0 ACD xxxx Define 0 as an ACD key. xxxx is the ACD-DN.

Zzz nnnn zzz is the CLID entry number. nnnn is the
position ID. The DN must match the DN on the
CAT (in Meridian Mail) or the Channel
Information page (in CallPilot).

KEY 1 SCN xxxx Define key 1 as a single-call non-ringing DN.
xxxx is the SCN DN of the SCN. The DN must
match the DN on the CAT (in Meridian Mail) or
the Channel Information page (in CallPilot).
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Prompt Response Description

KEY 2 MSB Define key 2 as a Make Set Busy key.

KEY 3 NRD Define key 3 as a Not Ready key.

KEY 4 TRN Define key 4 as a Transfer key.

KEY 5 AO3 Define key 5 as a Conference key.
(letter O)

REQ END Exit from overlay.

322

Contact Center Manager



February 2007 To migrate from Meridian Mail to CallPilot

Step 2. Migrate Meridian Mail voice prompts
and voice segments

The following section describes voice prompt migration and management.

To migrate voice prompts

Unless you plan to recreate your voice prompts in CallPilot, you must migrate
your Meridian Mail voice prompts and voice segments (announcements and
menus) to CallPilot.

For more information about the Meridian Mail voice prompt and voice segment
migration process, see the Meridian Mail to CallPilot Migration Utility Guide.

The Meridian Mail to CallPilot Migration utility helps you collect the Meridian
Mail data and migrate it to CallPilot. For more information about this utility, and
for detailed instructions, see the Meridian Mail to CallPilot Migration Utility
Guide.

ATTENTION T, migration moves the voice prompts only. The menu

and announcement structures are not moved.

To manage voice prompts

After the voice prompts are in CallPilot, you manage them with Application
Builder. Application Builder is not installed as part of the CallPilot installation.
You must ensure that it is installed on a PC in your network. For more
information about installing and using Application Builder, see the CallPilot 4.0
Administrator’s Guide.

For information about the differences between Application Builder and the
\Voice Prompt Editor, which you used with Meridian Mail, see Section C:
“Comparison of VPE and Application Builder,” on page 365.
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Step 3. Configure CallPilot

You must perform the following tasks to configure CallPilot for Contact Center
Manager Server integration:

In the Configuration Wizard, on the Switch Identification page, define the
Nortel server subnet IP address of Contact Center Manager Server in the
server IP Address field.

In the Configuration Wizard, on the Channel Detail Information page,
define a channel for each voice port that is used to provide ACCESS or IVR
services to Contact Center Manager Server.

Define Service DNs for Symposium \Voice Services.

Updating the Configuration Wizard

ATTENTION

To minimize downtime, and to make backing out easier,
make sure that the CallPilot class IDs are different from the
channel numbers of your Meridian Mail voice ports. For
example, if your Meridian Mail voice ports use channel
numbers 1 to 48, then assign class I1Ds 49 to 96 to your
CallPilot TNs.

This procedure assumes that you use new class 1Ds. If you do
not, you must delete the channel number from your Meridian
Mail voice ports before you create your CallPilot voice ports.
On the CallPilot server, start the Configuration Wizard.
Click Next until the Switch Information page appears.

In the Contact Center Manager Servert CLAN IP address box, enter the
CLAN address of the Contact Center Manager Server.

On the left side of the page, click the link for the set of channels you want to
configure.

Result: The Channel Name column lists the channels on the selected link.
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5 Inthe Channel Name column, click the first channel that you want to
configure.

Result: The Channel Detail Information page appears.

6 For each TN used to provide IVR services to Contact Center Manager
Server, select the IVR check box.

7 Foreach TN used to provide ACCESS services, select the ACCESS check
box, and specify a class ID. The class ID is used for communication
between the server and CallPilot over the ACCESS link.

ATTENTION When you define the TN as a voice port on Contact
Center Manager Server (see Step 4, “Configure CallPilot
switch resources”), make sure that the channel number
you assign to the voice port matches the class ID for the
TN.

8 Click Fill.

Click OK.

Configuring the ACCESS and Give IVR channels in the SDN table
1  Start CallPilot Manager.

2  From the menu, select System > Service Directory Number.
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3  Click New.
Result: The SDN Details window appears.

CaliPiiot Manager ﬂ

LDAP server: cp 10051 | Mailbox Number: 000000

Home User ¥ System v  Mai * M ing ¥ Tools ¥ Help ~

Location = System = Senice Directony Number # SDN Details

General
Setvice DN
Application Name: | Symposium Voice Services v
Media Type: |%oice hd

Minimum Channels: |0

X Use Default
aximum Channels

Cornments

4 In the Service DN box, type the CallPilot ACD-DN number, as defined on
the switch.

From the Application Name list, select Symposium Voice Services.
Click Save.
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Step 4. Configure CallPilot switch resources

You must update the configuration of switch resources on Contact Center
Manager Server. This involves the following tasks:

m  Create the CallPilot ACD-DNs.
m  Create the CallPilot voice ports.

This procedure assumes that the class IDs of your CallPilot TNs are different
from your Meridian Mail channel numbers. If they are not, you must either
delete the channel number from the Meridian Mail ACCESS ports, or assign
different class IDs to your CallPilot TNs.

ATTENTION To minimize backout effort, do not delete your Meridian Mail

voice ports at this time. You can delete them after you confirm
that the migration was successful.

Adding a new IVR ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

ﬁ:n;agc:nf:;ter Configuration Audit Trail

-LU out
Access and Partition Scripting .
Management

Real-Time Reporting Emergency Help

Qutbound

A6 606
@666

Historical Reporting
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On the system tree, in the Configuration component, double-click the server
in Contact Center Manager Server to which you want to add the IVR ACD-
DN.

Result: The server expands to reveal its resources.
Click the IVR ACD-DNs heading.
Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

Server | Download

+-{=) CARLING
GUNINESS Haywards VR ACD-DNs
+-{Z) Haloween
=) Haywards

([ Activity Codes Mame Mumber Threshald Class Acguired? Status
D Call Presentation Clazsses P |Default WVREG 899 IvF_Template J3 Mot Acquired
[ZCOMs (Route Poirts) SUS0201 (] IvR_Template: | Hot Acouired
(L] Contact Types * C
(JDmiss
D Formulas

[ Global Seftings
([ Histarical Statistics
B R ACD-DNs
|:| Met: king Communication Paramet
D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
) Heiniken
kilkenny
knockout
Sandpiper

In the Name box, type the name of the IVR ACD-DN as you want it to
appear in reports.

In the Number box, type the IVR ACD-DN number. This number must
match the number configured on the switch.

From the Threshold Class list, select the threshold class for the IVR ACD-
DN.

Click any other row of the table.

Result: The system adds the IVR ACD-DN, and Not Acquired appears in
the Status column.

Select the Acquired? check box in the row containing the IVR ACD-DN
that you want to acquire.

Tip: Clear the Acquired? check box to remove the check and to de-acquire
the IVR ACD-DN.
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9  Click any other row in the table to submit/save your action.

Result: The system acquires or deacquires the IVR ACD-DN, and the
status appears in the Status column.

10 Repeat steps 4 to 9 for each CallPilot ACD-DN (ACCESS and IVR) you
want to add.

Adding a new voice port

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

@} ﬁ:n;agcgnf;'::er @) Configuration

@} Access and Partition @j: Scripting
Management !

@ Real-Time Reporting @ Emergency Help

@} Historical Reporting @) Outbound

2  On the system tree, double-click the server in to which you want to add the
voice port.

Result: The server expands to reveal its resources.
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10

Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download

[#-{) BALTIKA
-]
g 2:5:;:2:5 Haywards Phonesets/Voice Parts
[+-{iZ) Haloween
=2} Haywards
(L2 Activity Codes Mame Type Address Channel VR Mame
D Call Presentstion Classes p [10-0-0-2 Voice Port 10-0-0-0 7080 (7080)
[Z1COMs (Route Paints) 10-0-0-1 aics Part 10-0-0-1 7010 (707 0)
D Contact Types 5-0-0-0 Agent 5-0-0-0
[aDHss 5-0-0-1 Agert 5-0-0-1
[CaFarmuas 5002 Ertar 5-0-0-2
[ Globel Settings: 5.0-0-3 Agent 5.0-0-3
[ Historicsl Statistics 5-0-0-4 Supervisar 5-0-0-4
(AR ACD-DHs 5-0-0-9 Error 5-0-0-8
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[CIReal-ime Statistics
[Routes

[ Skilzets

D Threshold Clazsses

[#-{Z] Heiniken
-] Kilkenny

In the Name box, type the name of the voice port as you want it to appear in
reports

From the Type list, select Voice Port.

In the Address box, type the address of the voice port on the telephony
server.

For ACCESS voice ports only, in the Channel box, type the channel
number.

Click any other row of the table.

Result: The system adds the voice port, and Not Acquired appears in the
Status column.

Select the Acquired? check box in the row containing the voice port that
you just added.

Click any other row in the table to acquire the voice port.

Result: The system acquires the voice port, and the status appears in the
Status column.

If necessary, click Refresh Status to view the current status of the
acquisition.
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11 Repeat steps 2 to 10 for each voice port you want to configure.

Tip: If you want to reconfigure a voice port, you must first deacquire the
voice port, edit the configuration parameters, and then reacquire the voice

port.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 331



To migrate from Meridian Mail to CallPilot Standard 6.0

Step 5. Deacquire Meridian Mail voice ports
and ACD-DNs

Before you make changes to resources on the switch, you must deacquire those
resources from Contact Center Manager Server. You must deacquire the
Meridian Mail voice ports first, and then the ACD-DNs (both IVR and
ACCESS). To deacquire is to release an acquired switch resource from the
control of the Contact Center.

Deacquiring a voice port

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

ﬁ:n;agc:nf:;ter Configuration Audit Trail

-LU out
Access and Partition Scripting .
Management

Real-Time Reporting Emergency Help

666 6
@666

Historical Reporting Outbound

2  On the system tree, double-click the server in which you want to deacquire
the voice port.

Result: The server expands to reveal its resources.
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3 Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download
(=) BALTIKA
CARLING

GUNINESS Haywards Phonesets/Voice Parts
Haloween
-/ Haywards

(L2 Activity Codes Mame Type Address Channel VR Mame
D Call Presentstion Classes p [10-0-0-2 Voice Port 10-0-0-0 7080 (7080)
[Z1COMs (Route Paints) 10-0-0-1 aics Part 10-0-0-1 7010 (707 0)
D Contact Types 5-0-0-0 \Agent 5-0-0-0
[aDHss 5-0-0-1 |Agert 5-0-0-1
[CaFarmuas 5002 Ertar 5-0-0-2
[ Globel Settings: 5.0-0-3 A gent 5.0-0-3
[ Historicsl Statistics 5-0-0-4 Supervisar 5-0-0-4
(AR ACD-DHs 5-0-0-9 Error 5-0-0-9
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[C1Realtime Statistics
[Routes

(L Skillsets

D Threshold Clazsses
Heiniken
kilkenny

Clear the Acquired? check box to deacquire the voice port.
Click any other row in the table to submit/save your action.

Result: The system deacquires the voice port, and the status appears in
the Status column.

6 Click Refresh Status to view the current status of the deacquisition.
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Deacquiring an ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

©666

Historical Reporting Outbound

666 6

2  On the system tree, double-click the server in Contact Center Manager
Server to which you want to deacquire the ACD-DN.

Result: The server expands to reveal its resources.
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3  Select the IVR ACD-DNs folder.
Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

server | Download

GUINNESS Haywards WR ACD-DMs

([ Activity Codes Mame Mumber Threshald Class Acguired? Status
(L Call Presentation Classes Defaul_VRG 999 IvF_Template Ji] Mot Acquired
[ZCOMs (Route Poirts) SLIS0201 (] IvR_Template: | Hot Acouired
(L] Contact Types * C
[aDHss
D Formulas
[ Global Seftings
([ Histarical Statistics
o =
I:I M iy Communication Paramed
D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
Heiniken
kilkenny
knockout
Sandpiper

b d

Clear the Acquired? check box to deacquire the ACD-DN.
Click any other row in the table to save your action.

Result: The system deacquires the ACD-DN and the status appears in the
Status column.

6 Click Refresh Status to view the current status of the deacquisition.
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Step 6. Configure Contact Center Manager
Server connection to CallPilot

To use CallPilot for voice processing, install Contact Center Manager Server and
configure the Contact Center Manager Server connection to CallPilot. Then
restart the Contact Center Manager Server application.

ATTENTION  \ortel recommends that you retain the physical cable

connections between Meridian Mail and Contact Center
Manager Server to facilitate backout, if required.

Configuring the CallPilot connection

1  On Contact Center Manager Server, choose Programs > Nortel Contact
Center > Manager Server > Server Setup Configuration.

2 Click the Voice Services tab.

Result: The Voice Services property page appears.

Local Area Network IP VoiceSences | ASMIPAddess | SiteName | Utiiies
Pleaze fil m the voice seraces sstup micimation below,
Woice Connection Typs: " Senal [Mendian Mail]

& [TCP [Cail Piai}
Call Piot Server IP: [r72125041
| Port 10008
> CONTACT CENTER o !
MANAGER SERVER
>THIS IS NERTEL
oK | caeel | s | |

3  For Voice Connection Type, choose TCP (CallPilot).

4 In the CallPilot Server IP box, type the ELAN subnet IP address of the
CallPilot server.
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5 Inthe CallPilot Port box, type 10008.
For single-NIC configuration, follow these steps:

a. Ensure the ELAN subnet is connected to the Nortel server subnet
though one (and only one) router.

b. Enter the IP address of the CallPilot Nortel server subnet NIC as
opposed to the IP address of the ELAN subnet NIC.

c. In CallPilot, do not configure a default gateway (for example, router)
address associated with the CallPilot ELAN NIC. A default gateway for
the CallPilot's NIC connected to the Nortel server subnet is required.

7  Click OK.

Result: The following message appears: “The configuration data has been
validated and can be used to configure the server database. Do you wish to
use this data to complete server configuration now?”

8 Click Yes.

Result: The Server Configuration utility runs and the following message
appears: “You must reboot now to commit changes. Press OK to reboot or
Cancel to stop.”

9 Click OK.

Result: The server restarts.
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Step 7. Configure the global settings

You must update the global settings with the CallPilot ACCESS DNs.

Updating global settings

1  In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁgztaagc:nf:mer Configuration

Logout
Access and Partition Scripting
Management

Real-Time Reporting Emergency Help

Qutbound

G606 6
®©e66

Historical Reporting

2  On the system tree, double-click the server in which you want to configure
global settings.

Result: The server expands to reveal its resources.
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Select the Global Settings folder.

Result: The Global Settings window appears.

NERTEL CONFIGURATION

server | Dowmload
=) BALTIKA
iZ) CARLING

=i Haywards

- GUINHESS Haywards Global Settings

aloween
[ Activity Codes .
[0 Call Presentation Classes Agert Orcler Preference: | Longest time in Idie state since last status change v |
L1CoMs (Route Points) Default Ran Route: 993 i
[ Cortact Types =
D DMISs Maximum Ports With GQueuing For Broadcast: |96
CaF
g
i
[LIWR ACD-DHs

Broadcast Yoice Port \Wait Timer: .1b |
istics Default Access VR DM | 999, Defautt VRS ;75

Merician Mailkox: ?11 |

CI Metveorking Communication Paramet
D Phonesets and Yoice Ports

[ Phoneset Displays

([ Realtime Ststistics

Meridian Mail Password (swes

Qaraes EZn
[ skilzets
D Threshald Classes

From the Agent Order Preference list, choose how to present calls to
agents based on their idle time. Valid values:

Longest total time in idle state since login—Choose this option if you
want calls to be presented to the agent who accumulated the most idle
time since logging on (this is the system default for the Communication
Server 2x00/DMS switch).

Longest time in idle state since last status change—Choose this
option if you want calls to be presented to the agent who accumulated
the most idle time since his or her last status change (this is the system
default for the Communication Server 1000/Meridian 1 switch).

Longest total time since last CDN/ACD call—Choose this option if
you want calls to be presented to the agent with the longest elapsed
time since handling a CDN/ACD call.

The system does not reset the timer when the agent switches to the Not
Ready state.

In the Default RAN Route box, type the default route to use when a script
contains route commands but does not explicitly state a route number.

Valid values: maximum of 3 digits
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10

11

Valid range: 0-511 (999 reserved for internal route)
Note: The route you specify must already exist.

In the Maximum Ports With Queuing For Broadcast box, type the total
number of IVR ports that can be user-controlled for broadcast at any time.

Valid values: 150 maximum

In the Broadcast Voice Port Wait Timer box, type the number of seconds
the system waits for a voice port to become available.

From the Default Access IVR DN list, select the default DN to use in the
event that a script contains voice-processing commands that may take an
IVR ACD-DN as a parameter, but does not explicitly state an IVR ACD-DN.

In the Meridian Mailbox box, type the DN of the Meridian Mail mailbox. In
CallPilot, this field is not used, but you must enter any two digits.

In the Meridian Mail Password box, type the password required to access
the Meridian Mail mailbox. In CallPilot, this field is not used, but you must
enter any four digits or use the default.

Click Submit.

340

Contact Center Manager



February 2007 To migrate from Meridian Mail to CallPilot

Step 8. Acquire CallPilot resources

After the Contact Center Manager Administration application comes up, you
must acquire the CallPilot resources to allow voice processing to begin.

Acquiring an ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁgztaagc:nf:mer Configuration

-Lo out
Access and Partition Scripting 2
Management

Real-Time Reporting Emergency Help

®©e66

Qutbound

G606 6

Historical Reporting

2  Onthe system tree, double-click the server in which you want to acquire the
ACD-DN.

Result: The server expands to reveal its resources.
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Select the IVR ACD-DNs folder.

Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

server | Download

[ Activity Codes
D Call Presentation Classes
(L CDMs (Route Points)
D Contact Types
[aDHss
D Formulas
[ Global Seftings
([ Histarical Statistics
(| =
I:I M iy Communication Paramed
D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
Heiniken
kilkenny
knockout
Sandpiper

Haywards VR ACD-DMNs

Mame Mumber Threshold Class Acuired? Status
P |Defaul WRD 899 IvF,_Template C Mot Acquired
SLIS0201 i) IvR_Template: 1] Hot Acouired
* O

Select the Acquired? check box to acquire the ACD-DN.

Click any other row in the table to save your action.

Result: The system acquires the ACD-DN, and the status appears in the

Status column.

Click Refresh Status to view the current status of the acquisition.
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Acquiring a voice port

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

©666

Historical Reporting Outbound

666 6

2 On the system tree, double-click the server which you want to acquire the
voice port.

Result: The server expands to reveal its resources.
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Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download
(=) BALTIKA
CARLING

GUNINESS Haywards Phonesets/Voice Ports
Haloween
-/ Haywards

(L2 Activity Codes Mame Type Address Channel VR Mame
D Call Presentstion Classes p [10-0-0-2 Voice Port 10-0-0-0° 7080 (7080)
[Z1COMs (Route Paints) 10-0-0-1 oice Part 10-0-0-1 7010 (7010)
D Contact Types 5-0-0-0 \Agent 5-0-0-0
[IoMss 5-0-0-1 |Bgert 5.0-0-1
[CFormulas 5-0-0-2 Error 5002
[ Globel Settings: 5.0-0-3 A gent 5.0-0-3
[ Histarical Statistics 5-0-0-4 Supervisor 5-0-0-4.
MR ACD-DHs 5.0-0-9 Error 5.0-0-9
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[C1Realtime Statistics
[Routes

(L Skillsets

D Threshold Clazsses
Heiniken
kilkenny

Select the Acquired? check box to acquire the voice port.
Click any other row in the table to submit/save your action.

Result: The system deacquires the voice port, and the status appears in
the Status column.

Click Refresh Status to view the current status of the acquisition.
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Step 9. Update your scripts

You must update all of your scripts to use the new ACD-DNs.

Hard-coded ACD-DNs

If you hard-code the ACD-DNSs in your scripts, you must change and reactivate
your scripts. For more information about changing scripts, see the Contact
Center Manager Scripting Guide for the Communication Server 1000/Meridian
1.

Global variables

If you use global variables to represent ACD-DNSs in your scripts, you must
assign new values to the script variables. For more information about changing
variables, see the Contact Center Manager Scripting Guide for the
Communication Server 1000/Meridian 1.

Nortel recommends that you use variables to represent ACD-DNSs in your
scripts.
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Step 10. Test the migration

After you complete the migration, you must test your system to ensure that it
functions as expected. Test each path in the call scripts to ensure that calls are
routed properly, and that they receive the appropriate treatment.
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Section B: To Back out of the migration

In this section

Overview of backout 348
Step 1. Deacquire CallPilot ACD-DNs and voice ports 350
Step 2. Configure the connection to Meridian Mail 354
Step 3. Configure global settings 357
Step 4. Acquire voice ports 360
Step 5. Update your scripts 364
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Overview of backout

If the migration to CallPilot is not successful, you can use the procedure in this
section to back out of the migration.

ATTENTION This procedure assumes that you did not delete your Meridian
Mail resources from the switch. If you deleted them, create
them before you continue. For more information about
creating Meridian Mail resources, see Chapter 4, “Switch
subsystem configuration.”

Backout process

The following flowchart illustrates the backout process.

Step 1. Deacquire
Messaging Services
resources

!

Step 2. Update
scripts

!

Step 3. Configure
IVR ACD-DN
Global Settings

!

Step 4. Configure
voice connection
and restart

!

Step 5. Acquire
voice ports
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Backout checklist

Use the following checklist to perform the backout.

Description v

Step 1. Deacquire CallPilot ACD-DNs and voice ports
For instructions, see page 350.

Step 2. Configure the connection to Meridian Mail
For instructions, see page 354.

Step 3. Configure global settings
For instructions, see page 357.

Step 4. Acquire voice ports
For instructions, see page 360.

Step 5. Update your scripts

For instructions, see page 364.
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Step 1. Deacquire CallPilot ACD-DNs and
voice ports

You must deacquire the CallPilot voice ports and ACD-DNs on Contact Center
Manager Server. To deacquire is to release an acquired switch resource from the
control of the Contact Center.

Deacquiring a voice port

1  In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁzg;ﬁ:ﬁf:ﬁ:er Configuration

Logout
Access and Partition Scripting
Management

Real-Time Reporting Emergency Help

®©e66

Qutbound

®©6 6 6

Historical Reporting

2  On the system tree, double-click the server in which you want to deacquire
the voice port.

Result: The server expands to reveal its resources.
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3 Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download
(=) BALTIKA
CARLING

GUNINESS Haywards Phonesets/Voice Ports
Haloween
-/ Haywards

(L2 Activity Codes Mame Type Address Channel VR Mame
D Call Presentstion Classes p [10-0-0-2 Voice Port 10-0-0-0° 7080 (7080)
[Z1COMs (Route Paints) 10-0-0-1 oice Part 10-0-0-1 7010 (7010)
D Contact Types 5-0-0-0 \Agent 5-0-0-0
[IoMss 5-0-0-1 |Bgert 5.0-0-1
[CFormulas 5-0-0-2 Error 5002
[ Globel Settings: 5.0-0-3 A gent 5.0-0-3
[ Histarical Statistics 5-0-0-4 Supervisor 5-0-0-4.
MR ACD-DHs 5.0-0-9 Error 5.0-0-9
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[C1Realtime Statistics
[Routes

(L Skillsets

D Threshold Clazsses
Heiniken
kilkenny

Clear the Acquired? check box to deacquire the voice port.
Click any other row in the table to save your action.

Result: The system deacquires the voice port, and the status appears in
the Status column.

6 Click Refresh Status to view the current status of the deacquisition.
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Deacquiring an ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

Historical Reporting Outbound

2  On the system tree, double-click the server in which you want to deacquire
the ACD-DN.

Result: The server expands to reveal its resources.
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3  Select the IVR ACD-DNs folder.
Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

server | Download

GUINNESS Haywards WR ACD-DMs

([ Activity Codes Mame Mumber Threshald Class Acguired? Status
(L Call Presentation Classes Defaul_VRG 999 IvF_Template Ji] Mot Acquired
[ZCOMs (Route Poirts) SLIS0201 (] IvR_Template: | Hot Acouired
(L] Contact Types * C
[aDHss
D Formulas
[ Global Seftings
([ Histarical Statistics
o =
I:I M iy Communication Paramed
D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
Heiniken
kilkenny
knockout
Sandpiper

b d

Clear the Acquired? check box to deacquire the ACD-DN.
Click any other row in the table to submit/save your action.

Result: The system deacquires the ACD-DN, and the status appears in the
Status column.

6 Click Refresh Status to view the current status of the deacquisition.
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Step 2. Configure the connection to Meridian

Mail

You must now shut down the Contact Center Manager Server application,
configure the Contact Center Manager Server connection to Meridian Mail, and
restart the Contact Center Manager Server application.

Note: If you removed the serial cable connection between Contact Center
Manager Server and Meridian Mail, you must reinstall it now.

Shutting down the Contact Center Manager Server application

Shut down all Contact Center Manager Server services using the Shutdown
utility.

1

From the Windows Start menu, choose Programs > Nortel Contact
Center > Manager Server > Shutdown.

Result: The Contact Center Manager Server Shutdown dialog box
appears.

Click OK.

Result: The utility shuts down all services, and then the Service Status
Log window appears. This log lists any services that failed to shut down.

Click Recheck to refresh the service statuses.
If any services are still running:

a. From the Windows Start menu, choose Control Panel >
Administrative Tools > Services to display the Services window.

b. Manually shut down the listed services.
c. Close the Services window.

d. Click Recheck to update the status log.
Click Accept to exit the utility.

Click Start > Run

In the command line, type serman.

Result: All the services are placed in manual mode.
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8 Restart the server.

CAUTION

Risk of database corruption

You must shut down the Contact Center Manager Server
Services before shutting down the database services.
Failure to do so can result in database corruption.

Configuring the Meridian Mail connection

1 On Contact Center Manager Server, choose Programs > Nortel Contact
Center > Manager Server > Server Setup Configuration.

2 Click the Voice Services tab.

Result: The Voice Services page appears.

£¥. Nortel Contact Center Management Server Setup Configuration Utility [ %]
Customer Information | Licenze Manager I Succeszion CSE 1000 Switch Infarmation I
Local drea Metwark IP VoiceServices | RSMIPAddiess | SteMame | Utiities

Fleaze fill in the voice services setup information below.

Woice Connection Type:

= TCP [Call Filot)

Call Pilot Server ELAN P |

Call Pilat Server Port: ID
> CONTACT CENTER
MANAGER SERVER

>THIS IS NERTEL

QK I Cancel | Lpply Help

3  For Voice Connection Type, choose Serial.

Result: The CallPilot ELAN IP box clears and the CallPilot Port box is set to
0. Do not change these values.
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Click OK.

Result: The following message appears: “The configuration data has been
validated and can be used to configure the server database. Do you wish to
use this data to complete server configuration now?”

Click Yes.

Result: The Server Configuration utility runs and the following message
appears: “You must reboot now to commit changes. Press OK to reboot or
Cancel to stop”

Click OK.

Result: The server restarts.
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Step 3. Configure global settings

You must update the global settings with the Meridian Mail ACCESS IVR and
Treatment DNs, and verify that the Meridian Mail mailbox and password are
correctly specified.

ATTENTION This procedure assumes that your Meridian Mail ACD-DNs

and voice ports still exist on the server. If they do not exist,
you must create them. For detailed instructions, see Chapter 7,
“Contact Center Manager configuration.”

Updating global settings

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&QRTEL.

ﬁ:n;agc:nf:;ter Configuration Audit Trail

-LU out
Access and Partition Scripting .
Management

Real-Time Reporting Emergency Help

G666

Qutbound

666 6

Historical Reporting

2 On the system tree, double-click the server in which you want to configure
global settings.

Result: The server expands to reveal its resources.
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3  Select the Global Settings folder.

NERTEL CONFIGURATION

e UIHESS Haywards Global Settings

=) Haywards

=) Sandpiper

aloween

(L Activity Cades .
[0 Call Presentation Classes Agert Orcler Preference: | Longest time in Idie state since last status change v |
CIcons (Route Paints) Default Ran Route: 993 i
[ Cortact Types =
D DMISs Maximum Ports With GQueuing For Broadcast: |96
[AFormulss —
o i Broadeast Voice Port Wait Timer: 10 |
[ Historical Statistics Defaul Access VRDM. |99, Defaut IWRG. v |
[Z1IWR ACD-Dis e

Merician Mailkox: ?11 |

CI Metveorking Communication Paramet
D Phonesets and Yoice Ports

[ Phoneset Displays

([ Realtime Ststistics

Meridian Mail Password (swes

Carases EZn
[ skilzets
D Threshald Classes

4  From the Agent Order Preference list, choose how to present calls to
agents based on their idle time. Valid values:

Longest total time in idle state since login—Choose this option if you
want calls to be presented to the agent who accumulated the most idle
time since logging on (this is the system default for the Communication
Server 2x00/DMS switch).

Longest time in idle state since last status change—Choose this
option if you want calls to be presented to the agent who accumulated
the most idle time since his or her last status change (this is the system
default for the Communication Server 1000/Meridian 1 switch).

Longest total time since last CDN/ACD call—Choose this option if
you want calls to be presented to the agent with the longest elapsed
time since handling a CDN/ACD call.

The system does not reset the timer when the agent switches to the Not
Ready state.

5 Inthe Default RAN Route box, type the default route to use when a script
contains route commands but does not explicitly state a route number.

Valid values: maximum of 3 digits

Valid range: 0-511 (999 reserved for internal route)

Note: The route you specify must already exist.
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10

11

In the Maximum Ports With Queuing For Broadcast box, type the total
number of IVR ports that can be user-controlled for broadcast at any time.

Valid values: 150 maximum

In the Broadcast Voice Port Wait Timer box, type the number of seconds
the system waits for a voice port to become available.

From the Default Access IVR DN list, select the default DN to use in the
event that a script contains voice-processing commands that may take an
IVR ACD-DN as a parameter, but does not explicitly state an IVR ACD-DN.

In the Meridian Mailbox box, type the DN of the Meridian Mail mailbox. In
CallPilot, this field is not used, but you must enter any two digits.

In the Meridian Mail Password box, type the password required to access
the Meridian Mail mailbox. In CallPilot, this field is not used, but you must
enter any four digits or use the default.

Click Submit.
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Step 4. Acquire voice ports

After the server comes up, you must acquire the Meridian Mail resources to
allow voice processing to begin.

Acquiring an ACD-DN

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS NQRTEL.

ﬁgztaagc:nf:mer Configuration

-Lo out
Access and Partition Scripting 2
Management

Real-Time Reporting Emergency Help

®©e66

Qutbound

G606 6

Historical Reporting

2  On the system tree, double-click the server in Contact Center Manager
Server to which you want to acquire the ACD-DN.

Result: The server expands to reveal its resources.
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3  Select the IVR ACD-DNs folder.
Result: The IVR ACD-DNs window appears.

NERTEL CONFIGURATION

Server | Download
+-{Z) BALTIKA
CARLING
GUNINESS Haywards VR ACD-DNs
Haloween
- Haywards
I:I Activity Codes Mame Mumber Threshold Class Acouired? Status
(L Call Presentation Classes Defaul_VRG 999 IvF_Template Ji] Mot Acquired
[ZCOMs (Route Poirts) SLIS0201 (] IvR_Template: | Hot Acouired
(L] Contact Types #* | ]
[aDHss
D Formulas
[ Global Seftings
([ Histarical Statistics
(| =
I:I M iy Communication Paramed
D Phonezets and Yoice Ports
[ Phoneset Displays
(1 Real-time Statistics
[Routes
([ Skilsets
D Threshold Classes
Heiniken
kilkenny
knockout
[+1-4)) Sandpiper

b d

Select the Acquired? check box to acquire the ACD-DN.
Click any other row in the table to submit/save your action.

Result: The system acquires the ACD-DN, and the status appears in the
Status column.

6 Click Refresh Status to view the current status of the acquisition.
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Acquiring a voice port

1 In Contact Center Manager Administration, from the launchpad, select
Configuration.

> CONTACT CENTER — MANAGER

>THIS IS N&RTEL.

ﬁgn?gc:nf:gtm Configuration
» -Logout

Access and Partition Scripting

Management

Real-Time Reporting Emergency Help

Historical Reporting Outbound

2 On the system tree, double-click the server on which you want to acquire
the voice port.

Result: The server expands to reveal its resources.
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3 Select the Phonesets and Voice Ports folder.

Result: The Phonesets/Voice Ports window appears.

NERTEL CONFIGURATION

Server | Download
(=) BALTIKA
CARLING

GUNINESS Haywards Phonesets/Voice Ports
Haloween
-/ Haywards

(L2 Activity Codes Mame Type Address Channel VR Mame
D Call Presentstion Classes p [10-0-0-2 Voice Port 10-0-0-0° 7080 (7080)
[Z1COMs (Route Paints) 10-0-0-1 oice Part 10-0-0-1 7010 (7010)
D Contact Types 5-0-0-0 \Agent 5-0-0-0
[IoMss 5-0-0-1 |Bgert 5.0-0-1
[CFormulas 5-0-0-2 Error 5002
[ Globel Settings: 5.0-0-3 A gent 5.0-0-3
[ Histarical Statistics 5-0-0-4 Supervisor 5-0-0-4.
MR ACD-DHs 5.0-0-9 Error 5.0-0-9
[:I Metveorking Communication Paramet *

D Phoneszets and Yoice Ports
[ Phoneset Displays
[C1Realtime Statistics
[Routes

(L Skillsets

D Threshold Clazsses
Heiniken
kilkenny

Select the Acquired? check box to acquire the voice port.
Click any other row in the table to save your action.

Result: The system deacquires the voice port, and the status appears in
the Status column.

6 Click Refresh Status to view the current status of the acquisition.
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Step 5. Update your scripts

If you use different ACD-DNs for CallPilot and Meridian Mail, you must update
all of your scripts to reference the Meridian Mail ACD-DNE.

Hard-coded ACD-DNs

If you hard-code the ACD-DNSs in your scripts, you must change and reactivate
your scripts. For more information about changing scripts, see the Conract
Center Manager Scripting Guide for the Communication Server 1000/Meridian

1.

Global variables

If you use global variables to represent ACD-DNSs in your scripts, you must
assign new values to the script variables. For more information about changing
variables, see the Contact Center Manager Scripting Guide for the
Communication Server 1000/Meridian 1.

Nortel recommends that you use variables to represent ACD-DNSs in your
scripts.
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Section C: Comparison of VPE and
Application Builder

In this section

Application Builder compared to Voice Prompt Editor 366
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Application Builder compared to Voice Prompt
Editor

After you migrate to CallPilot, you use the Application Builder to create, record,
and manage your voice prompts. (For detailed instructions, see the CallPilot 4.0
Administrator’s Guide.) Application Builder CallPilot provides much of the
same functionality as the Voice Prompt Editor. This section lists some of the
differences between the two programs.

Differences

The following table lists the differences between Voice Prompt Editor and
Application Builder.

Feature

VPE

Application Builder

Logging on

Enter mailbox, password, and
telephone number.

Enter user ID and password.
The program prompts for the
telephone number only if you
record prompts.

Creating voice
files

Description is entered at the
time of creation.

Description can be added later.

Opening voice
files

You can only open one voice
file at a time.

You can open multiple files
(applications) simultaneously.

Reverting to
previous file
version

Menu command

Close the file without saving
changes.

Copying voice
files

Copy menu command

Save As menu command

Renaming
voice files

Rename menu command

Save As menu command;
delete previous version
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Feature VPE Application Builder
Undeleting Undelete menu command Not available
voice files
Copying voice | Not available Supported
segments
between
applications
Listing voice | List shows segment duration. | Segment duration is not
segments available.
Each segment has a name, Each segment has a name and
title, and description. description.
Playing the Play Next Segment button. To play the next segment,
next segment select the next segment and
click Play.
Editing Length button Use a third-party application.
segment length
Searching for | Search button Sort the segment list by ID or
voice segments name.
Undeleting Undelete menu command Close and reopen the file.

voice segments

Deleting voice |Deletion causes renumbering |Deletion does not cause
segments of IDs in segment list and may | renumbering.
affect scripts.

Playing agroup | Supported You can build an application
of recorded to play prompt groups.
prompts

Telset Not available Voice Item Maintenance
application for
recording
prompts
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Feature VPE Application Builder

Prompt size Up to 2 minutes (120 seconds)| Up to 2 minutes (120 seconds)
Maximum 1000 3000

number of

segments per

file

Import/Export | Not available Supported

WAV file

Connection to
server

VPE uses a serial ACCESS
link.

Application Builder uses a
LAN link, resulting in faster
file and segment operations.

Assignment of

Automatically assigned,

Default provided, but can be

segment IDs  |starting at 1. overriden by administrator.
Description Maximum 2048 characters Maximum 240 characters
length
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To migrate from Meridian MAX to
Contact Center Manager Server

In this appendix

Premigration steps 370

Migration steps 371
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Premigration steps

This section provides a migration plan for a migration from Meridian MAX
MQA to Contact Center Manager Server with a staged cutover.

Before beginning the migration, verify the following items:

In MAX, make sure no Change Orders are created or scheduled.

Check Meridian Mail or CallPilot announcements, menus, and treatments
that are used in Customer Controlled Routing (CCR) or as entry points;
ensure that they do not route calls to old ACD-DNs or CDNs that are no
longer used. Contact Center Manager Server requires its own Meridian
Mail ACD-DN for voice processing, and cannot share CCR’s IVR ACD-
DN.

Check the CCR Variable table to ensure that the ACD-DNs are removed.

Check any link programming (LD 17, 15, 10, 11, 23) to ensure that ACD-
DNs and CDNs that use CTI are associated with the ELAN subnet link 1D
and not the AML.

Make sure routes are not auto-terminating on old ACD_DNs or CDNs.
Check the IDC tables for old ACD-DNs and CDNE.
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Migration steps

To migrate Meridian Max to Contact Center Manager Server, complete the
following procedure.

Performing the migration with a staged cutover

1  Create a new ACD-DN with enough MAXP assigned.
Set RPRT = YES on this new ACD-DN.

3 Instruct contact center agents to use single standard logon prior to leaving
on the night of the cutover. (Alternatively, if acceptable, monitor the switch.
The only ACD-DN maintained is the ACD-DN defined in the service
change.)

4  \Verify that agents are assigned to one queue in one of the following ways:

m Run the Configuration Update in MAX, and then print the Configuration
Report, which shows all ACD-DNs and the positions assigned to them.

= View the Real Time Display—Agent by ACD-DN.

5 Build and submit a Meridian MAX Change Order to move agents to a new
ACD-DN.

Note: Nortel recommends that you execute the Change Order at night
when the agents are not present.

6  Verify on the switch and in Meridian MAX that no agent positions are left in
old ACD-DNs.

7 Disassociate the CCR script. (The CDN shows CNTL = NO.)

For the CDN, change the old default ACD to a new ACD-DN, either in
Meridian MAX or LD 23. (Optionally, remove the Value Added Server [VAS]
ID, although this is not necessary.) When Contact Center Manager Server
acquires the CDN, the ASID appears.

9 Test the CDN and default queue routing. (Calls should be presented to
agents in the new ACD-DN.)

10 Create Contact Center Manager Server scripts.

Note: The Master Script must route calls to the CDN default DN if the CDN
is not acquired or if no script is assigned to it. Therefore, you can add CDNs
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to the Master Script and comment them out (commenting out refers to the /
* */ around commands that indicate a piece of script is tagged to not
compile) until the script is tested. After testing, you can acquire the CDN
and remove the comments.

Example: Following is an example Master Script:

IF TRANSFERRED THEN
GIVE RINGBACK
WAIT 6
ELSE
GIVE RINGBACK /* As long as busy isn’t given later */
END IF
IF test_cdn THEN
EXECUTE SCRIPT Test_1
END IF
/*
WHERE CDN EQUALS
VALUE xxxx: EXECUTE SCRIPT xxxxX
VALUE xxxy: EXECUTE SCRIPT XXXy
VALUE xxxz: EXECUTE SCRIPT xxXxz
END WHERE

*/
ROUTE CALL DEFAULT DN

11 In Contact Center Manager Server, acquire phones.

12 In Contact Center Manager Server, acquire a test CDN, and associate a
script with this CDN.

13 Place test calls receiving night treatment.

14 Change the hours in the script to offer day treatment.

15 Place test calls receiving day treatment.

16 Change the hours in the script back to night treatment.

17 Acquire CDNs and assign validated or tested scripts to live CDNs.

Note: As part of the migration plan you must consider all Meridian MAX
third-party devices such as wallboards, forecasting packages, adherence,
quality monitoring, and so on.

372

Contact Center Manager



Glossary

A

accelerator key

A key on a phoneset that an agent can use to place a call quickly. When an agent
presses an accelerator key, the system places the call to the configured number
associated with the key. For example, if an agent presses the Emergency key, the
system places a call to the agent’s supervisor.

ACCESS
An internal protocol used by Contact Center Manager Server to directly control
some of the voice services available on the CallPilot or Meridian Mail platform.

access class

A collection of access levels that defines the actions a member of the access
class can perform within the system. For example, a member of the
Administrator access class might be given a collection of Read/Write access
levels.

access level

A level of access or permission given to a particular user for a particular
application or function. For example, a user might be given View Only access to
historical reports.

ACCESS link
A communication channel between Contact Center Manager Server and
CallPilot or Meridian Mail.

ACCESS voice port
A voice port controlled by the ACCESS link.

ACD call
See automatic call distribution call.

ACD-DN
See automatic call distribution directory number.
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ACD group
See automatic call distribution group.

ACD routing table
See automatic call distribution routing table.

ACD subgroup
See automatic call distribution subgroup.

acquired resource

A resource configured on the switch under the control of Contact Center
Manager Server. Resources must be configured with matching values on both
the switch and Contact Center Manager Server.

activated script
A script that is processing calls or is ready to process calls. Before you can
activate a script, you must first validate it.

active server

In a system with a Replication Server, the server providing call processing and
administration services.

activity code

A number that agents enter on their phoneset during a call. Activity codes
provide a way of tracking the time agents spend on various types of incoming
calls. They are also known as Line of Business (LOB) codes. For example, the
activity code 720 might be used to track sales calls. Agents can then enter 720
on their agent desktop applications during sales calls, and this information can
be generated in an Activity Code report.

adapter

Hardware required to support a particular device. For example, network adapters
provide a port for the network wire. Adapters can be expansion boards or part of
the computer’s main circuitry.

administrator
A user who sets up and maintains Contact Center Manager and Contact Center
Multimedia.
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agent
A user who handles inbound and outbound voice calls, e-mail messages, and
Web communications.

agent logon ID

A unique identification number assigned to a particular agent. The agent uses
this number when logging on. The agent ID is not associated with any particular
phoneset.

agent priority per skillset

Each agent has a priority per skillset. This priority represents their skill level
within the skillset. This priority is used only in queuing the agent in the idle
agent queues, thus allowing agents with greater priority in a skillset to be
presented with calls before agents of lesser priority. Agent priority per skillset
has a range of 1 to 48, with 1 having the greatest priority. Agent priority per
skillset is not used to determine which request to present to an idle agent when
the agent qualifies for more than one queue request. That presentation is based
solely on the calls’ attributes.

agent-to-skillset assignment
A matrix that, when you run it, sets the priority of one or more agents for a
skillset. Agent to skillset assignments can be scheduled.

agent-to-supervisor assignment
A matrix that, when you run it, assigns one or more agents to specific
supervisors. Agent to supervisor assignments can be scheduled.

AIP
Advanced 1/0 Processor

alias
See e-mail alias.

AML
See Application Module Link.

ANI
See automatic Number ldentification.
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API
See application program interface.

application

1. A logical entity that represents a Contact Center Manager script for reporting
purposes. The Master script and each primary script have an associated
application. The application has the same name as the script it represents. 2. A
program that runs on a computer.

Application Module Link
An internal protocol used by Contact Center Manager Server to communicate
directly with the switch.

application program interface

A set of routines, protocols, and tools that programmers use to develop software
applications. APIs simplify the development process by providing commonly
used programming procedures.

application server

The server on which the Contact Center Manager Administration software is
installed. This server acts as the middle layer that communicates with Contact
Center Manager Server and makes information available to the client PCs.

associated supervisor
A supervisor who is available for an agent if the agent’s reporting supervisor is
unavailable. See also reporting supervisor.

automatic call distribution

A means of automatically distributing an organization’s incoming calls among a
number of answering positions (ACD agents). Automatic call distribution is
useful in operations where callers want a service rather than a specific person.
Calls are serviced in the order they arrive and are distributed so that the
workload at each answering position is approximately equal.

automatic call distribution call

A call to an ACD-DN. ACD calls are distributed to agents in an ACD group
based on the ACD routing table on the switch. See also automatic call
distribution directory number.
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automatic call distribution directory nhumber

A primary or supplementary DN associated with an ACD group. Calls made to
an automatic call distribution directory number are distributed to agents
belonging to the group, based on the ACD routing table on the switch.

automatic call distribution group

An entity defined on the switch for the purpose of call distribution. When a
customer dials an ACD group, the call is routed to any agent who is a member of
that group.

automatic call distribution routing table

A table configured on the switch that contains a list of ACD-DNSs used to define
routes for incoming calls. This ensures that incoming calls not processed by
Contact Center Manager Server are queued to ACD groups and handled by
available agents.

automatic call distribution subgroup

An entity defined on the switch to assign supervisory responsibilities. Each
subgroup has one supervisor phoneset and a number of agent phonesets
associated with it. Agents can log on to any phoneset within their ACD
subgroup. The supervisor must log on to the supervisor phoneset to monitor
assigned agents.

automatic Number Identification

A telephony feature that provides the originating local telephone number of the
caller.

auto-response

A message sent to a customer with no agent interaction. An auto-response can
be an intelligent response, such as a sales promotion flyer, or an
acknowledgement, such as, “We received your e-mail and will respond to you
within three days.”

B basic call
A simple unfeatured call between two 2500 phonesets, on the same switch,
using a four-digit dialing plan.
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BBUA
Back-to-Back User Agent

call age
The amount of time a call waits in the system before being answered by an
agent.

call destination
The site to which an outgoing network call is sent. See also call source.

Calling Line Identification

An optional service that identifies the telephone number of the caller. This
information can then be used to route the call to the appropriate agent or skillset.
The CLID can also be displayed on an agent’s phoneset.

call intrinsic

A script element that stores call-related information assigned when a call enters
Contact Center Manager Server. See also intrinsic, skillset intrinsic, time
intrinsic, traffic intrinsic.

call presentation class

A collection of preferences that determines how calls are presented to an agent.
A call presentation class specifies whether a break time between calls is allowed,
whether an agent can put DN calls on hold for incoming ACD calls, and whether
an agent phoneset displays that the agent is reserved for a network call.

call priority

The priority given to a request for a skillset agent in a QUEUE TO SKILLSET
or QUEUE TO NETWORK SKILLSET script element. This priority is used
only in queuing a pending request in the pending request queue corresponding to
the required skillsets. This allows pending requests with greater priority in a
skillset to be presented to agents before calls of lesser priority. Call priority has a
range or 1 to 6, with 1 having the greatest priority. Six priorities are used to fully
support the many queuing variations provided by existing NACD functionality.
Call priority is maintained at target nodes for network call requests.
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Call Request Queue Size

Sets the maximum queue size for network skillsets. When the set maximum is
reached, the queue rejects calls. For Network Skill-Based Routing, Call Request
Queue Size (CRQS) is configured in Contact Center Manager Administration. If
the NACD fallback or the Queue_to_NACD script command is used, CRQS
must be configured in LD23 on the switch. See also Flow Control Threshold.

call source
The site from which an incoming network call originates. See also call
destination.

call treatment

A script element that enables you to provide handling to a call while it is waiting
to be answered by a contact center agent. For example, a caller can hear a
recorded announcement or music while waiting for an agent.

call variable

A script variable that applies to a specific call. A call variable follows the call
through the system and is passed from one script to another with the call. See
also global variable, script variable.

CallPilot

A multimedia messaging system you can use to manage many types of
information, including voice messages, fax messages, e-mail messages,
telephone calls (including conferencing), calendars, and directories.

campaign
See outbound campaign.

CAT
Channel Allocation Table

CCR
customer controlled routing

CDN
See controlled directory number.
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central processing unit
The component of a computer that performs the instructions of computer
programs. Also known as a processor or microprocessor.

centum call seconds
A measure of call traffic density that represents one call in one channel for 100
seconds in 1 hour.

CLAN
See Customer Local Area Network.

CLAN subnet
See enterprise IP network.

CLID
See Calling Line Identification.

client

The part of Contact Center Manager Server that runs on a personal computer or
workstation and relies on the server to perform some operations. Two types of
client are available: Server Utility and Contact Center Manager Administration.
See also server.

closed reasons

An item configured in Contact Center Multimedia to indicate the result of a
completed e-mail contact. Agents choose a closed reason, and this information
can be generated in a report.

command

A building block used with expressions, variables, and intrinsics to create
scripts. Commands perform distinct functions, such as routing a call to a specific
destination, playing music to a caller, or disconnecting a caller.

Communication Control Toolkit
A client/server application that integrates a telephone on a user’s desktop with
client- and server-based applications.
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Communication Server 1000 Telephony Manager
A Nortel application used for Private Branch Exchange (PBX) management.

Computer Telephony Integration
An application that enables a computer to control telephone calls.

Conditionally Toll Denied
Allowed access for calls placed through Basic/Network Alternate Route
Selection and Coordinated Dialing Plan.

Contact Center Agent Desktop
An agent tool that contact center agents can use to provide intelligent and
personalized customer care. Agents use a personal computer to access the
telephony and multimedia functions.

Contact Center Manager

A client/server contact center solution for varied and changing business
requirements. It offers a suite of applications that includes call processing and
agent handling, management and reporting, networking, and third-party
application interfaces.

Contact Center Manager Administration

A browser-based tool for contact center administrators and supervisors used for
managing and configuring a contact center and its users, defining access to data,
and viewing real-time and historical reports. The Contact Center Manager
Administration software is installed on an application server. See also Contact
Center Manager Administration server.

Contact Center Manager Administration server

The server on which the Contact Center Manager Administration software is
installed. This server acts as the middle layer that communicates with Contact
Center Manager Server and makes information available to the client PCs.

Contact Center Manager Server

This server is responsible for functions such as the logic for call processing, call
treatment, call handling, call presentation, and the accumulation of data into
historical and real-time databases.
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Contact Center Manager Server call
A call to a CDN controlled by Contact Center Manager Server. The call is
presented to the Incalls key on an agent’s phoneset.

Contact Center Multimedia server
A client/server contact center application that expands inbound telephony
capabilities to include outbound voice, e-mail, and Web communications.

Contact Center Standby server

The server that contains an up-to-date backup version of the Contact Center
Manager Server database for use if the active server fails. The database is kept
up-to-date by the Replication Server.

Contivity VPN Switch

A Nortel product that provides routing, firewall, bandwidth management,
encryption, authentication, and data integrity for secure tunneling across
managed IP networks and the Internet.

controlled directory number

A special directory number that allows calls arriving at the switch to be queued
when the CDN is controlled by an application such as Contact Center Manager
Server. When a call arrives at this number, the switch notifies the application and
waits for routing instructions, which are performed by scripts in Contact Center
Manager Server.

CPH
calls per hour

CPU
See central processing unit.

CRM
See Customer Relationship Manager.

CRQS
See Call Request Queue Size.
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CSL
Command and Status Link

CTD
See Conditionally Toll Denied.

CTI
See Computer Telephony Integration.

customer administrator
A user who maintains Contact Center Manager.

Customer Local Area Network
The LAN to which your corporate servers, third-party applications, and desktop
clients connects.

Customer Relationship Manager
An application that provides the tools and information that an organization
requires to manage its customer relationships.

D Data Execution Prevention
A set of hardware and software technologies that perform additional checks on
memory to help to protect against malicious code exploits. In Windows Server
2003 Service Pack 1, Data Execution Prevention is enforced by both hardware
and software.

database views
A logical representation of the database used to organize information in the
database for your use. Event statistics are accessible through database views.

DBMS
Database Management System

deacquire
To release an acquired switch resource from the control of the contact center.
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deactivated script
A script that does not process any new calls. If a script is in use when it is
deactivated, calls continue to be processed by the script until they are completed.

default activity code

The activity code assigned to a call if an agent does not enter an activity code
manually, or when an agent presses the activity code button twice on the
phoneset. Each skillset has a defined default activity code.

default skillset
The skillset to which calls are queued if they are not queued to a skillset or a
specific agent by the end of a script.

denial of service
An incident in which a user or organization is unable to gain access to a resource
that they can normally access.

DEP
See Data Execution Prevention.

Designer Patch

An emergency fix packaged to address specific individual Contact Center
software problems. Designer Patches are viewable from a patch viewer
application. Designer Patches are included in the next scheduled Service Update
or Service Update Supplementary. See also Service Update and Service Update
Supplementary.

desktop user
A configured user who can log on to the Contact Center Manager Server from a
client PC.

destination site
The site to which an outgoing network call is sent. See also source site.

DHCP
See dynamic host configuration protocol.
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Dial-Up Networking
See Remote Access Services.

Dialed Number Identification Service

An optional service that allows Contact Center Manager Server to identify the
phone number dialed by the incoming caller. An agent can receive calls from
customers calling in on different DNISs and, if the DNIS is displayed on the
phoneset, can prepare a response according to the DNIS.

DID
Direct Inward Dial

directory number

The number that identifies a phoneset on a switch. The directory number (DN)
can be a local extension (local DN), a public network telephone number, or an
automatic call distribution directory number (ACD-DN).

directory number call
A call presented to the DN key on an agent’s phoneset.

display threshold
A threshold used in real-time displays to highlight a value below or above the
normal range.

disposition code

An item configured in Contact Center Multimedia to indicate the result of a
completed outbound contact. Agents choose a disposition code, and this
information can be generated in a report.

Distant Steering Code
Used by the switch to route calls to their intended destination.

Distance Vector Multicast Routing Protocol

The multicast routing protocol used when multicast data recipients extend
beyond a single network. This protocol advertises the shortest-path route to the
networks on which a multicasting source resides.
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DMS
Digital Multiplex Switch

DN
See directory number.

DN call
See directory number call.

DNIS
See Dialed Number Identification Service.

DoS
See denial of service.

DP
See Designer Patch.

DSC
Distant Steering Code

DTMF
Dual Tone Multi Frequency

Dual Tone Multi Frequency

A method used by the telephone system to communicate the keys pressed when
dialing. Pressing a key on the phone's keypad generates two simultaneous tones,
one for the row and one for the column. These are decoded by the exchange to
determine which key was pressed.

DVMRP
See Distance Vector Multicast Routing Protocol.

dynamic host configuration protocol
A protocol for dynamically assigning IP addresses to devices on a network.
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dynamic link library

A library of executable functions or data that can be used by a Windows
application. Typically, a DLL provides one or more particular functions, and a
program accesses the functions by creating either a static or dynamic link to the
DLL. Several applications can use a DLL at the same time.

E EBC

See equivalent basic calls.

EIU
Ethernet Interface Unit

ELAN Subnet
See embedded local area network.

e-mail alias

An e-mail address that forwards all e-mail messages it receives to another e-mail
account. For example, the mailbox general@magscripts.com can have the
aliases carz@magsubscriptions.com and planez@magsubscriptions.com. E-mail
addressed to either of these aliases is forwarded to the general @magscripts.com
mailbox. To route e-mail differently depending on the alias to which it is
addressed, create a recipient mailbox as an alias in the Contact Center
Multimedia Administrator application and then create routing rules based on the
alias.

e-mail message contact
An incoming e-mail message handled intelligently using rules to route a contact
according to a skillset, send an auto-response, or close the contact.

e-mail rule
Determine how an e-mail contact is routed based on information about the
e-mail message (inputs) and configurations in your contact center (outputs).

embedded local area network
A dedicated Ethernet TCP/IP LAN that connects the Contact Center Manager
Server and the switch.

Contact Center, Communication Server 1000/Meridian 1 and Voice Processing Guide 387



Glossary

Standard 6.0

Emergency key

A key on an agent’s phoneset that, when pressed by an agent, automatically calls
their supervisor to notify the supervisor of a problem with a caller.

enterprise IP network
Your entire IP network including the ELAN subnet and the Nortel server subnet.

equivalent basic calls
A measure of the telephone switch CPU real time required to process a basic
call. See also basic call.

event

1. An occurrence or action on Contact Center Manager, such as the sending or
receiving of a message, the opening or closing of an application, or the reporting
of an error. Some events are for information only, while others can indicate a
problem. Events are categorized by severity: information, minor, major, and
critical. 2. An action generated by a script command, such as queuing a call to a
skillset or playing music.

expression

1. A building block used in scripts to test for conditions, perform calculations, or
compare values within scripts. See also logical expression and mathematical
expression. 2. A category of disk drives that employs two or more drives in
combination for fault tolerance and performance. See also relational expression.

FCTH
See Flow Control Threshold.

filter timer
The length of time after the system unsuccessfully attempts to route calls to a
destination site before that site is filtered out of a routing table.

firewall
A set of programs that protects the resources of a private network from external
users.
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first-level threshold

The value that represents the lowest value of the normal range for a statistic in a
threshold class. The system tracks how often the value for the statistic falls
below this value.

Flow Control Threshold

The number of calls required to reopen a closed network skillset queue. This
value must be less than the Call Request Queue Size. For Network Skill-Based
Routing, Flow Control Threshold (FCTH) is configured in Contact Center
Manager Administration. If the NACD fallback or the Queue_to_NACD script
command is used, FCTH must be configured in LD23 on the switch. See also
Call Request Queue Size.

G global settings
Settings that apply to all skillsets or IVR ACD-DNs configured on your system.

global variable

A variable that contains values that can be used by any script on the system. You
can only change the value of a global variable in the Script Variable Properties
sheet. You cannot change it in a script. See also call variable, variable.

GOS
See grade of service.

grade of service

The probability that calls are delayed by more than a certain number of seconds
while waiting for a port.

H HDX

See Host Data Exchange.

Host Data Exchange
A rich scripting language provided with Contact Center Manager to control
treatment of calls.
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HTTP
See Hypertext Transfer Protocol.

hundred call seconds
See centum call seconds.

Hypertext Transfer Protocol
The set of rules for transferring data on the World Wide Web.

ICM
See Intelligent Call Manager.

IGMP
See Internet Group Management Protocol.

Incalls key
The key on an agent phoneset to which incoming ACD and Contact Center
Manager calls are presented.

Integrated Services Digital Network
A set of standards for transmitting digital information over ordinary telephone
wire and other media.

Integration Package for Meridian Link
A feature that integrates an VR system with a switch.

Intelligent Call Manager
A high capacity contact center TCP/IP interface to the switch that enables the
exchange of messages between the switch and a remote host computer.

Interactive Voice Response
An application that allows telephone callers to interact with a host computer
using prerecorded messages and prompts.

Interactive Voice Response ACD-DN
A directory number that routes a caller to a specific IVR application. An IVR
ACD-DN must be acquired for non-integrated IVR systems.
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Interactive Voice Response event
A voice port logon or logoff. An IVR event is pegged in the database when a call
acquires or deacquires a voice port.

Internet Group Management Protocol

The multicast routing protocol used in a network that does not require the
delivery of multicast packets between routers or across networks. This protocol
transports the following information between host group members, hosts, and
routers:

= client requests to join a group
= messages about group membership sent by hosts to routers

Internet Protocol address

An identifier for a computer or device on a TCP/IP network. Networks use TCP/
IP to route messages based on the IP address of the destination. For customers
using NSBR, site IP addresses must be unique and correct. The format of an IP
address is a 32-bit numeric address written as four values separated by periods.
Each value can be 0 to 255. For example, 1.160.10.240 can be an IP address.

intrinsic

A word or phrase used in a script to gain access to system information about
skillsets, agents, time, and call traffic that can then be used in formulas and
decision-making statements. See also call intrinsic, skillset intrinsic, time
intrinsic, traffic intrinsic.

IP address
See Internet Protocol address.

IPML
See Integration Package for Meridian Link.

ISDN
See Integrated Services Digital Network.

IVR
See Interactive Voice Response.
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IVR ACD-DN
See Interactive Voice Response ACD-DN.

IVR event
See Interactive Voice Response event.

IVR port
See voice port.

LAN
See local area network.

Line of Business code
See activity code.

LOB code
See activity code.

local area network

A computer network that spans a relatively small area. Most LANS connect
workstations and personal computers and are confined to a single building or
group of buildings.

local call
A call that originates at the local site. See also network call.

local skillset
A skillset that can be used at the local site only. See also network skillset,
skillset.

logical expression

1. A symbol used in scripts to test for different conditions. Logical expressions
are AND, OR, and NOT. See also expression, mathematical expression. 2. A
category of disk drives that employs two or more drives in combination for fault
tolerance and performance. See also relational expression.
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M

M1
Meridian 1 switch

M1 IE
Meridian 1 Internet Enabled switch

mailbox
See recipient mailbox.

Management Information Base

A data structure that describes the collection of all possible objects in a network.
Each managed node maintains one or more variables (objects) that describe its
state. Contact Center Manager Server Management Information Bases (MIB)
contribute to the overall network MIB by:

= identifying Nortel/Meridian/Contact Center Manager Server nodes within
the network

= identifying significant events (SNMP traps), such as alarms reporting
= specifying formats of alarms

Master script

The first script executed when a call arrives at the Contact Center. A default
Master script is provided with Contact Center Manager, but it can be customized
by an authorized user. It cannot be deactivated or deleted. See also network
script, primary script, script, secondary script.

mathematical expression

1. An expression used in scripts to add, subtract, multiply, and divide values.
Mathematical expressions are addition (+), subtraction (-), division (/), and
multiplication (*). See also expression and logical expression. 2. A category of
disk drives that employs two or more drives in combination for fault tolerance
and performance. See also relational expression.

mean holding time

1. The time that the agent is involved in serving a call. It is the sum of average
talk time. 2. The time required for postcall processing when the agent is not
available to handle other calls. 3. Intercall interval (including union break, if

any).
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Media Application Server

A programmable media endpoint in a SIP signaling network that acts as a SIP
user agent to accept and control sessions and the IP media (audio and video)
services associated with those sessions. The Media Application Server delivers
programmable customized intelligent media services to those sessions using
text, voice, and video initially, with extensibility to other media and information
types as the applications grow.

mean time between calls
The average time between presentation of calls to an agent.

Meridian Link Services
A communications facility that provides an interface between the switch and a
third-party host application.

Meridian Mail
A Nortel product that provides voice messaging and other voice and fax
Services.

Meridian MAX
A Nortel product that provides call processing based on ACD routing.

MHT
See mean holding time.

MIB
See Management Information Base.

MLS
See Meridian Link Services.

MM
See Meridian Mail.

MOSPF
See Multicasting Extensions to Open Shortest Path First.
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MTBC
See mean time between calls.

Multicasting Extensions to Open Shortest Path First

An enhanced version of the Open Shortest Path First (OSPF) routing algorithm
that allows a router to forward multicast IP traffic within an autonomous OSPF
(v.2) system.

Multimedia database
A Caché database used to store customer information and contact details for
outbound, e-mail, and Web communication contacts.

MSL-100
Meridian Stored Logic 100 switch

music route
A resource installed on the switch that provides music to callers while they wait
for an agent.

N NACD cali
A call that arrives at the server from a network ACD-DN.

NAT
See Network Address Translation.

NCC
See Network Control Center.

NCRTD
See Network Consolidated Real-Time Display.

Network Address Translation

The translation of an Internet Protocol (IP) address used within one network to
an IP address used within another network. One network is called the inside
network and the other is called the outside network.
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network call
A call that originates at another site in the network. See also local call.

Network Consolidated Real-Time Display
A real-time display containing data from more than one Contact Center Manager
Server. This data is consolidated by Contact Center Manager Administration.

Network Control Center
The server on a Contact Center Manager system where Network Skill-Based
Routing is configured and where communication between servers is managed.

network interface card
An expansion board that enables a PC to connect to a local area network (LAN).

network script

The script executed to handle error conditions for Contact Center Manager
Server calls forwarded from one site to another for customers using NSBR. The
network script is a system-defined script provided with Contact Center Manager,
but it can be customized by an authorized user. It cannot be deactivated or
deleted. See also Master script, primary script, script, secondary script.

Network Skill-Based Routing
An optional feature with Contact Center Manager Server that provides skill-
based routing to multiple networked sites.

network skillset
A skillset common to every site on the network. Network skillsets must be
created at the Network Control Center (NCC).

night mode

A skillset state in which the server does not queue incoming calls to the skillset,
and in which all queued calls are given night treatment. A skillset goes into night
mode automatically when the last agent logs off, or the administrator can put it
into night mode manually. See also out-of-service mode, transition mode.
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Nortel server subnet

The subnet to which the Nortel servers, such as Contact Center Manager Server,
Network Control Center, Contact Center Manager Administration, Contact
Center Multimedia, and CallPilot are connected.

Nortel VPN Router Switch

A Nortel product that provides routing, firewall, bandwidth management,
encryption, authentication, and data integrity for secure tunneling across
managed IP networks and the Internet.

NPA
See Number Plan Area.

NSBR
See Network Skill-Based Routing.

Number Plan Area
Area code

O object linking and embedding
A compound document standard that enables you to create objects with one
application, and then link or embed them in a second application.

ODBC
See Open Database Connectivity.

OEM
Original equipment manufacturer

Office hours

Hours configured in the contact center where e-mail messages can be routed
using one method when the contact center is open, and another method when the
contact center is closed.

OLE
See object linking and embedding.
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Open Database Connectivity
A Microsoft-defined database application program interface (API) standard.

Open Shortest Path First
A routing algorithm that provides least-cost routing, multipath routing, and load
balancing.

Optivity Telephony Manager
A Nortel application used for switch management.

OSPF
See Open Shortest Path First.

OTM
See Optivity Telephony Manager.

outbound campaign
A group of outgoing calls from the contact center for a specific purpose, for
example, customer satisfaction surveys.

Outbound Campaign Management Tool
An administrator tool accessed through Contact Center Manager Administration
for configuring outbound campaigns.

outbound contact
An outgoing voice call intelligently routed to an agent according to a skillset
within a defined time interval. The call can be dialed by the agent or the switch.

out-of-service mode

A skillset state in which the skillset does not take calls. A skillset is out of
service if no agents are logged on or if the supervisor puts the skillset into out-
of-service mode manually. See also night mode, transition mode.

out-of-service skillset

A skillset not taking any new calls. While a skillset is out of service, incoming
calls cannot be queued to the skillset. See also local skillset, network skillset,
skillset.
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P

patch
See Designer Patch.

PBX
See private branch exchange.

pegging
The action of incrementing statistical counters to track and report on system
events.

pegging threshold
A threshold used to define a cut-off value for statistics, such as short call and
service level. Pegging thresholds are used in reports.

PEP
Performance Enhancement Package. Now known as Designer Patch. See
Designer Patch.

Performance Enhancement Package
Now known as Designer Patch. See Designer Patch.

personal directory number
A DN on which an agent can be reached directly, usually for private calls.

phoneset
The physical device, connected to the switch, to which calls are presented. Each
agent and supervisor must have a phoneset.

phoneset display
The display area on an agent’s phoneset where information about incoming calls
can be communicated.

PIM
See Protocol Independent Multicast.

Platform Vendor Independence
A software-only contact center solution, which operates on any hardware
platform that meets specified requirements.
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Position ID

A unique identifier for a phoneset, used by the switch to route calls to the
phoneset. Referred to as Telephony/Port Address in Contact Center Manager
Server.

primary ACD-DN
A directory number that callers can dial to reach an ACD group.

primary script

A script executed or referenced by the Master script. A primary script can route
calls to skillsets, or it can transfer routing control to a secondary script. See also
Master script, network script, script, secondary script.

priorities

Two sets of priorities affect queuing and call presentation: agent priority per
skillset and call priority. For both sets of priorities, the lower in value of the
number indicates a greater priority in presentation. All idle agent queues and all
pending request queues always queue by priority as its top precedence. All other
gueuing options, such as age of call and agent idle time, take a lower precedence
than priority. See also call priority and agent priority per skillset.

private branch exchange

A telephone switch, typically used by a business to service its internal telephone
needs. A PBX usually offers more advanced features than are generally
available on the public network.

Protocol Independent Multicast
A protocol that provides efficient routes for multicast traffic that must cross the
Internet to reach members of sparsely distributed multicast groups.

PSTN
See public switched telephone network.

public switched telephone network
The international network of private and government-owned voice-oriented
public telephone networks.
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R

RAID
See Redundant Array of Intelligent/Inexpensive Disks.

RAN
recorded announcement

RAN route
See recorded announcement route.

RAS
See Remote Access Services.

Real-time Statistics Multicast
An interface that provides real-time information to third-party applications in
either multicast or unicast format.

recipient mailbox

A container on the e-mail server that hold e-mail messages. Standard mailboxes
are monitored by the Contact Center E-mail Manager, which routes the e-mail to
an agent or group of agents (skillset) based on an analytical search of the sender
address, the recipient address, the subject and body of an e-mail message for
predetermined keywords, or a combination of these. The e-mail server must be
compliant with Post Office Protocol 3 (POP3) and Standard Mail Transfer
Protocol (SMTP).

recorded announcement route
A resource installed on the switch that offers a recorded announcement to
callers.

Redundant Array of Intelligent/Inexpensive Disks
A category of disk drives that employs two or more drives in combination for
fault tolerance and performance.

redundant server
A warm standby server, used for shadowing the Multimedia database on the
Multimedia server and providing a quick recovery if the primary server fails.
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relational expression

An expression used in scripts to test for different conditions. Relational
expressions are less than (<), greater than (>), less than or equal to (< =), greater
than or equal to (> =), and not equal to (< >). See also expression, logical
expression, mathematical expression.

Remote Access Services

A feature built into Windows NT and Windows 95 that enables users to log on to
an NT-based LAN using a modem, X.25 connection, or WAN link. This feature
is also known as Dial-Up Networking.

Replication Server
A server that backs up the active Contact Center Manager Server to the standby
Contact Center Manager Server in real time.

reporting supervisor

The supervisor who has primary responsibility for an agent. When an agent
presses the Emergency key on the phoneset, the emergency call is presented to
the agent’s reporting supervisor. See also associated supervisor.

Resource Reservation Protocol
The protocol used by routers to allow host systems in an IP network to reserve
resources for unicast or multicast dataflows.

round robin routing table

A routing table that queues the first call to the first three sites in the routing
table, then the second three sites, then the third three sites, and so on, until an
agent is reserved at one of the sites. See also sequential routing table.

route
A group of trunks. Each trunk carries either incoming or outgoing calls to the
switch. See also music route, RAN route.

router
A device that connects two LANs. Routers can also filter messages and forward
them to different places based on various criteria.
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routing table
A table that defines how calls are routed to the sites on the network. See also
round robin routing table, sequential routing table.

RSM
See Real-time Statistics Multicast.

RSVP
See Resource Reservation Protocol.

rule
See e-mail rule.

S sample script
A script installed with the Contact Center Manager Server client. Sample scripts
are stored as text files in a special folder on the client. The contents of these
scripts can be imported or copied into user scripts to create scripts for typical
contact center scenarios.

SCM
See Service Control Manager.

script

A set of instructions that relates to a particular type of call, caller, or set of
conditions, such as time of day or day of week. See also Master script, network
script, primary script, secondary script.

script variable
See variable.

second-level threshold

The value used in display thresholds that represents the highest value of the
normal range for a given statistic. The system tracks how often the value for the
statistic falls outside this value.
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secondary directory nhumber
A DN defined on the agent’s phoneset as a Centrex line for incoming and
outgoing non-ACD calls.

secondary script

Any script (other than a Master, network, or primary script) referenced from a
primary script or any other secondary script. Statistics are not pegged for actions
occurring during a secondary script. See also Master script, network script,
primary script, script.

sequential routing table
A routing table method that always queues a call to the first three active sites in
the routing table. See also round robin routing table.

server

A computer or device on a network that manages network resources. Examples
of servers include file servers, print servers, network servers, and database
servers. Contact Center Manager Server is used to configure the operations of
the contact center. See also client.

server subnet

The subnet to which the Nortel servers, such as Contact Center Manger Server,
Network Control Center, Contact Center Manager Administration, Contact
Center Multimedia, and CallPilot are connected.

service
A process that adheres to a Windows NT structure and requirements. A service
provides system functionality.

Service Control Manager
A Windows NT process that manages the different services on the PC.

service level
The percentage of incoming calls answered within a configured number of
seconds.
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service level threshold

A parameter that defines the number of seconds within which incoming calls
should be answered.

Service Update

A Contact Center supplementary software application that enhances the
functionality of previously released software by improving performance, adding
functionality, or correcting a problem discovered since the original release. All
previous Service Updates (SUs) for the release are included in the latest Service
Update. For example, SUO2 contains the contents of SUOL as well as the fixes
delivered in SU02. SUO3 contains SU01, SU02, and the fixes delivered in SUO3.
See also Service Update Supplementary and Designer Patch.

Service Update Supplementary

A stand-alone Contact Center supplementary software application installed on
top of a specific Service Update (SU). It does not contain the contents of
previous SUs. The next SU includes SUSs built on top of previous SUs. For
example, SUS0301 is installed on top of SU03. SU04 contains SU03 and
SUS0301 (and any subsequent SUSs built on top of SU03). See also Service
Update and Designer Patch.

Session Initiation Protocol
An application-layer control (signaling) protocol for creating, modifying, and
terminating sessions with one or more participants.

Simple Network Management Protocol
A systematic way of monitoring and managing a computer network. The SNMP
model consists of four components:

= managed nodes, which are any device, such as hosts, routers, and printers,
capable of communicating status to network-management systems through
an SNMP management process called an SNMP Agent

= management stations, which are computers running special network
management software that interact with the Agents for status

= management information, which is conveyed through exact specifications
and format of status specified by the MIB

= Management Protocol or SNMP, which sends messages called protocol
data units (PDUs)
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SIP
See Session Initiation Protocol.

SIP Terminal

The SIP Address of the TR87 controlled terminal dedicated to this agent. This is
the phone number that the agent controls, combined with the domain of the
agent in the SIP URI.

SIP URI
The SIP Address for the agent as configured on the target SIP server. The SIP
Address uniquely identifies the agent on the SIP network.

site

1. A system using Contact Center Manager Server that can be accessed using
Server Utility. 2. A system using Contact Center Manager Server and
participating in Network Skill-Based Routing.

skillset
A group of capabilities or knowledge required to answer a specific type of call.
See also local skillset, network skillset.

skillset intrinsic

A script element that inserts information about a skillset in a script. Skillset
intrinsics return values such as skillsets, integers, and agent IDs. These values
are then used in queuing commands. See also call intrinsic, intrinsic, time
intrinsic, and traffic intrinsic.

SL-100
Stored Logic 100 switch

SNMP
See Simple Network Management Protocol.

source site
The site from which an incoming network call originates. See also destination
site.
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standby
In skillset assignments, a property that grants an agent membership in a skillset,
but makes the agent inactive for that skillset.

standby server

A server that contains an up-to-date version of the database, for use when the
active server becomes unavailable.

SuU
See Service Update.

supervisor
A user who manages a group of agents. See also associated supervisor and
reporting supervisor.

supplementary ACD-DN

A DN associated with a primary DN. Any calls to the supplementary DN are
automatically routed to the primary DN. A supplementary DN can be a toll-free
(1-800) number.

SuUsS
See Service Update Supplementary.

switch
See telephony switch.

switch resource

A device configured on the switch. For example, a CDN is configured on the
switch and then used as a resource with Contact Center Manager Server. See
also acquired resource.

system-defined scripts

The Master_Script and the Network_Script (if NSBR is enabled). Users can
customize or deactivate these scripts, but they cannot delete them. These scripts
are the first scripts executed for every local or network call arriving at the
contact center.
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T

TAPI
See Telephony Application Program Interface.

target site
See destination site.

TCP/IP
See Transmission Control Protocol/Internet Protocol.

TDM
See Time-Division Multiplex.

telephony

The science of translating sound into electrical signals, transmitting them, and
then converting them back to sound. The term is used frequently to refer to
computer hardware and software that perform functions traditionally performed
by telephone equipment.

telephony switch
The hardware that processes calls and routes them to their destination.

Telephony Application Program Interface
An interface between the switch and an application that allows the application to
control the telephone on a user’s desktop.

threshold
A value for a statistic at which system handling of the statistic changes.

threshold class
A set of options that specifies how statistics are treated in reports and real-time
displays. See also display threshold, pegging threshold.

Time-Division Multiplex
A method of transmission in which a signal is separated into multiple segments
at the transmission source, and then reassembled at the receiving end.
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time intrinsic

A script element that stores information about system time, including time of
day, day of week, and week of year. See also call intrinsic, intrinsic, skillset
intrinsic, traffic intrinsic.

Token Ring

A PC network protocol developed by IBM. A Token Ring network is a type of
computer network in which all the computers are arranged schematically in a
circle.

traffic intrinsic
An intrinsic that inserts information about system-level traffic in a script. See
also call intrinsic, intrinsic, skillset intrinsic, time intrinsic.

transition mode

A skillset state in which the server presents already queued calls to a skillset.
New calls queued to the skillset are given out-of-service treatment. See also
night mode, out-of-service mode.

Transmission Control Protocol/Internet Protocol
The communication protocol used to connect devices on the Internet. TCP/IP is
the standard protocol for transmitting data over networks.

treatment
See call treatment.

trunk

A communications link between a PBX and the public central office, or between
PBXs. Various trunk types provide services such as Direct Inward Dialing (DID
trunks), ISDN, and Central Office connectivity.

U user-created script
A script created by an authorized user on the Contact Center Manager system.
Primary and secondary scripts are user created scripts.

user-defined script
A script modified by an authorized user on the Contact Center Manager system.
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utility

A program that performs a specific task, usually related to managing system
resources. Operating systems contain a number of utilities for managing disk
drives, printers, and other devices.

validation
The process of checking a script to ensure that all the syntax and semantics are
correct. A script must be validated before it can be activated.

variable

A placeholder for values calculated within a script, such as CLID. Variables are
defined in the Script Variable Properties sheet and can be used in multiple scripts
to determine treatment and routing of calls entering Contact Center Manager
Server. See also call variable, global variable.

Virtual Private Network
A private network configured within a public network to take advantage of the
economies of scale and management facilities of large networks.

Voice Extensible Markup Language
Allows a user to interact with the Internet through voice-recognition technology.

Voice over IP
Voice traffic transmitted in digital format using the IP protocol.

voice port
A connection from a telephony port on the switch to a port on the IVR system.

VPN
See Virtual Private Network.

VXML
See Voice Extensible Markup Language.

WAN
See wide area network.
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Web-on-hold
A set of URLSs that a customer sees after requesting a text chat session, and
before the agent connects to the Web Communications contact.

wide area network

A computer network that spans a relatively large geographical area. Typically, a
WAN consists of two or more local area networks (LANSs). The largest WAN in
existence is the Internet.

workload scenarios

Sets of configuration values defined for typical patterns of system operations.
Five typical workload scenarios (entry, small, medium, large, and upper end) are
used in the Capacity Assessment Tool for capacity analysis for Contact Center
Manager.
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2008 phoneset TN, 33
2500 phoneset
ACD agent TNs, 30
TNs, 30
311, package, 83
324, package, 83
44, package, 112
5RS232 connector, 78
7, package, 112

A

AACD prompt, 123

AC1 prompt, 67

AC2 prompt, 67

ACC service type, 62

ACCESS, 63
ACD-DNs, adding VSDN entries for, 157
ACD-DNs, configuring on Contact Center

Manager Server, 58, 63

ACD-DNs, configuring on Meridian Mail, 62,

157

ACD-DNs, configuring on the switch, 55, 62

application, testing, 239
channels, 146

channels, configuring in CallPilot SDN table,

325
See also voice ports
configuring Meridian Mail for, 157
default treatment DN, 200

determining if enabled on Meridian Mail, 77

link, 35, 59, 64

link and Meridian Mail, 33

link, checking, 266

link, configuring, 77

ports reserved for broadcasts, 58, 64
test script, 61, 66

testing, 231

treatment DN, default, 58, 64

voice ports, 141

voice ports, configuring IVR ACD-DNs on
the switch for, 96

voice ports, configuring on CallPilot, 57, 144

voice ports, configuring on Contact Center
Manager Server, 59, 64

voice ports, configuring on Meridian Mail,
152, 159

voice ports, configuring on the switch, 56, 62

voice ports, prerequisites for configuring, 158

voice ports, status, 59, 64

voice prompts, creating, 232

ACD

agent phonesets, virtual, 30

agent TNs, 2500 phoneset, 30

phonesets, configuring as associated sets, 123

phonesets, digital, configuring on switch, 104

phonesets, single-line, configuring on switch,
107

queues. See ACD-DNs

Waiting Calls (AWC) key/lamp, 255

ACD-DNs

ACCESS, configuring on Contact Center
Manager Server, 58, 63

ACCESS, configuring on the switch for
CallPilot, 55

ACCESS, configuring on the switch for
Meridian Mail, 62

CallPilot IVR, acquiring, 341

configuring, 37

configuring as NACD-DNs, 93

configuring on Meridian Mail, 62, 63

configuring on the switch, 103

default IVR, 304

Give IVR, configuring on the switch for a
third-party voice-processing system, 53

Give IVR, configuring on the switch for
CallPilot, 45

hardcoded, in scripts, 345, 364

Meridian Mail IVR, acquiring, 360

MQA agent, 114

See also ACCESS ACD-DNs, Give IVR
ACD-DNs, IVR ACD-DNs

ACNT key, 105
acquired resources, moving, changing or

deleting, 84
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acquiring
agent phonesets, 194
CallPilot IVR ACD-DNs and voice ports, 341
CDN:s, 185
IVR ACD-DNs, 188
Meridian Mail IVR ACD-DNs and voice
ports, 360
resources for voice processing, 140
TNs, 194
activity codes, deactivating, 103
Activity key, 105
adding
ACCESS voice prompts, 232
announcements, 169
Meridian Mail mailbox passwords, 160
Meridian Mail mailboxes, 160
phonesets as voice ports, 196
script variables, 224
SDNs, 223
voice menus, 169
voice segment variables, 235
voice segments, 150, 161
VSDNs for ACCESS ACD-DNs, 157
VSDNs for Give IVR ACD-DNs, 172
VSDNs for non-ACCESS ACD-DNs, 172
advanced voice services. See ACCESS
agent ACD queues. See ACD-DNs
agent ACD-DNs. See ACD-DNs
agent phoneset display
and DWC key, 250
examples, 253
agent phonesets
acquiring, 194
configuring on the server, 194
configuring on the switch, 103
virtual ACD, 30
agent phonesets, configuring for
Communication Control Toolkit, 210
agent TNs, 44
2500 phoneset ACD, 30
virtual, 32, 33, 100
virtual, configuring, 38
agent TNs, configuring for Communication
Control Toolkit, 210
agents
and DSP ports, 154

not receiving Contact Center Manager Server
calls, 301
ALOG prompt, 45, 49
AML
CallPilot and, 32
checking, 75
configuring ELAN subnet for, 73
announcement services, 169
announcements
creating, 169, 217
using voice menus as, 170
See also Controlled Broadcast
Announcements
application
ACCESS, testing, 239
Give IVR, testing, 230
Application Builder, 47, 60, 323
comparison with Voice Prompt Editor, 365
applications, Meridian Link, 33
associated sets
and CTI, 122
configuring digital ACD phonesets as, 123
configuring single-line ACD phonesets as,
123
associating music routes with TNs, 113
AST prompt, 123
auditing, 15
audits, and the VSDN table, 155
AWC key/lamp, 255

B

backout, voice services migration, 347
backup
License Manager, 18
Manager Server, 14
basic ports, 159
basic voice services. See Give IVR
broadcast
ACCESS ports reserved for, 58, 64
announcements, too many repetitions of, 298
messages, 137
voice port wait timer, 58, 64
voice port wait timer, configuring on Contact
Server Manager Server, 200
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voice ports, maximum number of, 199
See also Give Controlled Broadcast
Announcement Command

C

cache database, 16

Call Path Diagnostics, 156

call registers, 42

Call Request Queue, 69

CallPilot, 12
and MLS, 118
and multiple servers on the switch, 145
Application Builder, 47, 60
communication with Contact Center Manager

Server, 31

compared with Meridian Mail, 308
Configuration Wizard, 45, 57, 146
configuring, 324
configuring ACCESS link on, 78
configuring as a voice-processing engine, 143
connecting to Contact Center Manager, 78
connection IP, 182, 336
connection port, 182, 337
connection to switch, 32
connection, configuring, 182, 336
creating IVR ACD-DNs for, 97
creating voice ports for, 100
IVR ACD-DNs, acquiring, 341
IVR ACD-DNs, deacquiring, 350
migrating voice services to, 307
release required, 23
Server ELAN subnet IP, 182, 336
Server Port, 182, 337
using for ACCESS voice services, 55
using for Give IVR, 44
\oice Messaging Primary CDN, 46, 58
voice ports, acquiring, 341
voice ports, deacquiring, 350

CallPilot Application Builder, 323

CallPilot Configuration Wizard, 324

Capacity Assessment Tool, 39

CapTool, 39

CAT, 154

CCR, 304

CDNs, 43
acquiring, 185
changing on the switch, 91
configuring, 37
configuring for host-enhanced routing, 126
configuring on the server, 185
configuring on the switch, 86
modes of operation, 87
scripts and, 207
verifying acquisition of, 90
CDP, 68
changing
CDN configurations on the switch, 91
Meridian Mail mailbox passwords, 160
switch resources, 84
Channel Allocation Table, 50, 154
Channel Monitor, 48
channel number, 292
channels, 304
See also voice ports
checking
AML link, 75
ELAN subnet link, 74
for non-Contact Center Manager Server calls,
291
checklists
for ACCESS voice services with CallPilot, 55
for ACCESS voice services with Meridian
Mail, 62
for backing out of the voice service migration,
349
for general setup, 42
for Give Controlled Broadcast, 55
for Give IVR with CallPilot, 44
for Give IVR with Meridian Mail, 49
for Give IVR with third-party voice-
processing systems, 53
for voice services migration, 318
for voice services pre-migration, 313
for voice sessions, 55
troubleshooting, 288
CLAN.See Nortel server subnet
Class ID, 57
class of service
CallPilot, 101
Meridian Mail, 100, 102
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client applications
Outbound Campaign Management Tool, 17
CLS
CallPilot, 101
Meridian Mail, 100, 102
CNTL prompt, 87
Command and Status Link, 36, 98
Communication Server 1000 releases, 23
Communication Server 1000 switch, 23
and Meridian Mail, 12, 49
release, 23
Communication Server 1000M Release 3.0, 114,
115
Communications Control Toolkit server
overview, 15
Computer Telephony Integration (CTI), 15
configuration
checklists, 42
overview, 36
recommended sequence, 39
Wizard, 146
Configuration Wizard, 324
configuring
ACCESS ACD-DNs on Meridian Mail, 157
ACCESS channels in CallPilot SDN table,
146, 325
ACCESS link, 77
ACCESS voice ports on Meridian Mail, 159
agent phonesets for Communication Control
Toolkit, 210
agent phonesets on the server, 194
CallPilot, 324
CallPilot as a voice-processing engine, 143
CDNs for host-enhanced routing, 126
CDNs on the server, 185
CDNs on the switch, 86
connection to CallPilot, 182, 336
connection to Meridian Mail, 183, 354
ELAN subnet, 73
e-mail contacts, 16
Give IVR ACD-DNs in Meridian Mail, 171
Give IVR channels in CallPilot SDN table,
146, 325
Give IVR voice ports on Meridian Mail, 173
IVR ACD-DNs on Contact Center Manager
Server, 327

IVR ACD-DNs on the server, 188

IVR ACD-DNs on the switch, 96, 320

Meridian Mail as a voice-processing system,
151

Meridian Mail for ACCESS, 157

Meridian Mail for Give IVR, 169

MLS, 117

MLS on the switch, 120

music routes on the switch, 112

Night Routing table on the switch, 92

non-ACCESS ACD-DNs on Meridian Mail,
171

non-ACCESS voice ports on Meridian Mail,
173

NSBR, 40

outbound contacts, 16

phonesets for CTI, 122

phonesets on the switch, 103

RAN routes on the switch, 112

routes on the switch, 111

Service DNs in CallPilot, 147

subsystems, 72

TNs on the server, 194

treatment DNs on Meridian Mail, 171

trunk routes on the switch, 111

voice connection, 181

voice ports on Contact Center Manager
Server, 329

voice ports on the switch, 100, 322

voice prompts, 162

connecting voice-processing system and server,

77

connection port, CallPilot, 182, 337
connectivity

and switch, 30

Contact Center

multiple servers on the same switch and
CallPilot, 145

multiple servers on the same switch and
Meridian Mail, 153

contact center

access, 14

core component, 13
management, 14

scripting, 14

viewing real-time statistics, 15

416

Contact Center Manager



February 2007

Index

Contact Center Agent Desktop application
on Multimedia server, 17
Contact Center Manager
CLAN IP Address, 45
Contact Center Manager Administration
tracking changes, 15
Contact Center Manager Server
ACCESS voice ports, 141
calls not presented to agents, 301
CLAN IP Address, 57
communication with subsystems, 31
configuring IVR ACD-DNs on, 327
configuring voice ports on, 329
fails to communicate with switch, 301
Give IVR voice ports, 141
release required, 23
Contact Center Manager server
network interface cards, 19
redundancy, 14
Contact Center Manager Voice Services, 303
Contact Center Manager Voice Services on
CallPilot
and multiple servers on switch, 145
creating IVR ACD-DN:s for, 97
creating voice ports for, 100
Contact Center Manager Voice Services on
Meridian Mail
and multiple servers on switch, 153
connections, 35
creating IVR ACD-DNs for, 98
creating voice ports for, 102
Contact Center Multimedia/Outbound server
Agent Desktop, 17
database, 16
migration, 17
Outbound Campaign Management Tool, 17
redundancy server, 16
contacts
routing, 13
treatments, 13
continuous mode, 138
Controlled Broadcast Announcement. See Give
Controlled Broadcast Announcement
command
controlled mode, 87
Coordinated Dialing Plan, 68

corporate licensing, 18
COT trunk types, 111
CP_Testl, 214, 244
CP_Test2, 214, 227, 245
CPD, 156
creating
ACCESS voice prompts, 232
announcements, 169, 217
Meridian Mail mailbox passwords, 160
Meridian Mail mailboxes, 160
script variables, 224
voice menus, 169
voice segment variables, 235
voice segments, 150, 161
CRQS, 69
CSL, 36, 98
checking, 265
CTI, 119
and MLS, 118
configuring phonesets for, 122
enabling on the ELAN subnet, 121
customer number, 45, 57

D

database
migrating Multimedia/Outbound data, 17
Multimedia contacts, 16
Day Routing Table, 69
DB-25 male connector, 78
DB-9 female connector, 78
D-Channels, 67
deacquiring
CallPilot IVR ACD-DNs and voice ports, 350
Meridian Mail IVR ACD-DNs and voice
ports, 332
deactivating Not Ready reason codes, 103
default
ACCESS treatment DN, 58, 64
ACCESS treatment DNs, configuring in
Contact Center Manager Server, 200
IVR ACD-DN, 304
mode, 87
treatment DN, 48, 51, 304
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treatment DNs, configuring on Meridian
Mail, 172
treatment DNs, configuring on the switch, 97,
99
defining. See creating
definitions
contact routing, 13
contact treatment, 13
outbound campaign, 17
skillset, 14
Delay Night RAN Treatment (DNRT), 94
determining whether ACCESS is enabled on
Meridian Mail, 77
Dial Intercom key, 255
DID trunk types, 111
Digit Manipulation Index, 67, 68
digital
ACD phonesets, configuring as associated
sets, 123
ACD phonesets, configuring on switch, 104
non-ACD phonesets, configuring as
associated sets, 123
Display Waiting Calls
key, 105, 250
key and agent phoneset displays, 250
key and skillset information, 251
key and supervisor phoneset displays, 251
key, display format, 251
lamp, 250, 254
Distant Steering Code, 68
DMI, 67, 68
DNRT, 94
DNs
default ACCESS treatment, 58, 64
default ACCESS treatment, configuring on
Contact Center Manager Server, 200
default treatment, 304
default treatment, configuring on switch, 97,
99
treatment, 303
documents in Contact Center, 25
DSC, 68
DSP
Port Status, 51, 64
ports and agents, 154
duplication

Manager server, 14
Multimedia/Outbound server, 16
DWC key. See Display Waiting Calls key

E

E1 TNs, 31
ELAN subnet, 35, 43
checking, 265
configuring, 73
enabling CTI operations on, 121
IP address, CallPilot connection, 182, 336
link, checking, 74
embedded LAN. See ELAN subnet
enabling
Contact Center Manager Server integration,
57
Contact Center Manger Server integration, 45
CTI on the ELAN subnet, 121
MLS, 120
the ELAN subnet link, 74
End Voice Session command, 303
typical uses of, 136
using for voice processing, 134
external IVR systems
and scripts, 176
using with Give IVR, 176

F

FCTH, 69
features
MLS, 119
FEX trunk types, 111
FGDT trunk types, 111
Flow Control Threshold, 69
frequently asked questions, 303
front-end VR, 303
and voice processing, 132

G

general Meridian Mail services, 142
getting started

418

Contact Center Manager



February 2007

Index

how to get help, 27
Give Controlled Broadcast Announcement

command, 133

and CallPilot, 32

and mailbox passwords, 201

and Meridian Mail, 33

checklist for configuring, 55

default operation, 304

maximum number of ports, 199

typical uses of, 135

using for voice processing, 134

Give IVR

ACD-DNs, adding VSDNs for, 172

ACD-DNs, configuring in Meridian Mail, 171

ACD-DNs, configuring on CallPilot, 46

ACD-DNs, configuring on Contact Center
Manager Server, 47, 50, 53

ACD-DNs, configuring on Meridian Mail, 49

ACD-DNs, configuring on the switch, 45, 53

application, testing, 230

channels, 146

channels, configuring in CallPilot SDN table,
325

command and Contact Center Manager \Voice
Services on CallPilot, 32

command and Contact Center Manager \Voice
Services on Meridian Mail, 33

command, typical uses of, 135

command, using external VR systems with,
176

command, using for voice processing, 134

command, using third-party IVR systems
with, 176

configuration checklist, 44

configuring Meridian Mail for, 169

default operation, 304

test scripts, importing, 227

testing, 216

voice ports, 141, 152

voice ports, configuring VR ACD-DNss for,
96

voice ports, configuring on CallPilot, 145

voice ports, configuring on Meridian Mail,
173

voice ports, configuring on the switch, 46, 49,
53, 54

voice ports, prerequisites for configuring on
Meridian Mail, 173
Give Music command, 111
Give RAN command, 111
typical uses of, 135
using for voice processing, 134
global settings, 64
global settings, for IVR ACD-DNs
configuring on Contact Center Manager
Server, 199, 338, 357
global variables, 345, 364
gradual migration, 312

H

handling e-mail, outbound, voice, 17
hardcoded ACD-DNs, 364
HDX application server, 19
help, 27
High Priority Queue, 69
HLOC, 41, 68
Home Location Code, 41, 68
host application, MLS, 127
host-enhanced

routing, 119, 126

voice processing, 119
Hotline key, 255
HPQ, 69

IAPG groups, 122
importing
Give IVR test scripts, 227
INAC prompt, 67
installing MLS, 120
Integrated Voice Messaging, 98
interacting with callers
directly using script commands, 133
indirectly using script commands, 133
interactive voice response (IVR), 19
interactive voice-processing mode, 132
intermittent voice-processing treatment, 294
interruptible operation, 139
IP address, CallPilot connection, 182, 336
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IPML, 54
IVMS, 98
IVR
ACD-DN global settings, 58, 64
ACD-DN global settings, configuring on
Contact Center Manager Server, 199,
338, 357
ACD-DNs, acquiring, 188
ACD-DNs, acquiring CallPilot, 341
ACD-DNS, acquiring Meridian Mail, 360
ACD-DNs, CallPilot, 350
ACD-DNs, configuring, 37, 45
ACD-DNs, configuring on Contact Center
Manager Server, 188, 327
ACD-DNs, configuring on Meridian Mail, 50
ACD-DNs, configuring on the switch, 53, 96,
320
ACD-DNs, deacquiring Meridian Mail, 332
ACD-DN:s, scripts and, 207
See also ACCESS ACD-DNSs, Give IVR
ACD-DNs
channels, 146
prompt, 45, 49
voice ports, configuring on CallPilot, 46
voice ports, configuring on Contact Center
CallPilot for Give IVR, 51
voice ports, configuring on Contact Center
Manager Server, 47
voice ports, configuring on Contact Center
Manager Server for Give IVR, 54
voice ports, configuring on Meridian Mail, 50
voice ports, configuring on the switch, 49, 53
voice ports, configuring on the voice-
processing system, 53
voice ports, status, 48, 51, 54
IVR channels. See IVR voice ports

L

license manager, 18

licensing corporate, 18

limitations for migration of voice services, 315
listen only mode, 137

Local Steering Code, 68

loop, checking, 267

LSC prompt, 68

M

mailboxes
adding, 160
creating, 160
Meridian Mail, 63
Meridian Mail, configuring, 37
passwords and, 201
managing components using a license, 18
MAX. See Meridian MAX
maximum number of broadcast ports, 199
MCDN, 92
media required for migration of voice services,
316
Meridian 1 PBX
Communication Server 1000, 12
Meridian 1 PBX 11C - Chassis, 23
Meridian 1 PBX 51C, 23
Meridian 1 PBX 61C, 23
Meridian 1 PBX 81, 23
Meridian 1 PBX 81C, 23
Meridian 1 PBX switch, 12
Meridian Customer Defined Network, 92
Meridian Integrated RAN, 12
Meridian Link, 33, 119, 304
CallPilot and, 32
traces, 263
Meridian Link Services, 12, 34
Meridian Link Services. See MLS
Meridian Mail, 12, 33
and multiple servers on the switch, 153
changing mailbox passwords, 160
communication with Contact Center Manager
Server, 32
compared with CallPilot, 308
configuring ACCESS IVR ACD-DNs on, 157
configuring ACCESS link on, 79
configuring ACCESS voice ports on, 159
configuring as a voice-processing system, 151
configuring for ACCESS, 157
configuring for Give IVR, 169
configuring Give IVR ACD-DNs on, 171
configuring Give IVVR voice ports on, 173
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configuring non-ACCESS ACD-DNs on, 171
configuring non-ACCESS voice ports on, 173
connecting to Contact Center Manager
Server, 78
connection to switch, 33
connection, configuring, 183, 354
connections, 35
creating IVR ACD-DN:s for, 98
creating mailbox passwords, 160
creating voice ports for, 102
determining whether ACCESS is enabled on,
77
IVR ACD-DNs, acquiring, 360
IVR ACD-DNs, deacquiring, 332
mailboxes, 63, 201
mailboxes, creating, 160
migrating voice prompts, 369
migrating voice services from, 307
password, 63
release required, 23
tape drive and media requirements, 316
using for ACCESS voice services, 62
using for Give IVR, 49
voice ports, acquiring, 360
voice ports, deacquiring, 332
Meridian MAX
migrating to Contact Center Manager Server
from, 369
using Multiple Queue assignments with, 114
messages
callers hearing incorrect, 297
playing to callers, using script commands, 133
methods of voice processing, 132
front-end IVR, 132
script commands, 132
migrating
voice prompts, 323
voice segments, 323
migrating Multimedia/Outbound databases, 17
migration
from Meridian Mail to CallPilot, 312
from Meridian MAX to Contact Center
Manager Server, 369
testing, 346
MIRAN, 12
MIRAN cards, 96, 111

ml_trace.exe, 263
MLink. See Meridian Link
MLS, 12, 34
configuring, 117
configuring on the switch, 120
configuring the ELAN subnet link for, 74
enabling on the switch, 120
features, 119
host application, 127
installing, 120
MLSM service, 47, 59, 64
MLSMTraceFile.txt, 264
modes of operation, CDNs, 87
monitoring
the status of Manager server, 17
MPLR16833, 85
MPLR17921, 114
MPLR18387, 85
MQA, 114
agents and Contact Center Manager Server,
114
multi-line ACD phonesets. See digital ACD
phonesets
Multiple Queue Assignments. See MQA
MUS routes. See music routes
Music package 44, 112
music routes, 44
associating with TNs, 113
configuring on the switch, 112

N

NACD
ACD-DNs and scripts, 207
ACD-DNs, configuring on the switch, 92
package, 40, 67, 84
routing, using, 92
NACD-DNs. See NACD ACD-DNs
NCFW prompt, 93
network call-by-call reports with inaccurate
timestamps, 302
Network Control Center (NCC) software, 13
Network interface cards (NIC), 19
Network Skill-Based Routing. See NSBR
networking
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configuring, 40
NGCC package, 83
NGEN package, 83
Night Routing Table, 69
configuring on the switch, 92
Night Service, configuring on the switch, 94
nightly audits, and the VSDN table, 155
non-ACCESS
ACD-DNs, configuring on Meridian Mail,
171
IVR ACD-DNs, adding VVSDN entries for,
172
voice ports, 141
voice ports, configuring IVR ACD-DN:s for,
96
voice ports, configuring on CallPilot, 145
voice ports, configuring on Meridian Mail,
152, 173
voice ports, prerequisites for configuring on
Meridian Mail, 173
non-ACD phonesets, configuring as associated
sets, 123, 124
non-Contact Center calls terminating on voice
ports, 291
non-interruptible operation, 139
Nortel Server Subnet
IP address, 146
Nortel server subnet, 35
IP address, 45, 57
Not Ready reason codes, 105
deactivating, 103
NRAC prompt, 103
NSBR
configuring, 40
NT4R20AA fan-out cable, 78
number clause, 305
numberbydigit clause, 305

o)

OCN, 69

Oldest Call in Network, 69

open queue, 13

Open Voice Session command, 303
and CallPilot, 32

and Meridian Mail, 33

typical uses of, 136

using for voice processing, 134
operation modes

broadcast, 137

continuous, 138

for voice-processing commands, 137

interruptible, 139

listen only, 137

non-interruptible, 139

single connection, 137

start/stop, 138
Outbound Campaign Management Tool, 17
overview

of configuration, 36

of subsystem configuration, 72

P

package
311, 83
324, 83
44,112
7,112
partitioning voice ports, 141
passive voice-processing mode, 132
password, Meridian Mail, 63
passwords
and Meridian Mail mailboxes, 201
changing for Meridian Mail mailboxes, 160
creating for Meridian Mail mailboxes, 160
Meridian Mail, configuring, 37
Personal Number Identification, 67
phoneset
ACD agent TNs, 2500, 30
display examples, 252
keys, unsupported, 255
TNs, 2500, 30
phonesets
adding as virtual agents, 196
adding as voice ports, 196
call center, 248
configuring, 37
configuring for CTI, 122
configuring on the switch, 103
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supported, 248
virtual ACD agent, 30
physical connection between voice-processing
system and server, establishing, 77
Play Prompt statement, 303, 305
playing messages to callers using script
commands, 133
PNI prompt, 67, 68
port, CallPilot connection, 182, 337
ports. See voice ports
predefined voice segments, 206
pre-migration checklist for voice services, 313
prerecorded voice segments, 206
prerequisites for configuring IVR ACD-DNs
global setting, 201
primary CDN, CallPilot Voice Messaging, 46, 58
Private line key, 255
problems with subsystem links, 265

Q

Queue to NACD command, 69, 92
queueing contacts, 13

R

RAGT, 69
RAN routes, 44, 111
configuring on the switch, 112
redundancy
Manager server, 14
Multimedia/Outbound server, 16
related documents, 25
Release ID, 67
release, switch software, 83
releases, 23
Remote Out-Of-Service voice ports, 292
Report Creation Wizard
accessing, 14
Reserve Agent Timer, 69
resources
changing switch, 84
for voice processing, acquiring, 140
RLI, 67, 68
Route List Index, 67, 68

routes, 44
configuring, 37
configuring on the switch, 111
music, 44
music, associating with TNs, 113
music, configuring on the switch, 111
RAN, 44
RAN, configuring on the switch, 111
scripts and, 208
trunk, 44
trunk, configuring on the switch, 111
routing
contacts, 13
routing tables, 69
RPRT prompt, 87

S

sample phoneset displays, 252
saving outbound data, 17
SCN DN, 154
screen pops, 33
script commands
for voice processing, 132
Give Controlled Broadcast Announcement,
134
Give IVR, 134
Give RAN, 134
Open/End Voice Session, 134
script example, using voice segments, 206
script variables. See variables
scripting
application, 14
scripts, 37
and third-party IVR systems, 176
CDNs and, 207
external IVR systems and, 176
IVR ACD-DNs and, 207
NACD ACD-DNs and, 207
routes and, 208
skipping voice-processing commands, 293
suspending, 294
treatment DNs and, 207
updating, 345, 364
voice processing and, 207
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SDN table, 46, 58, 147
configuring ACCESS and Give IVR channels
in, 325
SDNs, 47
creating, 223
SECU prompt, 121
sending e-mail, 17
sequence of configuration, 39
serial voice connection, 62
Server Utility
introduction, 17
server, connecting voice-processing system to,
77
Service Directory Number table. See SDN table
service DNs. See SDNs
Session Initiation Protocol (SIP)
network interface information, 19
sets. See phonesets
shelves, checking, 267
signaling links, 31
silence, callers hearing, 296
single
call non-ringing DN, 154
connection, 137
single-line
ACD phonesets, configuring as associated
sets, 123
ACD phonesets, configuring on switch, 107
non-ACD phonesets, configuring as
associated sets, 124
skillset information and DWC key, 251
skillsets
definition, 14
SL1 phoneset TN, 32, 33
software phones, 16
software release, switch, 83
software-based queue, 13
start/stop mode, 138
Status Change message filtering, 122
subsystems
and communication with Contact Center
Manager Server, 31
configuring, 72
link problems, 265
supervisor
phoneset display and DWC key, 251

phonesets, configuring on the switch, 103
TNs, 44
supported phonesets, 248
suspending script, 294
switch
and connectivity, 30
CallPilot connection to, 32
changing CDNs on, 91
changing resources on, 84
communication with Contact Center Manager
Server, 31
configuring CDNs on, 86
configuring IVR ACD-DNs on, 96
configuring MLS on, 120
configuring music routes on, 112
configuring Night Routing table on, 92
configuring phonesets on, 103
configuring RAN routes on, 112
configuring routes on, 111
configuring trunk routes on, 111
configuring voice ports on, 100
enabling MLS on, 120
fails to communicate with Contact Center
Manager Server, 301
maintenance, 116
Meridian Mail connection to, 33
multiple servers and CallPilot, 145
multiple servers and Meridian Mail, 153
software release, 83
verifying acquisition of CDNs on, 90
Switch Customer Number box, 45, 57
system-predefined phrases, 206

T

T1TNs, 31

tandem nodes, 69

tape drive required for migration of voice
services, 316

TAPI Service Provider, 34

TCP voice connection, 45, 56

Telephony API Service Provider, 34

telephony integration, 15

Telephony/Port Address, 46, 50, 57

test scripts, 48, 242
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ACCESS, 61, 66
Give IVR, 48, 51
importing Give IVR, 227
testing
ACCESS, 231
Give IVR, 216
migration, 346
third-party applications
agent telephony toolbars, 16
call management applications, 16
interactive voice response, 19
other Nortel products, 19
software phones, 16
third-party IVR systems
scripts and, 176
using with Give IVR, 176
third-party voice-processing system, 12
third-party voice-processing systems, 176
checklist for configuration, 53
TIE trunk types, 111
timer, broadcast voice port wait, 58, 64
timestamps inaccurate on network call-by-call
reports, 302
TNs
2008 phoneset, 33
2500 phoneset, 30
2500 phoneset ACD agent, 30
acquiring, 194
associating music routes with, 113
configuring for Communication Control
Toolkit, 210
configuring on the server, 194
El, 31
SL1 (virtual agent), 32, 33
T1,31
verifying configuration of, 106
virtual agent, 100
See also phonesets
traces, Meridian Link, 263
tracking changes in Administration, 15
transfer failures, 300
TRDN, 48, 51
prompt, 97, 99
treatment DNs, 47, 155, 303
configuring, 37
configuring on CallPilot, 224

configuring on Meridian Mail, 50, 171
default, 48, 51, 304
default, configuring on Contact Center
Manager Server, 200
default, configuring on Meridian Mail, 172
default, configuring on switch, 97, 99
external IVR systems and, 177
scripts and, 207
third-party IVR systems and, 177
treatment of contacts, 13
troubleshooting, 261
checklist, 288
trunk routes, 44
configuring on the switch, 111
types
of switches, 23

U

UDP, 67
Uniform Dialing Plan, 67
unsupported keys, 255
updating scripts, 345, 364
user-defined voice segments, 205
using
external IVR systems with Give IVR, 176
Give Controlled Broadcast Announcement,
135
Give IVR, 135
Give RAN, 135
Open/End Voice Session, 136
third-party IVR systems with Give IVR, 176
voice menus as announcements, 170
voice segments, script example, 206

\'}

variables, 60

adding, 224

voice segments, 205
VAS ID

Value Added Server ID, 74
viewing real-time statistics, 15
virtual ACD agent phonesets, 30
virtual agent TNs, 32, 33, 100
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configuring, 38
virtual agents. See voice ports
Voice call key, 255
voice channels. See voice ports
voice connection
configuring, 181
type, 45, 56, 62, 182, 183, 336
voice files, configuring, 38
voice items, 47
voice mail, 19
voice menu services, 170
voice menus
creating, 169
using as announcements, 170
using to offer choices to callers, 170
voice messaging, 96
\Voice Messaging Primary CDN, CallPilot, 46, 58
voice paths, 30
voice ports
ACCESS, 141
ACCESS, configuring IVR ACD-DN:s for, 96
ACCESS, configuring on CallPilot, 144
ACCESS, configuring on Meridian Mail, 152,
159
acquiring CallPilot, 341
acquiring Meridian Mail, 360
broadcast wait timer, 58, 64
callers not connected to, 296
configuring, 38
configuring on CallPilot, 46, 57
configuring on Contact Center Manager
Server, 51, 54, 196, 329
configuring on Contact Center Manager
Server for ACCESS, 59, 64
configuring on Contact Center Manager
Server for Give IVR, 47
configuring on Meridian Mail, 50
configuring on the switch, 100, 322
configuring on the switch for ACCESS, 56, 62
configuring on the switch for Give IVR, 49, 53
configuring on the voice-processing system,
53
deacquiring Meridian Mail, 332
Give IVR, 141
Give IVR, configuring IVR ACD-DN:s for, 96
Give IVR, configuring on CallPilot, 145

Give IVR, configuring on Meridian Mail, 152,
173
non-ACCESS, 141
non-ACCESS, configuring IVR ACD-DNs
for, 96
non-ACCESS, configuring on CallPilot, 145
non-ACCESS, configuring on Meridian Mail,
173
partitioning rules, 141
Remote Out-of-Service, 292
reserved for broadcasts, ACCESS, 58, 64
status, 48, 51, 54, 59, 64
See also ACCESS voice ports, IVR voice
ports
voice processing
acquiring resources for, 140
and script commands, 132
and scripts, 207
commands, scripts skipping, 293
configuring CallPilot for, 143
configuring Meridian Mail for, 151
interactive, 132
intermittent treatment, 294
methods, 132
operation modes, 137
passive, 132
system, configuring ACCESS link on, 78
types of, 132
using front-end IVR, 132
using Give Controlled Broadcast
Announcement, 134
using Give IVR, 134
using Give RAN, 134
using Open/End Voice Session, 134
\Voice Prompt Editor. See VPE
voice prompts
configuring, 162
creating ACCESS, 232
do not play, 299
maintaining, 323
migrating, 323
migrating to CallPilot, 369
voice responses, 19
voice segment variables, creating, 235
voice segments, 50, 60, 65
adding, 38, 150, 161
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creating, 150, 161 X
migrating, 323
predefined, 206 X11 releases, 23
prerequisites for configuring, 162
script example using, 206
user-defined, 205 Y
Voice Service DN table. See VSDN table

voice service DNs. See VSDNs your voice session cannot be completed, 299

voice services
backing out of the migration, 347
comparison of VPE and Application Builder,
365
gradual migration, 312
migrating to CallPilot, 307, 369
migration checklist, 318
migration limitations, 315
migration overview, 312
pre-migration checklist, 313
voice session cannot be completed, 299
voice session commands and mailbox
passwords, 201
voice sessions
checklist for configuration, 55
default operation, 304
voice-processing
system, connecting to server, 77
VPE, 65, 161
comparison with Application Builder, 365
VSDN table, 49, 62, 155
and nightly audits, 155
configuring ACCESS ACD-DNs in, 157
configuring Give IVR ACD-DNs in, 171
configuring non-ACCESS ACD-DNs in, 171
VSDNSs
adding for ACCESS ACD-DNs, 157
adding for Give IVR ACD-DNs, 172
adding for non-ACCESS IVR ACD-DNs, 172
configuring, 38
VSM service, 47, 50, 59

W

wait timer, broadcast voice port, 58, 64
WATS trunk types, 111
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